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Preface

Important Safety Warnings

WARNING! Avoid Electrical Shocks. To avoid electrical shock, do not open the power supplies. There 
are no user-serviceable parts inside.

To avoid electrical shock and harm to your eyes by laser light, do not open the DVD laser module. The 
laser module should be serviced by service personnel only. Do not attempt to make any adjustment to 
the laser unit. Refer to the label on the DVD for power requirements and wavelength. This product is a 
class I laser product.

WARNING! Grounding your Equipment. For your safety always connect the equipment to a grounded 
wall outlet. Always use a power cord with a properly grounded plug, such as the one provided with the 
equipment, or one in compliance with your national safety standards. This equipment can be 
disconnected from the power by removing the power cord from the power outlet. This means the 
equipment must be located close to an easily accessible power outlet.

WARNING! Protecting your Ears. If your system is a multimedia model, or if you have installed a sound 
card in your system, always turn the volume down before connecting the headphones or speakers. This 
prevents discomfort from unexpected noise or static. Listening to loud sounds for prolonged periods of 
time may permanently damage your hearing. Before putting on headphones, place them around your 
neck and turn the volume down. When you put on the headphones, slowly increase the volume until you 
find a comfortable listening level. When you can hear comfortably and clearly, without distortion, leave 
the volume in that position.

WARNING! Removing and Replacing the Cover. For your safety, never remove the system side cover 
without first disconnecting the power cord from the power outlet and removing any connection to a 
telecommunications network. If a Power Protection Device is fitted to your system, you must shut down 
your computer using its on/off switch, then remove the power cord before removing the system’s side 
cover. Remove the Power Protection Device cables before any servicing operation. Always replace the 
side cover before switching the system on again.
IMPORTANT SAFETY WARNINGS VII



WARNING! Battery Safety Information. There is a danger of explosion if the battery is incorrectly 
installed. For your safety, never attempt to recharge, disassemble, or burn an old battery. Replace the 
battery with the same or equivalent type, as recommended by the manufacturer.

The battery in this system is a lithium battery that does not contain any heavy metals. However, to 
protect the environment, do not dispose of batteries in household waste. Return used batteries either to 
the shop from which you bought them, to the dealer from whom you purchased your system, or to HP so 
that they can either be recycled or disposed of in the correct way. Returned batteries will be accepted 
free of charge.

WARNING! Metallic particulates can be especially harmful around electronic equipment. This type of 
contamination may enter the data center environment from a variety of sources, including, but not limited 
to, raised floor tiles, worn air conditioning parts, heating ducts, rotor brushes in vacuum cleaners or 
printer component wear. Because metallic particulates conduct electricity, they have an increased 
potential for creating short circuits in electronic equipment. This problem is exaggerated by the 
increasingly dense circuitry of any electronic equipment.

Over time, very fine whiskers of pure metal can form on electroplated zinc, cadmium, or tin surfaces. If 
these whiskers are disturbed, they may break off and become airborne, possibly causing failures or 
operational interruptions. For over 50 years, the electronics industry has been aware of the relatively 
rare, but possible, threat posed by metallic particulate contamination. During recent years, a growing 
concern has developed in computer rooms where these conductive contaminants are formed on the 
bottom of some raised floor tiles.

Although this problem is relatively rare, it may be an issue within your computer room. Since metallic 
contamination can cause permanent or intermittent failures on your electronic equipment, Hewlett-
Packard strongly recommends that your site be evaluated for metallic particulate contamination before 
installation of electronic equipment.

WARNING! Avoid Burn Injuries. Some parts inside the computer will be hot. Turn off and unplug the 
system, then wait approximately three to five minutes for them to cool down before opening the system 
access panels or touching internal components.

WARNING! If you have a modem: Do not attempt to connect this product to the phone line during a 
lightning storm. Never install telephone jacks in wet locations unless the telephone line has been 
disconnected at the network interface. Never touch uninsulated telephone wires or terminals unless the 
telephone line has been disconnected at the network interface. Use caution when installing or modifying 
telephone lines. Avoid using a telephone (other than a cordless type) during an lightning storm. There 
may be a risk from lightning.

Do not use the telephone to report a gas leak in the vicinity of the leak.

Never touch or remove the communications board without first removing the connection to the telephone 
network.
VIII PREFACE
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CAUTION Avoid Static Electricity. Static electricity can damage electronic components. Turn OFF all 
equipment and disconnect the power cable before installing an accessory card. Do not let your clothes 
touch any accessory card. Handle the card as little as possible and with care.

CAUTION Information on Ergonomic Issues. It is strongly recommended that you read the ergonomics 
information in the Safety and Comfort Guide on the Documentation Library CD before using your system. 
You can access more extensive ergonomics information at: http://www.hp.com/ergo.

NOTE Recycling Your System. HP has a strong commitment toward the environment. Your HP system 
has been designed to respect the environment as much as possible. HP can also take back your old 
system for recycling when it reaches the end of its useful life. HP has a product take-back program in 
several countries. The collected equipment is sent to an HP recycling facilities in Europe or the U.S.A. 
As many parts as possible are reused. The remainder is recycled. Special care is taken for batteries and 
other potential toxic substances, these are reduced into non-harmful components through special 
chemical processes. If you require more details about the HP product take-back program, contact your 
local dealer or your nearest HP Sales Office.

Updating BIOS, Drivers, and Software
HP continually strives to implement new enhancements that will increase functionality, performance, and 
reliability of your HP Workstation. To ensure that your workstation takes advantage of the latest 
enhancements, HP recommends that you install the latest BIOS, driver, and software updates on a 
regular basis.

To download available updates from the HP Web site:

Go to www.hp.com/go/bizsupport.

Or

Click Start>Help & Support Center. Then, click the HP Software & Drivers Download icon, select 
your operating system, and review or select available updates.

Finding Information

E-Support
For online access to technical support information and tools, go to http://www.hp.com/support. Support 
resources include web-based troubleshooting tools, technical knowledge databases, driver and patch 
downloads, online communities, and proactive notification services.

The following sites are also available to you.

http://www.hp.com—Provides useful product information.

http://www.hp.com/support/workstation_manuals—Provides the latest online documentation.

http://welcome.hp.com/country/us/eng/wwcontact.html—Provides a listing of the worldwide technical 
support phone numbers.
UPDATING BIOS, DRIVERS, AND SOFTWARE IX
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Additional Documentation
Refer to the Documentation Library CD for additional product information in PDF format. The CD 
contains the following:

Getting Started (available in print and PDF on library CD)
Helps you set up hardware and factory-provided software; also includes basic troubleshooting 
information should you encounter any problems during initial startup.

Safety and Comfort Guide (PDF on library CD)
Provides safety and ergonomic information to assist you in setting up a safe and comfortable 
workstation environment.

Safety & Regulatory Information Guide (PDF on library CD)
Provides safety and regulatory information that ensures compliance with U.S., Canadian, and various 
international regulations.

Helpful links
The following links can also be accessed for additional information:

Product Bulletin—The product bulletin contains the QuickSpecs and is available at:
http://h18000.www1.hp.com/products/quickspecs/productbulletin.html

For information about the Microsoft® Windows® operating system:
http://www.microsoft.com

For information about the Linux operating system:
http://www.redhat.com

Additional product information is available from the HP Web site at http://www.hp.com/go/workstations.

Using the Documentation Library CD
To access the contents of the Documentation Library CD follow the steps that are applicable to your 
workstation.

Windows-Based Workstations

Insert the CD into the CD-ROM drive. The CD Autorun feature begins.

If there is no CD-ROM drive activity for two minutes or more, the Autorun feature might not be enabled 
on the workstation. To run the CD:

1 Click Start>Run.

2 In the text box, enter:

X:\index.htm
(where X is the drive letter designator for the CD-ROM drive)

3 Click OK.

Linux-Based Workstations

If the workstation is running a Linux operating system, browse the CD and click the index.htm file to 
launch the CD interface. To view the documents on the CD, download and install Adobe® Acrobat® 
Reader for Linux from http://www.adobe.com.
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Locating Regulatory Information
Refer to the Safety & Regulatory Information guide on the Documentation Library CD for product class 
information. You can also refer to the label on the rear of the chassis.

Parts and Accessories
For complete and current information on supported accessories and components, visit http://
partsurfer.hp.com.

Subscriber’s Choice
Subscriber’s Choice, an HP program, allows you to sign up to receive driver and software alerts, 
proactive change notifications (PCNs), the HP newsletter, and more. Sign up today at http://
www.hp.com/go/subscriberschoice.
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Chapter 1 Product Overview

This chapter presents an overview of the hardware components of the HP Workstation xw4200. For a 
more detailed overview of all the hardware components and spare part numbers, visit
http://partsurfer.hp.com. This chapter includes the following sections:

“Product Features” on page 14

“Product Specifications” on page 20

“ENERGY STAR” on page 24

“Hyper-Threading Technology” on page 25
13



Product Features

Exploded View
The following illustration shows an exploded view of the HP Workstation xw4200.

NOTE Drive configurations can vary.

Figure 1-1 Exploded View

1 Access panel 8 Optical drive

2 System fan 9 Diskette drive

3 Processor heatsink 10 Bezel

4 Power supply 11 System speaker

5 Memory 12 Processor

6 System board 13 PCI Express Card

7 Chassis 14 Hard drive

1 2 3 4 5 6 7 8 9

1011121314
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Front Panel Components
The following illustration shows a typical HP Workstation xw4200. Drive configurations might vary 
depending on the configuration that was purchased.

Figure 1-2 Front Panel Components

1 Optical Drive* (optional) 6 Diskette Eject Button 11 Universal Serial Bus (USB) Ports

2 Optical Drive Activity Lights 7 Optical Drive Eject Button 12 Headphone Connector

3 5.25 inch drive bays 8 Power On Light 13 Microphone Connector

4 Diskette Drive (optional) 9 Power Button 14 IEEE-1394 Connector**

5 Diskette Drive Activity Light 10 Hard Drive Activity Light

*An optical drive is a CD-ROM, CD-R/RW, DVD-ROM, DVD+R/RW, or CD-RW/DVD combo drive.
**IEEE-1394 is an optional feature. If the workstation was purchased without this option, then this connector will be covered.

1
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Rear Panel Components

Figure 1-3 Rear Panel Components

1 Power Cord Connector 9 PS/2 Mouse Connector (green)

2 PS/2 Keyboard Connector (purple) 10 Parallel Connector (burgundy)

3 Serial Connector (teal) 11 Audio Line-In Connector (light blue)

4 USB 12 RJ-45 Network Connector and two USB connectors

5 Microphone Connector (pink) 13 Cable Lock Slot

6 Audio Line-Out Connector (lime) 14 Padlock Loop

7 Built In Self Test (BIST) LED (green) 15 Graphics Adapter

8 Universal Chassis Clamp Lock

NOTE: The rear panel connectors are labeled with industry-standard icons to assist you in connecting your peripheral devices. 

1
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System Board Components
The following illustration shows the system board connectors and sockets on the HP Workstation 
xw4200.

Figure 1-4 System Board Components

1 Second serial port connector 
(optional)

13 CD-ROM audio 25 Clear CMOS button

2 Keyboard/mouse 14 Auxiliary audio 26 Main power

3 Serial 15 Chassis speaker 27 Serial ATA

4 Parallel 16 Hard disk activity LED 28 Diskette drive

5 USB 17 Front USB 29 MultiBay

6 Audio 18 Trusted Platform Module 
connector

30 IDE

7 Network/USB 19 Front chassis fan (optional) 31 Memory modules sockets

8 PCI Express x1 20 Front control panel 32 Processor fan

9 PCI Express x16 21 Hood sensor 33 Processor

10 PCI 22 Boot block jumper 34 Solenoid hood lock

11 PCI Express x1 23 Battery 35 Processor power

12 Front audio 24 Password jumper 36 Rear chassis fan

1
2

3433 32 31 30

29

28
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The following illustration shows the HP Workstation xw4200 block diagram.

Figure 1-5 HP Workstation xw4200 Block Diagram
18 PRODUCT OVERVIEW
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Serial Number and COA Label Location
Each workstation has two unique serial number labels 1 and a certificate of authentication (COA) label 2. 
The serial number labels are located on the top (in a minitower configuration) of the unit and on the rear 
panel. Keep this number available when contacting customer service for assistance. The COA label is 
located on the top panel (in a minitower configuration).

NOTE The COA label is only if you have a Microsoft XP preinstalled system.

\

1 2
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Product Specifications
This section describes the physical, environmental, and graphical and PCI Express specifications for the 
HP Workstation xw4200. For more specification information, visit http://www.hp.com and search for the 
QuickSpecs for this product.

Physical Specifications
The following table shows the physical characteristics of the HP Workstation xw4200.

Environmental Specifications
The following table shows the HP Workstation xw4200 environmental specifications.

Table 1-1 HP Workstation xw4200 Physical Characteristics

Weight 16 kg/35 lb (typical configuration)

Tower Dimensions 45.0 cm (17.7 in) high
16.8 cm (6.6 in) wide
45.6 cm (17.9 in) deep

Maximum Altitude
(Non-pressurized)

Operating: 3,000 m (10,000 ft)
Non-operating: 9,100 m (30,000 ft)

Table 1-2 HP Workstation xw4200 Environmental Specifications

Temperature Operating: 5 to 35°C (40 to 95°F)
Non-operating: -40 to 60°C (-40 to 140°F) 

Humidity Operating: 8 to 85%RH, non-condensing
Non-operating: 8 to 90%RH, non-condensing

Altitude Operating: 0 to 10,000 ft (3048m)
Non-operating: 0 to 30,000 ft (9144m)

Shock Operating ½-sine: 40g, 2-3ms
Non-operating:

½-sine: 160 cm/s, 2-3ms, (~100g)·
square: 422 cm/s, 20g

Vibration Operating Random: 0.5g (rms), 5-300 Hz
Non-Operating:

random: 2.0 g (rms), 10-500 Hz·
20 PRODUCT OVERVIEW
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Graphics and PCI Express Slot Power Specifications
Your workstation contains four PCI slots, two PCI Express x1 slots, and a single PCI Express x16 high-
end graphics slot. The following table describes the slots, card types, and maximum slot power.

NOTE For hardware specifications of other system components, such as graphics cards or optical 
drives, visit the Web site of the specific manufacturer.

Table 1-3 HP Workstation xw4200 Graphics and PCI Express Slot Power Specifications

Slot# Card Type Slot Power (Maximum)

1 PCI Express x1 half-length 10 W*

2 PCI Express x16 graphics 75 W*

3-6 PCI 25 W*

7 PCI Express x1 full-length 25 W*

* In addition to these slot power specifications, the overall power consumption of the system (including I/O 
cards, processor, and memory) must not exceed the maximum ratings of the system power supply.
PRODUCT SPECIFICATIONS 21



Power Supply and Cooling
The following table shows the power supply specifications of the HP Workstation xw4200.

Table 1-4 HP Workstation xw4200 Power Supply Specifications

Full Ranging Input (No Line Select Switch) Yes

Active Power Factor Correction (APFC)
(Input Current is nearly 1/2 a non-APFC PS)

Yes

Passive Power Factor Correction (PFC) No

Operating Voltage Range 90 to 264 VAC/118 VAC

Rated Voltage Range 100 to 240 VAC

Rated Line Frequency 50 to 60 Hz/400 Hz

Operating Line Frequency Range 47 to 66 Hz/393 to 407 Hz

Rated Input Current 6.4A/6.4A

Maximum Rated Power 410 W

Heat Dissipation Typical 737.1 btu/hr
Maximum 2152.8 (410W)

Power Supply Fan 92mm variable speed

Power Supply Dimensions 9.76 cm (3.843 in) wide
15 cm (5.906 in) high
15.371 cm (6.052 in) deep

ENERGY STAR Compliant Yes

FEMP Standby Power Compliant
(<2W in S5–Power Off)

No

Power Consumption in ES Mode–Suspend to RAM (S3)
(Instantly Available PC)

2.5 W 

Built-in Self Test LED Yes

Surge Tolerant Full Ranging Power Supply Withstands power surges up to 2000 V
22 PRODUCT OVERVIEW
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Power Consumption and Cooling
The following table shows the power consumption for a typical configuration based on primary power 
consumptions:

One processor (1 x 3.4 GHz Pentium 4 Processor with HT Technology)

One GB memory (2 x 512 MB)

Two hard drives (2 x SATA 40 GB)

CD-ROM drive

PCI-Express Graphics Card (Quadro FX 1300)

One diskette

Monitor

NOTE When you turn off your workstation with the power button on the front panel, the power 
consumption falls below 10 W. To reach zero power consumption, either unplug the workstation from the 
power outlet or use a power strip with a switch. However, removing all power to the workstation might 
reduce the life of the real-time clock battery.

For more information on power-saving features, refer to your operating system documentation.

System Fans and Airflow
The workstation includes a rear system fan, one processor heatsink fan, plus an optional front system 
fan.

Resetting the Power Supply
If an overload triggers the power supply overload protection, all power is immediately cut. To reset the 
power supply unit:

1 Disconnect the power cord.

2 Determine what caused the overload, and fix the problem.

3 Reconnect the power cord and reboot the workstation.

Table 1-5 HP Workstation xw4200 Power Consumption and Cooling

Input Power Consumption 120 VAC/60Hz

Typical operating mode (system busy) 216 W/737.1 btu/hr

Windows XP Idle 138 W/470.9 btu/hr

Standby mode (S3) 2.5 W/8.53 btu/hr

Hibernate mode (S4) 2.1 W/7.166 btu/hr

Power Off (S5) 7.166 btu/hr
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ENERGY STAR
The ENERGY STAR® program, a government-backed initiative, promotes energy efficiency by 
identifying ways to reduce energy consumption. Select HP workstations participate in the ENERGY 
STAR program.

NOTE ENERGY STAR is not supported on Linux-based workstations.

For those workstations that support ENERGY STAR and have it enabled, the power management 
features will be set as follows:

Monitor—goes into Sleep mode after 20 minutes of inactivity.

System—goes into Standby mode after 20 minutes of inactivity.

Hard Drive—goes into Power Savings mode after the system goes into Standby mode.

NOTE If you must restore the operating system, reset the ENERGY STAR settings (if applicable).

To verify the factory default power settings for your product:

From the Windows 2000 or Windows XP Classic Start menu, select Start>Settings>Control 
Panel>Power Options.

From the Windows XP standard Start menu, select Start>Control Panel>Performance and 
Maintenance>Power Options.
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ENERGY STAR Compliance
HP products purchased with the ENERGY STAR configuration are compliant with the U.S. 
Environmental Protection Agency (EPA) ENERGY STAR Computers Program. The EPA ENERGY STAR 
configuration does not imply endorsement by the EPA. As an ENERGY STAR Partner, HP has 
determined that products with the ENERGY STAR configuration meet the ENERGY STAR guidelines 
for energy efficiency.

The ENERGY STAR Computers Program was created by the EPA to promote energy efficiency and 
reduce air pollution through more energy-efficient equipment in homes, offices, and factories. HP 
products achieve this by reducing the power consumption when not being used.

ENERGY STAR on HP Workstations uses ACPI power management. The system can wake as a result 
of a user action (keyboard or mouse) or from the network or a modem.

The Power Management feature, when used in conjunction with an external ENERGY STAR-compliant 
monitor, will support the power-down features of the monitor. The Power Management feature allows an 
external monitor to go into low-power mode when the energy save timeout occurs.

CAUTION Using the Energy Save Monitor feature with non-ENERGY STAR compliant monitors might 
cause video distortion when the Energy Save timeout occurs.

Hyper-Threading Technology
Hyper-Threading Technology is a high-performance technology, developed by Intel®, that enables a 
single processor to execute multiple threads of instructions simultaneously. Hyper-Threading Technology 
enables the processor to utilize its execution resources more efficiently, delivering performance 
increases and improving user productivity. Not all systems benefit from the Hyper-Threading Technology.

To see if Hyper-Threading Technology can benefit you, test your system by turning the feature on. 
Computer Setup (F10) can be used to turn this feature on. To do this, run F10 Setup during boot up and 
select Advanced>Device Options>Hyper-Threading, and enable the Hyper-Threading Technology.

NOTE If your workstation does not support Hyper-Threading Technology, the Hyper-Threading menu 
item will not be available on the Computer Setup menu.

NOTE The Hyper-Threading Technology is recommended for use with Windows XP systems. This 
technology is detected by the system and is turned on in the operating system after it is enabled in the 
system BIOS.

NOTE Red Hat Enterprise Linux WS 3 supports Hyper-Threading Technology. An SMP-capable kernel 
must be installed on your system before this technology can be utilized.

For more information about the Hyper-Threading Technology, visit the Intel Web site at
http://www.intel.com.
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Chapter 2 Installing or Restoring the 
Operating System

This chapter discusses installation and restoration of the operating system. This chapter includes the 
following sections:

“Installing the Operating System and Software” on page 28

“Restoring the Operating System” on page 31

“Protecting the Software” on page 31

“Ordering Backup Software” on page 32

If the workstation was shipped with a preinstalled OS, it is configured automatically the first time the 
workstation is turned on.

CAUTION Do not add optional hardware devices to your workstation until the operating system is 
successfully installed. Doing so can cause errors and might prevent the operating system from installing 
properly.

CAUTION When the automatic installation has begun, DO NOT TURN OFF THE WORKSTATION 
UNTIL THE PROCESS IS COMPLETE. Turning off the workstation during the installation process might 
damage the software that runs the workstation.
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Installing the Operating System and Software
The following section discusses the operating system and HP software installation procedures.

Microsoft Windows XP Professional
The first time you turn on your workstation, you will be prompted to select a language for the operating 
system. After selecting the language, read and follow the on-screen instructions to complete the 
installation of the operating system. This takes approximately 10 minutes, depending on the system 
hardware configuration. During the process, do not turn off your workstation unless you are directed to 
do so.

Installing or Upgrading Device Drivers

To install hardware devices, such as a printer, a display adapter, or network adapter after the operating 
system installation is completed, make sure that the operating system has access to the appropriate 
software drivers for the devices. Device drivers are usually provided on a CD supplied with the peripheral 
device.

Some existing peripheral devices might not have been shipped with drivers developed for Windows XP. 
To locate the most current device drivers, visit http://www.hp.com.

Creating a Restore Diskette

To create a restore diskette for Windows XP, go to Start>All Programs>Accessories>System 
Tools>System Restore, and follow the on-screen instructions.

Linux-Preinstalled Workstations
If you have a Linux-preinstalled workstation, follow the instructions in this section to set up your OS and 
software.

After the boot process completes, you can view additional HP Linux documentation by simply opening 
your Internet browser (the browser is automatically set to use the local HP documentation page as its 
default). You can also access Linux Web links for Red Hat (Internet access required) by using your 
Internet browser.

NOTE For additional information concerning the setup of Linux-preinstalled or Linux-enabled 
workstations, refer to the HP User Manual for Linux, located at http://www.hp.com/support/
linux_user_manual.

For more information about HP and Linux, visit http://www.hp.com/linux.

Starting Up the Linux Operating System

The first time the workstation is booted, the Red Hat First Boot utility displays. This program enables you 
to enter your password, network, graphics, time, and keyboard settings for your workstation.

CAUTION When the automatic installation has begun, DO NOT TURN OFF THE WORKSTATION 
UNTIL THE PROCESS IS COMPLETE. Turning off the workstation during the installation process might 
damage the software that runs the workstation or prevent its proper installation.
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NOTE When you enable the YPBind feature in the Network tab of the Linux Setup Tool, you might get a 
blank screen for about 15–30 seconds after you have selected and saved all of your settings and have 
exited the utility. This is normal. The boot process continues its execution after the screen returns.

Restoring the Linux Operating System

NOTE To restore the Linux OS, the HP Driver CD and Red Hat box set are required.

Download the latest HP Driver CD to get any new enhancements.

NOTE Linux does not support mixed hard disk drive types for manufacturing preload. When restoring 
the operating system, mixed hard disk drive types can be handled with the restoring media.

DOWNLOADING THE LATEST HP DRIVER CD

To download the latest HP Driver CD:

1 Download the ISO image to a local hard drive from the HP support Web site for the appropriate 
workstation platform (such as http://www.hp.com/support/xw4200).

a Click the download drivers and software link.

b Select the Linux OS that matches your box set.

c Select the latest version from the Utility Tools section.

d Download and unpack it (tar zxvf filename.tgz).

2 Copy the ISO image to CD-R bootable media. On another Linux workstation, use the cdrecord utility. 
Identify the device address for the CD burner (cdrecord --scanbus).
The default is usually 2, 0, 0.

Example:
cdrecord -v -eject dev=2,0,0 CD0_golden.iso

INSTALLING WITH THE HP DRIVER CD

To install with the HP Driver CD:

1 Boot the workstation from the Red Hat box set Binary CD 1.

2 Insert the Linux operating system CDs from the Red Hat box set as prompted.

3 Continue following the prompts until the operating system is successfully installed.

4 Configure the X server to start on reboot.

5 Reboot the workstation.

6 Follow the prompts to set up your system with the Red Hat First Boot utility.

7 When prompted in First Boot to add additional CDs, insert the HP Driver CD into the CD-ROM tray of 
the workstation.
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8 Click Install next to “Additional CDs.”
The HP Driver CD window opens.

9 Click Press to begin install...

10 When the install is done, you will have two options, “Reboot now...” on the left side and “Press to 
continue, reboot later...” on the right side. Click Reboot now...

Upgrading Device Drivers

If you must upgrade a Linux device driver, visit the HP Web site at http://www.hp.com/go/
workstationsupport.

Linux-Enabled Workstations
Linux-enabled workstations are not pre-installed with Linux. They require the HP Installer Kit for Linux 
and the purchase of a Red Hat box set. The Installer kit includes the HP CDs necessary to complete the 
installation of all versions of the Red Hat box set which have been verified to work on HP workstation 
hardware.

Verifying Hardware Compatibility

To see which Linux versions have been verified to work on HP workstation hardware:

1 Go to http://www.hp.com/support/workstation_manuals.

2 Select your HP workstation model.

3 Click the Hardware Support Matrix for Linux link.

Installing the Linux Operating System

To install the Linux operating system on your Linux-enabled system:

1 Follow the instructions for “Restoring the Linux Operating System” in the previous section.

2 Follow the instructions for “Starting Up the Linux Operating System” in the previous section.

NOTE For more information concerning the setup of Linux-preinstalled or Linux-enabled workstations, 
refer to the HP User Manual for Linux, located at http://www.hp.com/support/linux_user_manual.

For more information about HP and Linux, visit http://www.hp.com/linux.

Upgrading Device Drivers

If you must upgrade a Linux device driver, visit the HP Web site at http://www.hp.com/go/
workstationsupport.
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HP Software
The following HP software will also be installed the first time the workstation is turned on:

Computer Setup (F10) Utilities and diagnostic features

HP Support Software including device drivers

HP Client Manager Software (available for download from http://www.hp.com/go/EasyDeploy)

System Software Manager (available for download from http://www.hp.com/go/ssm)

Power Management Setup with energy saver features (not supported for Linux)

Security Management tools

Software Support Management tools

Certain drivers and utilities are available only in selected languages. You can obtain the latest version of 
these files, in English and selected other languages, in one of the following ways:

Support Software CD

HP Web site at http://www.hp.com

Restore Plus! CD, which is supplied with Windows-based workstations

HP Workstations Driver for Red Hat Enterprise Linux 3 CD, which is supplied with Linux-based 
workstations

NOTE Additional HP software might be required in certain situations.

Restoring the Operating System
Restore the original Microsoft Windows XP Professional operating and factory-installed software by 
using the Restore Plus! CD and the OS CD that came with the workstation. Carefully read and follow the 
instructions provided with the Restore Plus! CD.

For more information about restoring the Linux OS or software, see “Restoring the Linux Operating 
System” on page 29.

Protecting the Software
To protect software from loss or damage, you should keep a backup copy of all system software, 
applications, and related files stored on the hard drive. Refer to the operating system or backup utility 
documentation for instructions on making backup copies of data files.
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Ordering Backup Software
All software that shipped with the workstation, including the Restore Plus! CD, can be ordered from HP 
as a single set, or you can order the various software packages separately.

NOTE Before calling HP to order the software, be sure to have the serial number of the workstation 
available. This number is necessary for all diskette orders. See the “Serial Number and COA Label 
Location” on page 19 for the location of the serial number on the workstation.
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Chapter 3 System Management

This chapter discusses the various tools and utilities that allow for the system management of the HP 
Workstation xw4200. This chapter includes the following sections:

“Computer Setup (F10)” on page 34

“Desktop Management” on page 44
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Computer Setup (F10)
The Computer Setup (F10) utilities enable you to perform the following tasks:

Change factory default settings and to set or change the system configuration, which might be 
necessary when you add or remove hardware.

Determine if all of the devices installed on the workstation are recognized by the system and 
functioning properly.

Determine information about the operating environment of the workstation.

Solve system configuration errors detected but not automatically fixed during the Power-On Self-Test 
(POST).

Establish and manage passwords and other security features.

Establish and manage energy-saving timeouts (not supported for Linux platforms).

Modify or restore factory default settings.

Set the system date and time.

Set, view, change, or verify the system configuration including settings for processor, graphics, 
memory, audio, storage, communications, and input devices.

Modify the boot order of bootable devices, such as hard drives, diskette drives, optical drives, or LS-
120 drives.

Configure the boot priority of SATA, IDE (ATA) and SCSI hard drive controllers.

Enable Quick Boot which is faster than Full Boot, but does not run all of the diagnostic tests run 
during a Full Boot. You can set your system to:

always Quick Boot (default)

periodically Full Boot (from every 1–30 days)

always Full Boot

Enable or disable Network Server Mode, which allows the workstation to boot the operating system 
when the power-on password is enabled with or without a keyboard or mouse attached. When 
attached to the system, the keyboard and mouse remain locked until the power-on password is 
entered.

Select POST Messages Enabled or Disabled to change the display status of POST messages. POST 
Messages Disabled suppresses most POST messages, such as memory count, product name, and 
other non-error text messages. If a POST error occurs, the error is displayed regardless of the mode 
selected. To manually switch to POST Messages Enabled during POST, press any key (except F1 
through F12).

Establish an Ownership Tag, the text of which is displayed each time the system is turned on or 
restarted.

Enter the Asset Tag or property identification number assigned by your company to this workstation.

Enable power-on password prompting during system restarts (warm boots) as well as during power-
on.

Secure the integrated I/O functionality, including the serial, USB, or parallel ports, audio, or 
embedded NIC, so that they cannot be used until they are unsecured.

Enable or disable Master Boot Record (MBR) Security.
34 SYSTEM MANAGEMENT



C
h
a
p
t
e
r
 
3

Enable or disable removable media boot ability.

Enable or disable removable media write ability (when supported by hardware).

Replicate your system setup by saving system configuration information on diskette and restoring it 
on one or more workstations.

Execute self-tests on a specified SATA or IDE (ATA) hard drive (when supported by the drive).

NOTE All features identified in this chapter might not be available on all HP products.

BIOS ROM
The Basic Input/Output System (BIOS) of the workstation is a collection of machine language programs 
stored as firmware in read-only memory (ROM). The BIOS ROM includes such functions as POST, PCI 
device initialization, Plug 'n Play support, power management activities, and the Setup utility. The 
firmware contained in the BIOS ROM supports the following systems and specifications:

Microsoft WHQL

Alert-On-LAN (AOL) and Wake-On-LAN (WOL)

ACPI 1.0 and OnNow

SMBIOS 2.3.5

PC98/99/00 and NetPC

PXE boot ROM for the integrated LAN controller

BIOS Boot Specification 1.01

Enhanced Disk Drive Specification 3.0

“El Torito” Bootable CD-ROM Format Specification 1.0

ATAPI Removable Media Device BIOS Specification 1.0

MPS Specification 1.4 (for booting Linux SMP)

The BIOS ROM is a 512-KB Firmware Hub (or Firmware Hub-compatible) part. The runtime portion of 
the BIOS resides in a 128-K block from E0000h to FFFFFh.
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Using Computer Setup (F10)
Computer Setup can be accessed only by turning on the workstation or restarting the system. To access 
the Computer Setup Utilities menu:

1 Turn on or restart the workstation. If you are in Windows, click Start>Shut Down>Restart the 
Computer.

2 Wait for the F10=Setup prompt to appear on the lower right corner of the screen. Once you see the 
prompt, press the F10 key to enter the F10 setup utility.

NOTE If you do not press the F10 key at the appropriate time, you must try again. Turn the workstation 
off, then on again, and press the F10 key again to access the utility.

3 Select your language from the list and press Enter. A choice of four headings appears in the 
Computer Setup Utilities menu: File, Storage, Security, and Advanced.

4 Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and down) 
keys to select the option you want, then press Enter.

5 To apply and save changes, select File>Save Changes and Exit.

If you have made changes that you do not want applied, select Ignore Changes and Exit.

To reset to factory settings, select Set Defaults and Exit. This option will restore the original 
factory system defaults.

CAUTION Do NOT turn the workstation power OFF while the ROM is saving your Computer Setup F10 
changes because the CMOS could become corrupted. It is safe to turn off all power to the workstation 
after you exit the F10 Setup screen.

NOTE This menu can change with new firmware releases, so it might be consistent with what is 
presented in the following table.
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Table 3-1 Computer Setup Menu

Heading Option Description

File System Information Lists product name, processor type/speed/stepping, cache size (L1/L2), system ROM family 
and version, installed memory size, chassis serial number, integrated MAC for enabled or 
embedded NIC (if applicable), and asset tracking number.

About Displays copyright information.

Set Time and Date Allows you to set system time and date.

Replicated Setup Save to Removable Media
Saves system configuration, including CMOS, to a formatted blank 1.44-MB diskette in file 
CPQsetup.txt. 

Restore to Removable Media
Restores system configuration from a diskette. 

Default Setup Save Current Settings as Default
Saves the current settings as default settings for the next operation.

Restore Factory Settings as Default
Restores the factory settings as the default settings for the next operation.

Apply Defaults and Exit Restores factory default settings which includes clearing any established passwords.

Ignore Changes and Exit Exits Computer Setup without applying or saving any changes.

Save Changes and Exit Saves changes to system configuration and exits Computer Setup.
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Storage Device Configuration Lists all installed non-SCSI storage devices.
SCSI storage drives will not be listed in Computer Setup (F10).
When a device is selected, detailed information and options are displayed. The following 
options might be presented:

Diskette Type (for legacy diskette drives only)
Identifies the highest capacity media type accepted by the diskette drive. Options are 3.5" 1.44 
MB, 5.25" 1.2 MB, and Not Installed.

Drive Emulation (IDE devices only)
Allows you to select a drive emulation type for a storage device. (For example, a Zip drive can 
be made bootable by selecting disk emulation.)

Drive Type Emulation Options

ATAPI Zip drive None (treated as Other).

Diskette (treated as diskette drive).

Disk (treated as hard drive).

IDE Hard disk None (treated as Other).
Disk (treated as hard drive).

Legacy diskette No emulation options available.

IDE CD-ROM No emulation options available.

ATAPI LS-120 No emulation options available.

Transfer Mode (IDE devices only)
Specifies the active data transfer mode. Options (subject to device capabilities) are PIO 0, Max 
PIO, Enhanced DMA, Ultra DMA 0, and Max UDMA.

Translation Mode (IDE disks only)
Lets you select the translation mode to be used for the device. This enables the BIOS to 
access disks partitioned and formatted on other systems and may be necessary for users of 
older versions of UNIX (for example, SCO UNIX version 3.2). Options are Bit-Shift, LBA 
Assisted, User, and None.

CAUTION: A new Automatic option has been added to allow for BIOS to automatically 
determine the translation mode used to configure a previously formatted IDE, SATA, or USB 
mass storage device. This prevents you from having to know how the mass storage device was 
previously formatted.

Ordinarily, the translation mode selected automatically by the BIOS should not be changed. If 
the selected translation mode is not compatible with the translation mode that was active when 
the disk was partitioned and formatted, the data on the disk will be inaccessible.

Translation Parameters (IDE disks only)
Allows you to specify the parameters (logical cylinders, heads, and sectors per track) used by 
the BIOS to translate disk I/O requests (from the operating system or an application) into terms 
the hard drive can accept. Logical cylinders cannot exceed 1024. The number of heads cannot 
exceed 256. The number of sectors per track cannot exceed 63. These fields are only visible 
and changeable when the drive translation mode is set to User.

Multisector Transfers (IDE disks only)
Specifies how many sectors are transferred per multi-sector PIO operation. Options (subject to 
device capabilities) are Disabled, 8, and 16.

Table 3-1 Computer Setup Menu (Continued)

Heading Option Description
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Storage
(continued)

Options Removable Media Boot
Enables/disables ability to boot the system from removable media.

Legacy Diskette Write
Enables/disables ability to write data to removable media.
NOTE: This feature applies only to legacy diskette, (IDE/ATA) LS-120 Superdisk, (IDE/ATA) 
LS-240 Superdisk, and (IDE/ATA) PD-optical drives.
NOTE: After saving changes to Removable Media Boot, the workstation will restart. Manually, 
turn the workstation off, then on.

BIOS DMA Data Transfers
Allows you to enable or disable the BIOS use of DMA for IDE data transfers.

IDE Controller
Allows you to enable or disable the primary IDE/ATA controller.

SATA Emulation
Enables the SATA to emulate the RAID controller, combined controllers, or a separate 
controller.

SATA Primary Controller
Allows you to disable the SATA primary controller ports.

SATA Secondary Controller
Allows you to disable the SATA secondary controller ports.

Diskette MBR Validation
Allows you to enable or disable strict validation of the diskette MBR. 
NOTE: If you use a bootable diskette image that you know to be valid, and it does not boot with 
Diskette MBR Validation enabled, you might need to disable this option to use the diskette.

IDE DPS Self-Test Allows you to execute self-tests on IDE hard drives capable of performing the Drive Protection 
System (DPS) self-tests.
NOTE: This selection will only appear when at least one drive capable of performing the IDE 
DPS self-tests is attached to the system.

Controller Order* Allows you to specify the order of the attached hard drive controllers. The first hard drive 
controller in the order will have priority in the boot sequence and will be recognized as drive C 
(if any devices are attached).
NOTE: The selection will not appear if all hard drives are attached to the embedded IDE 
controllers.

Boot Order Allows you to configure the boot, diskette drive, and hard drive orders by physically reordering 
the menu entries. Each device on the list can be individually excluded from or included for 
consideration as a bootable operating system source.
NOTE: MS-DOS drive lettering assignments might not apply after a non-MS-DOS operating 
system has started.
Shortcut to Temporarily Override Boot Order
To boot one time from a device other than the default device specified in Boot Order, restart 
the workstation and press F9 when the F10=Setup message appears on the screen. After 
POST is completed, a list of bootable devices is displayed. Use the arrow keys to select the 
preferred bootable device and press Enter. The workstation then boots from the selected non-
default device for this one time.

*Available on select models.

Table 3-1 Computer Setup Menu (Continued)

Heading Option Description
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Security Setup Password Allows you to set and enables setup (administrator) password.
NOTE: If the setup password is set, it is required to change Computer Setup options, flash the 
ROM, and make changes to certain Plug ‘n Play settings under Windows.

Power-On Password Allows you to set and enable power-on password.

Device Security* Enables/disables serial ports A and B, parallel port, front USB ports, all USB ports, system 
audio, network controllers (some models), and SCSI controllers (some models).

Network Service Boot Enables/disables the workstation’s ability to boot from an operating system installed on a 
network server. (Feature available on NIC models only; the network controller must reside on 
the PCI bus or be embedded on the system board.)

Password Options (This 
selection will appear 
only if a power-on 
password is set.)

Allows you to specify whether the password is required for warm boot (CTRL+ALT+DEL).

Hood sensor* Allows you to enable/disable solenoid hood (Smart Cover) lock.
NOTE: Notify User alerts the user that the sensor has detected that the cover has been 
removed. Setup Password requires that the setup password be entered to boot the workstation 
if the sensor detects that the cover has been removed.
This feature is supported on select models only.

DriveLock* Allows you to assign or modify a master or user password for certain hard drives. When 
enabled, the user is prompted to provide one of the DriveLock passwords during POST. If 
neither is successfully entered, the hard drive will remain inaccessible until one of the 
passwords is successfully provided during a subsequent cold-boot sequence.
This selection will only appear when at least one drive that supports the DriveLock feature is 
attached to the system.

Master Boot Record 
Security*

Allows you to enable or disable MBR Security.
When enabled, the BIOS rejects all requests to write to the MBR on the current bootable disk. 
Each time the workstation is powered on or rebooted, the BIOS compares the MBR of the 
bootable disk to the previously saved MBR. If changes are detected, you are given the option 
of saving the MBR on the current bootable disk, restoring the previously saved MBR, or 
disabling MBR security. You must know the setup password if one is set.
NOTE: Disable MBR Security before intentionally changing the formatting or partitioning of the 
current bootable disk. Several disk utilities (such as FDISK and FORMAT) attempt to update 
the MBR.

If MBR Security is enabled and disk accesses are being serviced by the BIOS, write requests 
to the MBR are rejected, causing the utilities to report errors.

If MBR Security is enabled and disk accesses are being serviced by the operating system, any 
MBR change will be detected by the BIOS during the next reboot, and an MBR Security 
warning message will be displayed.

Save Master Boot 
Record*

Saves a backup copy of the Master Boot Record of the current bootable disk.
NOTE: Only appears if MBR Security is enabled.

System IDs Allows you to set:
- Asset tag (18-byte identifier) and ownership Tag (80-byte identifier displayed during POST).
- Chassis serial number or Universal Unique Identifier (UUID) number. The UUID can only be 
updated if the current chassis serial number is invalid. (These ID numbers are normally set in 
the factory and are used to uniquely identify the system.)
- Keyboard locale setting (for example, English or German) for System ID entry.

*Available on select models

Table 3-1 Computer Setup Menu (Continued)

Heading Option Description
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Security
(continued)

Restore Master Boot 
Record*

Restores the backup Master Boot Record to the current bootable disk.
NOTE: Only appears if all of the following conditions are true:
- MBR Security is enabled.
- A backup copy of the MBR has been previously saved.
- The current bootable disk is the same disk from which the backup copy of the MBR was 
saved.
NOTE: Restoring a previously saved MBR after a disk utility or operating system has modified 
the MBR might cause the data on the disk to become inaccessible. Only restore a previously 
saved MBR if you are confident that the current bootable disk’s MBR has been corrupted or 
infected with a virus.

Smarter Allows you to use Smarter authentication for the Pre-Boot process.

Embedded Security 
Device

Embedded Security Device
Allows you to activate the Trusted Platform Module.
Setup password must be established before this menu item can be selected.

Reset to Factory Settings
Allows you to clear all encryption keys stored into the Trusted Platform Module.
Setup password must be established before this menu item can be selected.

Device Security SMBUS Controller was added to embedded devices capable of being hidden or available 
during a refresh of the BIOS.

Power OS Power Management Allows you to enable PCI Express ASPM support.

Thermal Allows you set the fan idle mode.

*Available on select models.

Table 3-1 Computer Setup Menu (Continued)

Heading Option Description
COMPUTER SETUP (F10) 41



Advanced** Power-On Options Allows you to set:
- POST mode (QuickBoot, FullBoot, or FullBoot every 1–30 days).
- POST messages (enable/disable).
- Safe POST* (enable/disable). Enabling this feature allows the ROM to monitor add-in cards 
during boot. If an add-in card does not work or initialize correctly, then on the next boot all cards 
will be skipped during POST.
- F9 prompt (enable/disable). Enabling this feature will display the text F9=Boot Menu during 
POST. Disabling this feature prevents the text from being displayed but pressing F9 will still 
access the Shortcut Boot (Order) Menu screen. Refer to Storage>Boot Order for more 
information.
- F10 prompt (enable/disable). Enabling this feature will display the text F10=Setup during 
POST. Disabling this feature prevents the text from being displayed but pressing F10 will 
still access the Setup screen.
- F12 prompt (enable/disable). Enabling this feature will display the text F12=Network 
Service Boot during POST. Disabling this feature prevents the text from being displayed 
but pressing F12 will still force the system to attempt booting from the network.
- Option ROM* prompt (enable/disable). Enabling this feature will cause the system to display a 
message before loading options ROMs. 
- Remote wakeup boot source (remote server/local hard drive).
- Fan Idle Mode: Allows you set the fan idle mode.
- After Power Loss (off/on/previous state): After power loss, if you connect your workstation to 
an electric power strip and would like to turn on power to the workstation using the switch on 
the power strip, set this option to ON. The previous state will set the power loss setting to 
whatever the unit status was before the power loss.
- If you turn off power to your workstation using the switch on a power strip, you will not be able 
to use the suspend/sleep feature or the Remote Management features.
- POST Delay (in seconds) (enable/disable). Enabling this feature will add a user-specified 
delay to the POST process. This delay is sometimes needed for hard disks on some PCI cards 
that spin up very slowly; so slowly that they are not ready to boot by the time POST is finished. 
The POST delay also gives you more time to select F10 to enter Computer Setup (F10).
- I/O APIC Mode (enable/disable). Enabling this feature will allow Microsoft Windows Operating 
system to run optimally. This feature must be disabled for certain non-Microsoft Operating 
Systems to work properly.
- ACPI/USB Buffers @ Top of Memory (enable/disable). Enabling this feature places USB 
memory buffers at the top of memory. The advantage of remapping is that it allows space in the 
DOS Compatibility Hole range, below 1-MB, to be made available for additional PCI plug-in 
cards that need option ROM space.

BIOS Power-On Allows you to select week days and a specific time to automatically power the unit on from the 
power-off state.

Onboard Devices Allows you to set resources for or disable onboard system devices (serial port, parallel port, or 
diskette controller).

PCI Devices Lists currently installed PCI devices and their IRQ settings.
Allows you to reconfigure IRQ settings for these devices or to disable them entirely. These 
settings have no effect under an APIC-based operating system.

Bus Options* Allows you to enable or disable:
- PCI bus mastering, which allows a PCI device to take control of the PCI bus.
- PCI VGA palette snooping, which sets the VGA palette snooping bit in PCI configuration 
space; only needed when more than one graphics controller is installed.
- PCI SERR# generation.
- ECC support allows hardware-based error correction for ECC-capable memories.

*Available on select models.
**These options should be used by advanced users only.
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Advanced**
(continued)

Device options Allows you to set:
- Printer mode (bi-directional, EPP+ECP, output only).
- Num Lock state at power-on (off/on).
- Power management event (PME) wakeup events (enable/disable).
- Processor cache (enable/disable).
- Hyper-Threading* (enable/disable).
- ACPI S3* support (enable/disable). S3 is an advanced configuration and power interface 
(ACPI) sleep state that some add-in hardware options might not support.
- ACPI S3 selections are supported on select models only. If the ACPI S3 support option is not 
presented, the other ACPI S3 options (ACPI S3 Video REPOST, ACPI S3 Hard disk Reset, and 
ACPI S3 PS2 Mouse Wakeup) will not be available.
- ACPI S3 Video REPOST* (enable/disable). This feature reruns the video option ROM on a 
boot from the S3 state.
- ACPI S3 Hard Disk Reset* (enable/disable). Resets the hard disk on a boot from the S3 sleep 
state.
- ACPI S3 PS2 Mouse Wakeup* (enable/disable). Allows the mouse to wake the system from 
the S3 sleep state.
- Aperture size*. Allows you to specify the amount of system memory reserved for use by your 
graphics controller.
- Monitor Tracking (enable/disable). Allows ROM to save monitor asset information.
- Unique Sleep State Blink Patterns*. Allows you to choose a LED blink pattern that uniquely 
identifies each sleep state.
- Frame Buffer Size*. Allows you to specify amount of system memory dedicated to the 
embedded graphics frame buffer. The AUTO setting attempts to optimize the frame buffer size 
depending on the amount of total system memory.
- PCI Slot x Option ROM Download. Allows you to enable/disable the downloading of the PCI 
slot option ROM. “X.” can be a value of 1, 2, 3, 4, or 5.
- NIC PXE (enable/disable). The BIOS contains an embedded NIC option ROM to allow the unit 
to boot through the network to a PXE server. This is typically used to download a corporate 
image to a hard drive. The NIC option ROM takes up memory space below 1-MB commonly 
referred to as DOS Compatibility Hole (DCH) space. This space is limited. The F10 option 
allows you to disable the downloading of the embedded NIC option ROM, giving more DCH 
space for other PCI cards which might need option ROM space. The default setting for the NIC 
option ROM is “enabled.”

PCI VGA Configuration Displayed only if there are multiple PCI video adapters in the system. Allows you to specify 
which VGA controller will be the “boot” or primary VGA controller.

*Available on select models.
**These options should be used by advanced users only.
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Desktop Management
HP Client Management Solutions (available for download from http://www.hp.com/go/
workstationsupport) provides standards-based solutions for managing and controlling workstations in a 
networked environment. This section summarizes the capabilities and features of the key components of 
desktop management:

Initial Configuration and Deployment

Remote System Installation

Software Updating and Management

ROM Flash

Asset Tracking and Security

Fault Notification and Recovery

NOTE Support for specific features described in this guide might vary by model or software version.

Initial Configuration and Deployment
The workstation comes with a preinstalled system software image. After a brief software “unbundling” 
process, the workstation is ready to use.

You may prefer to replace the preinstalled software image with a customized set of system and 
application software. There are several methods for deploying a customized software image. They 
include:

Installing additional software applications after unbundling the preinstalled software image.

Using software deployment tools, such as Altiris Deployment Solutions™, to replace the preinstalled 
software with a customized software image.

Using a disk cloning process to copy the contents from one hard drive to another.

The best deployment method depends on your information technology environment and processes. The 
PC Deployment section of the HP Lifecycle Solutions Web site (http://whp-sp-orig.extweb.hp.com/
country/us/en/solutions.html) provides information to help you select the best deployment method.

The Restore Plus! CD, ROM-based setup, and ACPI hardware provide further assistance with recovery 
of system software, configuration management and troubleshooting, and power management.

Remote System Installation
Remote System Installation lets you start and set up your system using the software and configuration 
information located on a network server. This feature is usually used as a system setup and 
configuration tool, and can be used for the following tasks:

Deploying a software image on one or more new PCs

Formatting a hard drive

Installing application software or drivers

Updating the operating system, application software, or drivers
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To initiate Remote System Installation, press F12 when the F12=Network Service Boot message 
appears in the lower-right corner of the HP logo screen. Follow the on-screen instructions to continue the 
process. The default boot order is a BIOS configuration setting that can be changed to always attempt to 
PXE boot.

HP and Altiris have partnered to provide tools designed to make the task of corporate PC deployment 
and management easier and less time-consuming, ultimately lowering the total cost of ownership and 
making HP PCs the most manageable client PCs in the enterprise environment.

Software Updating and Management
HP provides several tools for managing and updating software on desktops and workstations—HP Client 
Manager Software, Altiris Client Management Solutions, System Software Manager; Proactive Change 
Notification; and Subscriber’s Choice.

HP Client Manager Software

HP Client Manager Software (HP CMS) assists HP customers in managing the hardware aspects of their 
client workstations with features that include:

Detailed views of hardware inventory for asset management

PC health check monitoring and diagnostics

Proactive notification of changes in the hardware environment

Web-accessible reporting of business critical details such as machines with thermal warnings, 
memory alerts, and more

Remote updating of system software such as device drivers and ROM BIOS

Remote changing of boot order

Configuring the system BIOS settings

For more information on the HP Client Manager, visit http://www.hp.com/go/im.

Altiris Client Management Solutions

HP and Altiris have partnered to provide comprehensive, tightly integrated systems management 
solutions to reduce the cost of owning HP client PCs. HP Client Manager Software is the foundation for 
additional Altiris Client Management Solutions that address:

Inventory and Asset Management

SW license compliance

PC tracking and reporting

Lease contract, fixing asset tracking

Deployment and Migration

Microsoft Windows XP Professional or Home Edition migration

System deployment

Personality migrations
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Help Desk and Problem Resolution

Managing help desk tickets

Remote troubleshooting

Remote problem resolution

Client disaster recovery

Software and Operations Management

Ongoing desktop management

HP system SW deployment

Application self-healing

For more information and details on how to download a fully-functional 30-day evaluation version of the 
Altiris solutions, visit http://h18000.www1.hp.com/im/prodinfo.html#deploy.

System Software Manager

System Software Manager (SSM) is a utility that lets you update system-level software on multiple 
systems simultaneously. When executed on a PC client system, SSM detects both hardware and 
software versions, then updates the appropriate software from a central repository, also known as a file 
store. Driver versions that are supported by SSM are denoted with a special icon on the software, the 
driver download Web site, and on the Support Software CD. To download the utility or to obtain more 
information on SSM, visit http://www.hp.com/go/ssm.

Proactive Change Notification

The Proactive Change Notification program uses the Subscriber's Choice Web site in order to 
proactively and automatically:

Send you Proactive Change Notification (PCN) e-mails informing you of hardware and software 
changes to most commercial workstations and servers, up to 60 days in advance.

Send you e-mail containing Customer Bulletins, Customer Advisories, Customer Notes, Security 
Bulletins, and Driver alerts for most commercial workstations and servers.

You create your own profile to ensure that you only receive the information relevant to a specific IT 
environment. To learn more about the Proactive Change Notification program and create a custom 
profile, visit http://www.hp.com/go/pcn.

Subscriber’s Choice

Subscriber’s Choice is a client-based service from HP. Based on your profile, HP will supply you with 
personalized product tips, feature articles, and/or driver and support alerts/notifications. Subscriber’s 
Choice Driver and Support Alerts/Notifications will deliver e-mails notifying you that the information you 
subscribed to in your profile is available for review and retrieval. To learn more about Subscriber’s 
Choice and create a custom profile, visit http://www.hp.com/go/pcn.
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ROM Flash
The workstation comes with a programmable flash ROM (read only memory). By establishing a setup 
password in the Computer Setup (F10) Utility, you can protect the ROM from being unintentionally 
updated or overwritten. This is important to ensure the operating integrity of the workstation. Should you 
need or want to upgrade the ROM, you may:

Order an upgraded ROMPaq diskette from HP.

Download the latest ROMPaq images from HP driver and support page, http://www.hp.com/support/
files.

CAUTION For maximum ROM protection, be sure to establish a setup password. The setup password 
prevents unauthorized ROM upgrades. System Software Manager allows the system administrator to set 
the setup password on one or more PCs simultaneously. For more information, visit http://www.hp.com/
go/ssm.

Remote ROM Flash

Remote ROM Flash allows the system administrator to safely upgrade the ROM on remote HP 
workstations directly from the centralized network management console. Enabling the system 
administrator to perform this task remotely, on multiple workstations and personal computers, results in a 
consistent deployment of and greater control over HP PC ROM images over the network. It also results 
in greater productivity and lower total cost of ownership.

The workstation must be powered on, or turned on through Remote Wakeup, to take advantage of 
Remote ROM Flash.

For more information on Remote ROM Flash, refer to the HP Client Manager Software or System 
Software Manager at http://h18000.www1.hp.com/im/prodinfo.html.

HPQFlash

The HPQFlash utility is used to locally update or restore the system ROM on individual PCs through a 
Windows operating system.

For more information on HPQFlash, visit http://www.hp.com/support/files and enter the name of the 
workstation when prompted.

FailSafe Boot Block ROM

The FailSafe Boot Block ROM allows for system recovery in the unlikely event of a ROM flash failure, for 
example, if a power failure were to occur during a ROM upgrade. The Boot Block is a flash-protected 
section of the ROM that checks for a valid system ROM flash when power to the system is turned on.

If the system ROM is valid, the system starts normally.

If the system ROM fails the validation check, the FailSafe Boot Block ROM provides enough support 
to start the system from a ROMPaq diskette, which will program the system ROM with a valid image.

NOTE Some models also support recovery from a ROMPaq CD. ISO ROMPaq images are included 
with selected models in the downloadable ROM softpaqs.
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When the boot block detects an invalid system ROM, the System Power LED blinks RED 8 times, one 
every second, followed by a 2-second pause. Also, eight simultaneous beeps will be heard. A Boot Block 
recovery mode message is displayed on the screen (some models).

To recover the system after it enters Boot Block recovery mode:

1 If there is a diskette in the diskette drive or a CD in the CD drive, remove the diskette and CD and 
turn off the power.

2 Insert a ROMPaq diskette into the diskette drive or, if permitted on this workstation, a ROMPaq CD 
into the CD drive.

3 Turn on the workstation.

If no ROMPaq diskette or ROMPaq CD is found, you will be prompted to insert one and restart the 
workstation.

If a setup password has been established, the Caps Lock light will turn on and you will be prompted 
to enter the password.

4 Enter the setup password.

If the system successfully starts from the diskette and successfully reprograms the ROM, then the 
three keyboard lights will turn on. A rising tone series of beeps also signals successful completion.

5 Remove the diskette or CD and turn the power off.

6 Turn the power on again to restart the workstation.

The following table lists the various keyboard light combinations used by the Boot Block ROM (when a 
PS/2 keyboard is attached to the workstation), and explains the meaning and action associated with 
each combination.

Table 3-2 Keyboard Light Combinations Used by Boot Block ROM

FailSafe Boot
Block Mode

Keyboard LED Activity State/Message

Num Lock On ROMPaq diskette or ROMPaq CD not present, is bad, or drive not ready.

Caps Lock On Enter password.

Num, Caps, 
Scroll Lock

Blink On in sequence, 
one at a time–N,C, SL

Keyboard locked in network mode.

Num, Caps, 
Scroll Lock

On Boot Block ROM Flash successful. Turn power off, then on to reboot.

NOTE: Diagnostic lights do not flash on USB keyboards
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Replicating the Setup

The following procedures give an administrator the ability to easily copy one setup configuration to other 
workstations of the same model. This allows for faster, more consistent configuration of multiple 
workstations.

NOTE Both procedures require a diskette drive.

NOTE To collect and replicate BIOS settings on multiple computers, use System Software Manager or 
HP Client Manager Software. For more information, visit http://www.hp.com/go/easydeploy.

COPYING TO SINGLE WORKSTATION

CAUTION A setup configuration is model-specific. File system corruption may result if source and target 
workstations are not the same model. For example, do not copy the setup configuration from an HP 
Workstation xw8200 to an HP Workstation xw4200.

1 Select a setup configuration to copy. Turn off the workstation. If you are in Windows, click Start>Shut 
Down>Shut Down.

2 Turn on the workstation.

3 Wait for the F10=Setup prompt to appear on the lower right corner of the screen. Once you see the 
prompt, press the F10 key to enter the F10 setup utility.

NOTE If you do not press the F10 key at the appropriate time, you must restart the workstation and try 
again to access the utility. 

4 If you are using a a diskette, insert it now.

5 Select File>Replicated Setup>Save to Removable Media. Follow the instructions on the screen to 
create the configuration diskette.

6 Turn off the workstation to be configured and insert the configuration diskette.This procedure gives 
an administrator the ability to easily copy one setup configuration to other workstations of the same 
model. This allows for faster, more consistent configuration of multiple workstations.

7 Turn on the workstation to be configured.

8 Wait for the F10=Setup prompt to appear on the lower right corner of the screen. Once you see the 
prompt, press the F10 key to enter the F10 setup utility.

9 Select File>Replicated Setup>Restore from Removable Media, and follow the instructions on the 
screen.

10 Restart the workstation when the configuration is complete.
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COPYING TO MULTIPLE WORKSTATIONS

CAUTION A setup configuration is model-specific. File system corruption may result if source and target 
workstations are not the same model. For example, do not copy the setup configuration from a xw6200 
to a xw4200.

This method takes a little longer to prepare the configuration diskette, but copying the configuration to 
target workstations is significantly faster.

NOTE A bootable diskette is required for this procedure. If Windows XP is not available to use to create 
a bootable diskette, use the method for copying to a single workstation instead (see “Copying to Single 
Workstation” on page 49).

1 Create a bootable diskette.

2 Select a setup configuration to copy. Turn off the workstation. If you are in Windows, click Start>Shut 
Down>Shut Down.

3 Turn on the workstation.

4 Wait for the F10=Setup prompt to appear on the lower right corner of the screen. Once you see the 
prompt, press the F10 key to enter the F10 setup utility.

NOTE If you do not press the F10 key at the appropriate time, you must restart the workstation and try 
again to access the utility.

5 If you are using a a diskette, insert it now.

6 Select File>Replicated Setup>Save to Removable Media. Follow the instructions on the screen to 
create the configuration diskette.

7 Download a BIOS utility for replicating setup (repset.exe) and copy it onto the configuration diskette. 
To obtain this utility, go to http://welcome.hp.com/support/files and enter the model number of the 
workstation.

8 On the configuration diskette, create an autoexec.bat file containing the following command: 
repset.exe.

9 Turn off the workstation to be configured. Insert the configuration diskette and turn the workstation 
on. The configuration utility will run automatically.

10 Restart the workstation when the configuration is complete.
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Dual-State Power Button

With Advanced Configuration and Power Interface (ACPI) enabled, the power button can function either 
as an on/off switch or as a standby button. The stand-by feature does not completely turn off power, but 
instead causes the workstation to enter a low-power standby state. This allows you to power down 
quickly without closing applications and to return quickly to the same operational state without any data 
loss.

To change the power button’s configuration:

1 Click the Start button, then select Control Panel>Power Options.

2 In the Power Options Properties, select the Advanced tab.

3 In the Power Button section, select Stand by.

After configuring the power button to function as a standby button, press the power button to put the 
system in a very low power state (standby). Press the button again to quickly bring the system out of 
standby to full power status. To completely turn off all power to the system, press and hold the power 
button for four seconds.

CAUTION Do not use the power button to turn off the workstation unless the system is not responding; 
turning off the power without operating system interaction could cause damage to or loss of data on the 
hard drive.

World Wide Web Site

HP engineers rigorously test and debug software developed by HP and third-party suppliers, and 
develop operating system specific support software, to ensure performance, compatibility, and reliability 
for HP workstations.

When making the transition to new or revised operating systems, it is important to implement the support 
software designed for that operating system. If you plan to run a version of Microsoft Windows that is 
different from the version included with the workstation, you must install corresponding device drivers 
and utilities to ensure that all features are supported and functioning properly.

HP has made the task of locating, accessing, evaluating, and installing the latest support software 
easier. You can download the software from http://www.hp.com/support.

The Web site contains the latest device drivers, utilities, and flashable ROM images needed to run the 
latest Microsoft Windows operating system on the HP workstation.

Building Blocks and Partners

HP management solutions integrate with other systems management applications, and are based on 
industry standards, such as:

Web-Based Enterprise Management (WBEM)

Windows Management Interface (WMI)

Wake on LAN Technology

ACPI

SMBIOS

Pre-boot Execution (PXE) support
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Asset Tracking and Security
Asset tracking features incorporated into the workstation provide key asset tracking data that can be 
managed using HP Systems Insight Manager, HP Client Manager Software or other system 
management applications. Seamless, automatic integration between asset tracking features and these 
products enables you to choose the management tool that is best suited to the environment and to 
leverage the investment in existing tools.

HP also offers several solutions for controlling access to valuable components and information. 
ProtectTools Embedded Security, if installed, prevents unauthorized access to data and checks system 
integrity and authenticates third-party users attempting system access. Security features such as 
ProtectTools, the Smart Cover Sensor and the Smart Cover Lock, available on select models, help to 
prevent unauthorized access to the internal components of the workstation. By disabling parallel, serial, 
or USB ports, or by disabling removable media boot capability, you can protect valuable data assets. 
Memory Change and Smart Cover Sensor alerts can be automatically forwarded to system management 
applications to deliver proactive notification of tampering with a workstation’s internal components.

NOTE ProtectTools, the Smart Cover Sensor, and the Smart Cover Lock are available as options on 
select systems.

Use the following utilities to manage security settings on the HP workstation:

Locally, using the Computer Setup Utilities.

Remotely, using HP Client Manager Software or System Software Manager. This software enables 
the secure, consistent deployment and control of security settings from a simple command-line utility.

The following table and sections refer to managing security features of the workstation locally through 
the Computer Setup (F10) Utilities.

Table 3-3 Security Features Overview

Feature Purpose How it is Established

Removable Media Boot Control Prevents booting from the removable media 
drives.

From the Setup Utilities menu.

Serial, Parallel, USB, or Infrared 
Interface Control

Prevents transfer of data through the 
integrated serial, parallel, USB, or infrared 
interface.

From the Setup Utilities menu.

Power-On Password Prevents use of the workstation until the 
password is entered. This can apply to both 
initial system startup and restarts.

From the Setup Utilities menu.

Setup Password Prevents reconfiguration of the workstation 
(use of the Setup Utilities) until the password 
is entered.

From the Setup Utilities menu.

Network Server Mode Provides unique security features for 
workstations being used as servers.

From the Setup Utilities menu.

DriveLock Prevents unauthorized access to the data on 
specific hard drives.

From the Setup Utilities menu.
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Master Boot Record Security Can prevent unintentional or malicious 
changes to the MBR of the current 
bootable disk and provides a means of 
recovering the “last known good” MBR.

From the Setup Utilities menu.

Ownership Tag Displays ownership information, as defined 
by the system administrator, during system 
startup (protected by setup password).

From the Setup Utilities menu.

Cable Lock Provision Prevents entire system theft only. 3mm x 
7mm slot at rear of system.

Install a cable lock to secure the 
workstation to a fixed object, lock the 
access panel and secure internal 
components.

Padlock loop Prevents access panel from being removed. 
This loop can also be used to secure the unit 
to a fixed object.

Install a padlock.

Solenoid Hood (Smart Cover) 
Lock (Optional)

Prevents removal of the access panel and all 
internal components including optical and 
diskette drives. Eliminates the need for a 
physical key by enabling password-protected 
locking & unlocking by a local or remote user. 
This feature is sold with the Hood Sensor.

Install a solenoid lock.

Hood Sensor (Optional) Notifies a local or remote user when the 
chassis access panel has been opened. This 
feature is sold with the Solenoid Hood (Smart 
Cover) Lock.

Install an intrusion sensor.

Universal Chassis Clamp Lock 
(Optional)

The version without a cable discourages 
access panel removal and prevents theft of IO 
devices. The version with a cable additionally 
prevents entire system theft and allows 
multiple systems to be secured with a single 
cable.

Install a chassis clamp lock.

Rear Port Controller Cover Clips to the back of the workstation and 
secures your input-output devices and 
prevents any cables at the back of the 
workstation from being removed. 

Install a rear port controller cover.

NOTE: For more information about Computer Setup, see “Using Computer Setup (F10)” on page 36.

Table 3-3 Security Features Overview

Feature Purpose How it is Established
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Password Security

The power-on password prevents unauthorized use of the workstation by requiring entry of a password 
to access applications or data each time the workstation is turned on or restarted. The setup password 
specifically prevents unauthorized access to Computer Setup, and can also be used as an override to 
the power-on password. That is, when prompted for the power-on password, entering the setup 
password instead will allow access to the workstation.

A network-wide setup password can be established to enable the system administrator to log in to all 
network systems to perform maintenance without having to know the power-on password.

NOTE System Software Manager and HP Client Manager Software allow remote management of Setup 
Passwords and other BIOS settings in a networked environment. For more information, visit http://
www.hp.com/go/EasyDeploy.

ESTABLISHING A SETUP PASSWORD USING COMPUTER SETUP

Establishing a setup password through Computer Setup prevents reconfiguration of the workstation (use 
of the Computer Setup (F10) utility) until the password is entered.

To establish a setup password using workstation setup:

1 Turn on or restart the workstation. If you are in Windows, click Start>Shut Down>Restart.

2 Wait for the F10=Setup prompt to appear on the lower right corner of the screen. Once you see the 
prompt, press the F10 key to enter the F10 setup utility.

NOTE If you do not press the F10 key at the appropriate time, you must restart the workstation and try 
again to access the utility. 

3 Select Security>Setup Password and follow the on-screen instructions.

4 Before exiting, select File>Save Changes and Exit.

ESTABLISHING A POWER-ON PASSWORD USING WORKSTATION SETUP

Establishing a power-on password through Computer Setup prevents access to the workstation when 
power is turned on, unless the password is entered. When a power-on password is set, Computer Setup 
presents Password Options under the Security menu. The password options include Network Server 
Mode and Password Prompt on Warm Boot.

When Network Server Mode is disabled, the password must be entered each time the workstation is 
turned on when the key icon appears on the monitor. When Password Prompt on Warm Boot is enabled, 
the password must also be entered each time the workstation is rebooted. When Network Server Mode 
is enabled, the password prompt is not presented during POST, but any attached PS/2 keyboard will 
remain locked until the user enters the power-on password.
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To establish a power-on password through workstation setup:

1 Turn on or restart the workstation. If you are in Windows, click Start>Shut Down>Restart.

2 Wait for the F10=Setup prompt to appear on the lower right corner of the screen. Once you see the 
prompt, press the F10 key to enter the F10 setup utility.

NOTE If you do not press the F10 key at the appropriate time, you must restart the workstation and try 
again to access the utility. 

3 Select Security>Power-On Password and follow the on-screen instructions.

4 Before exiting, select File>Save Changes and Exit.

ENTERING A POWER-ON PASSWORD

To enter a power-on password:

1 Turn on or restart the workstation. If you are in Windows, click Start>Shut Down>Restart the 
Computer.

2 When the key icon appears on the monitor, enter the current password, then press Enter.

NOTE Type carefully. For security reasons, the characters you enter do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful 
tries, you must turn off the workstation, then turn it on again before you can continue.

ENTERING A SETUP PASSWORD

If a setup password has been established on the workstation, you will be prompted to enter it each time 
you run Computer Setup.

To enter a setup password:

1 Turn on or restart the workstation. If you are in Windows, click Start>Shut Down>Restart the 
Computer.

2 Wait for the F10=Setup prompt to appear on the lower right corner of the screen. Once you see the 
prompt, press the F10 key to enter the F10 setup utility.

NOTE If you do not press the F10 key at the appropriate time, you must restart the workstation and try 
again to access the utility. 

3 When the key icon appears on the monitor, enter the setup password, then press Enter.

NOTE Type carefully. For security reasons, the characters you enter do not appear on the screen.
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If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful 
tries, you must turn off the workstation, then turn it on again before you can continue.

CHANGING A POWER-ON OR SETUP PASSWORD

To change a power-on or setup password:

1 Turn on or restart the workstation. If you are in Windows, click Start>Shut Down>Restart the 
Computer. To change the setup password, run Computer Setup.

2 To change the Power-On password, go to step 3.

To change the Setup password, wait for the F10=Setup prompt to appear on the lower right corner of 
the screen. Once you see the prompt, press the F10 key to enter the F10 setup utility.

NOTE If you do not press the F10 key at the appropriate time, you must restart the workstation and try 
again to access the utility. 

3 When the key icon appears, type the current password, a slash (/) or alternate delimiter character, 
your new password, another slash (/) or alternate delimiter character, and your new password again 
as shown:

current password/new password/new password

NOTE Type carefully. For security reasons, the characters you enter do not appear on the screen.

4 Press Enter.

The new password takes effect the next time you turn on the workstation.

NOTE See the “National Keyboard Delimiter Characters” on page 58 for information about the alternate 
delimiter characters. The power-on password and setup password can also be changed using the 
Security options in Computer Setup.
56 SYSTEM MANAGEMENT



C
h
a
p
t
e
r
 
3

Deleting a Power-On or Setup Password

To delete a power-on or setup password:

1 Turn on or restart the workstation. If you are in Windows, click Start>Shut Down>Restart the 
Computer.

2 To delete the Power-On password, go to Step 3.

To delete the Setup Password, wait for the F10=Setup prompt to appear on the lower right corner of 
the screen. Once you see the prompt, press the F10 key to enter the F10 setup utility.

NOTE If you do not press the F10 key at the appropriate time, you must restart the computer and try 
again to access the utility.

3 When the key icon appears, enter your current password followed by a slash (/) or alternate delimiter 
character as shown:

current password/

4 Press Enter.

NOTE See the “National Keyboard Delimiter Characters” on page 58 section for information about the 
alternate delimiter characters. The power-on password and setup password can also be changed using 
the Security options in Computer Setup.
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NATIONAL KEYBOARD DELIMITER CHARACTERS

Each keyboard is designed to meet country-specific requirements. The syntax and keys that you use for 
changing or deleting your password depend on the keyboard that came with your workstation.

CLEARING PASSWORDS

If you forget your password, you cannot access the workstation. See Appendix H, “Additional Password 
Security and Resetting CMOS” for instructions on clearing passwords.

DriveLock

DriveLock prevents unauthorized access to the data on MultiBay hard drives. DriveLock has been 
implemented as an extension to Computer Setup. It is only available when DriveLock-capable hard 
drives are detected.

DriveLock employs a two-password security scheme. One password is intended to be set and used by a 
system administrator while the other is typically set and used by the end-user. There is no “back-door” 
that can be used to unlock the drive if both passwords are lost. Therefore, DriveLock is most safely used 
when the data contained on the hard drive is replicated on a corporate information system or is regularly 
backed-up.

CAUTION If both DriveLock passwords are lost, the hard drive is rendered unusable.

Table 3-4 National Keyboard Delimiter Characters

Arabic / Greek - Russian /

Belgian = Hebrew . Slovakian -

BHCSY* - Hungarian - Spanish -

Brazilian / Italian - Swedish/Finnish /

Chinese / Japanese / Swiss -

Czech - Korean / Taiwanese /

Danish - Latin American - Thai /

French ! Norwegian - Turkish .

French Canadian é Polish - U.K. English /

German - Portuguese - U.S. English /

*For Bosnia-Herzegovina, Croatia, Slovenia, and Yugoslavia
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USING DRIVELOCK

The DriveLock option appears under the Security menu in Computer Setup. The user is presented with 
options to set the master password or to enable DriveLock. A user password must be provided to enable 
DriveLock. Since the initial configuration of DriveLock is typically performed by a system administrator, a 
master password should be set first. HP encourages system administrators to set a master password 
whether they plan to enable DriveLock or keep it disabled. This will give the administrator the ability to 
modify DriveLock settings if the drive is locked in the future. Once the master password is set, the 
system administrator can enable DriveLock or choose to keep it disabled.

If a locked hard drive is present, POST will require a password to unlock the device. If a power-on 
password is set and it matches the user password of the device, POST will not prompt the user to re-
enter the password. Otherwise, the user will be prompted to enter a DriveLock password. Either the 
master or the user password can be used. Users will have two attempts to enter a correct password. If 
neither attempt succeeds, POST will continue but the data on the drive will remain inaccessible.

DRIVELOCK APPLICATIONS

The most practical use of the DriveLock security feature is in a corporate environment where a system 
administrator provides users with MultiBay hard drives for use in some desktop workstations. The 
system administrator would be responsible for configuring the MultiBay hard drive which would involve, 
among other things, setting the DriveLock master password. In the event that the user forgets the user 
password or the equipment is passed on to another employee, the master password can always be used 
to reset the user password and regain access to the hard drive.

HP recommends that corporate system administrators who choose to enable DriveLock also establish a 
corporate policy for setting and maintaining master passwords. This should be done to prevent a 
situation where an employee intentionally or unintentionally sets both DriveLock passwords before 
leaving the company. In such a scenario, the hard drive would be rendered unusable and require 
replacement. Likewise, by not setting a master password, system administrators might find themselves 
locked out of a hard drive and unable to perform routine checks for unauthorized software, other asset 
control functions and support.

For users with less stringent security requirements, HP does not recommend enabling DriveLock. Users 
in this category include personal users or users who do not maintain sensitive data on their hard drives 
as a common practice. For these users, the potential loss of a hard drive resulting from forgetting both 
passwords is much greater than the value of the data DriveLock has been designed to protect. Access to 
Computer Setup and DriveLock can be restricted through the Setup password. By specifying a Setup 
password and not giving it to end users, system administrators are able to restrict users from enabling 
DriveLock.
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Hood Sensor

The hood sensor is an optional feature that is a combination of hardware and software technology that 
can alert you when the workstation access panel has been removed. This option is available as a kit that 
includes the solenoid hood (Smart Cover) lock (see the following section). There are three levels of 
protection, as described in the following table.

SETTING THE HOOD SENSOR PROTECTION LEVEL

To set the hood sensor protection level:

1 Turn on or restart the workstation. If you are in Windows, click Start>Shut Down>Restart.

2 Wait for the F10=Setup prompt to appear on the lower right corner of the screen. Once you see the 
prompt, press the F10 key to enter the F10 setup utility.

NOTE If you do not press the F10 key at the appropriate time, you must restart the computer and try 
again to access the utility. 

3 Select Security>Smart Cover>Cover Removal Sensor, then access panel, and follow the on-
screen instructions.

4 Before exiting, select File>Save Changes and Exit.

Solenoid Hood (Smart Cover) Lock

The solenoid hood lock is available as an option on HP Workstation xw4200 models (this option comes 
as a kit that includes the hood sensor). When installed, the solenoid hood lock can prevent unauthorized 
access to the internal components.

CAUTION For maximum cover lock security, be sure to establish a setup password. The setup 
password prevents unauthorized access to the Computer Setup utility.

Table 3-5 Hood Sensor Protection Levels

Level Setting Description

Level 0 Disabled Hood sensor is disabled (default).

Level 1 Notify User When the workstation is restarted, the screen displays a message 
indicating that the workstation access panel has been removed.

Level 2 Setup Password When the workstation is restarted, the screen displays a message 
indicating that the workstation access panel has been removed. You 
must enter the setup password to continue.

NOTE: These settings can be changed using Computer Setup.
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LOCKING THE SOLENOID HOOD LOCK

To activate and lock the solenoid hood lock:

1 Turn on or restart the workstation. If you are in Windows, click Start>Shut Down>Restart.

2 Wait for the F10=Setup prompt to appear on the lower right corner of the screen. Once you see the 
prompt, press the F10 key to enter the F10 setup utility.

NOTE If you do not press the F10 key at the appropriate time, you must restart the workstation and try 
again to access the utility. 

3 Select Security>Smart Cover>Cover Lock>Lock option.

4 Before exiting, select File>Save Changes and Exit.

UNLOCKING THE SOLENOID HOOD LOCK

To unlock the solenoid hood lock:

1 Turn on or restart the workstation. If you are in Windows, click Start>Shut Down>Restart.

2 Wait for the F10=Setup prompt to appear on the lower right corner of the screen. Once you see the 
prompt, press the F10 key to enter the F10 setup utility.

NOTE If you do not press the F10 key at the appropriate time, you must restart the workstation and try 
again to access the utility. 

3 Select Security>Smart Cover>Cover Lock>Unlock.

4 Before exiting, select File>Save Changes and Exit.

USING THE ACCESS PANEL FAILSAFE KEY

If you enable the solenoid hood lock and cannot enter your password to disable the lock, you will need a 
access panel FailSafe Key to open the workstation access panel. You will need the key in any of the 
following circumstances:

Power outage

Startup failure

PC component failure (such as processor or power supply)

Forgotten password

CAUTION The access panel FailSafe Key is a specialized tool available from HP. Be prepared; order 
this key before you need one.
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To obtain the FailSafe Key, complete any one of the following tasks:

Contact your authorized HP reseller or service provider.

Visit the HP Web site (http://www.hp.com) for ordering information.

Visit the Contact HP Worldwide Web site (http://welcome.hp.com/country/us/en/wwcontact.html) for 
contact information.

Master Boot Record Security

The MBR contains information needed to successfully boot from a disk and to access the data stored on 
the disk. Master Boot Record Security detects and reports unintentional or malicious changes to the 
MBR, such as those caused by some workstation viruses or by the incorrect use of certain disk utilities. It 
also allows you to recover the “last known good” MBR, should changes to the MBR be detected when 
the system is restarted.

To enable MBR Security:

1 Turn on or restart the workstation. If you are in Windows, click Start>Shut Down>Restart.

2 Wait for the F10=Setup prompt to appear on the lower right corner of the screen. Once you see the 
prompt, press the F10 key to enter the F10 setup utility.

NOTE If you do not press the F10 key at the appropriate time, you must restart the workstation and try 
again to access the utility. 

3 Select Security>Master Boot Record Security>Enabled.

4 Select Security>Save Master Boot Record.

5 Before exiting, select File>Save Changes and Exit.

When MBR Security is enabled, the BIOS prevents any changes being made to the MBR of the current 
bootable disk while in MS-DOS or Windows Safe Mode.

NOTE Most operating systems control access to the MBR of the current bootable disk; the BIOS cannot 
prevent changes that might occur while the operating system is running.
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Each time the workstation is turned on or restarted, the BIOS compares the MBR of the current bootable 
disk to the previously saved MBR. If changes are detected and if the current bootable disk is the same 
disk from which the MBR was previously saved, the following message is displayed:

1999 - Master Boot Record has changed.
Press any key to enter Setup to configure MBR Security.

Upon entering Computer Setup, you must perform one of the following tasks:

Save the MBR of the current bootable disk

Restore the previously saved MBR

Disable the MBR Security feature

You must know the setup password, if one exists.

If changes are detected and if the current bootable disk is not the same disk from which the MBR was 
previously saved, the following message is displayed:

2000 - Master Boot Record Hard Drive has changed.
Press any key to enter Setup to configure MBR Security.

Upon entering Computer Setup, you must perform one of the following tasks:

Save the MBR of the current bootable disk

Disable the MBR Security feature

You must know the setup password, if one exists.

In the unlikely event that the previously saved MBR has been corrupted, the following message is 
displayed:

1998 - Master Boot Record has been lost.
Press any key to enter Setup to configure MBR Security.

Upon entering Computer Setup, you must perform one of the following tasks:

Save the MBR of the current bootable disk

Disable the MBR Security feature

You must know the setup password, if one exists.

Before You Partition or Format the Current Bootable Disk

Before you partition or format the current bootable disk, ensure that MBR Security is disabled before you 
change partitioning or formatting of the current bootable disk. Some disk utilities, such as FDISK and 
FORMAT, attempt to update the MBR. If MBR Security is enabled when you change partitioning or 
formatting of the disk, you might receive error messages from the disk utility or a warning from MBR 
Security the next time the workstation is turned on or restarted.
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To disable MBR Security:

1 Turn on or restart the workstation. If you are in Windows, click Start>Shut Down>Restart the 
Computer.

2 Wait for the F10=Setup prompt to appear on the lower right corner of the screen. Once you see the 
prompt, press the F10 key to enter the F10 setup utility.

NOTE If you do not press F10 key at the appropriate time, you must restart the workstation and try again 
to access the utility. 

3 Select Security>Master Boot Record Security>Disabled.

4 Before exiting, select File>Save Changes and Exit.

Cable Lock Slot

The rear panel of the chassis can accommodate a cable lock accessory that allows the workstation to be 
physically secured to a work area.

For illustrated instructions, see “Cable Lock (Optional)” on page 75.

Padlock (Optional)

Prevents entire system theft and discourages access panel removal.

For illustrated instructions, see “Security Padlock (Optional)” on page 75.

Universal Chassis Clamp Lock (Optional)

The version without a cable discourages access panel removal and prevents theft of IO devices. The 
version with a cable also prevents entire system theft and allows multiple systems to be secured with a 
single cable.

For illustrated instructions, see “Universal Chassis Clamp Lock (Optional)” on page 76.

Rear Port Controller Cover (Optional)

Locks rear I/O cables to prevent cable theft.

Fingerprint Identification Technology

Eliminating the need to enter user passwords, HP Fingerprint Identification Technology tightens network 
security, simplifies the login process, and reduces the costs associated with managing corporate 
networks. Affordably priced, it is not just for high-tech, high-security organizations anymore.

Support for Fingerprint Identification Technology varies by model.

For more information, visit http://ht8004.www1,hp.com/products/security.
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Fault Notification and Recovery
Fault Notification and Recovery features combine innovative hardware and software technology to 
prevent the loss of critical data and minimize unplanned downtime.

If the workstation is connected to a network managed by HP Client Manager Software, the computer 
sends a fault notice to the network management application. With HP Client Manager Software, you can 
also remotely schedule diagnostics to automatically run on all managed PCs and create a summary 
report of failed tests.

Drive Protection System

The DPS is a diagnostic tool built into the hard drives installed in select HP workstations. DPS is 
designed to help diagnose problems that might result in unwarranted hard drive replacement.

When HP workstations are built, each installed hard drive is tested using DPS, and a permanent record 
of key information is written onto the drive. Each time DPS is run, test results are write to the hard drive. 
Each time DPS is run, test results are written to the hard drive. The service provider can use this 
information to help diagnose conditions that caused you to run the DPS software.

Ultra ATA Integrity Monitoring

Ultra ATA Integrity Monitoring monitors the integrity of data as it is transferred between an Ultra ATA hard 
drive and the system’s core logic. If the workstation detects an abnormal number of transmission errors, 
the workstation displays a Local Alert message with recommended actions.

ECC Fault Prediction and Prefailure Warranty

When the workstation encounters an excessive number of error checking and correcting (ECC) memory 
errors, the workstation displays a Local Alert message. This message contains detailed information 
about the errant memory module, allowing you to take action before you experience non-correctable 
memory errors. The Prefailure Warranty for ECC memory modules allows you to replace these modules, 
free of charge, before the modules actually fail. ECC memory modules are optional on selected HP 
systems.

NOTE To use this feature, you must replace the standard DIMMs with HP ECC DIMMs.

Surge-Tolerant Power Supply

An integrated surge-tolerant power supply provides greater reliability when the workstation is hit with an 
unpredictable power surge. This power supply is rated to withstand a power surge of up to 2000 V (Line 
to PE or Neutral to PE) and 1000 V (Line to Line) without any data loss or system downtime.

Thermal Sensor

The thermal sensor is a hardware and software feature that tracks the internal temperature of the 
workstation. When combined with HP Client Manager Software, this feature notifies the network 
administrator when the normal range is exceeded.

The thermal sensor monitors the processor temperature and if the temperature gets too hot, the 
processor clock automatically begins to throttle. If the temperature does not go down, then the system 
eventually shuts down.
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Chapter 4 Removal and Replacement

This chapter discusses removal and replacement procedures for the HP Workstation xw4200. This 
chapter includes the following sections:

“Service Considerations” on page 68

“Pre-Disassembly Procedures” on page 73

“Removal and Replacement of Components” on page 73
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Service Considerations
The following sections discuss service considerations that should be reviewed and practiced before 
removing and replacing any system components.

WARNING! When lifting or moving the workstation, do not use the front bezel as a handle or lifting point. 
Lifting the workstation from the front bezel or lifting it incorrectly could cause the unit to fall and harm the 
user and damage the workstation. To properly and safely lift the workstation, lift it from the bottom of the 
unit.

Read Cautions, Warnings, and Safety Precautions
For your safety, you must review the “Important Safety Warnings” on page vii before accessing the 
components of the workstation. Also, review the Safety and Regulatory Guide that came with your 
workstation for more information.

Electrostatic Discharge Information
A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive 
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic 
device exposed to electrostatic discharge (ESD) might not appear to be affected at all and can work 
perfectly throughout a normal cycle. The device might function normally for a while, but it has been 
degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the discharge 
contains enough power to alter device parameters or melt silicon junctions.

Generating Static

The following table shows that:

Different activities generate different amounts of static electricity.

Static electricity increases as humidity decreases.

Table 4-1 Generating Static Electricity

Relative Humidity

Event 55% 40% 10%

Walking across carpet
Walking across vinyl floor
Motions of bench worker

7,500 V
3,000 V

400 V

15,000 V
5,000 V

800 V

35,000 V
12,000 V

6,000 V

Removing bubble pack from PCB
Packing PCBs in foam-lined box

7,000 V
5,000 V

20,000 V
11,000 V

26,500 V
21,000 V

NOTE: 700 volts can degrade a product.
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Preventing Electrostatic Damage to Equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree 
of sensitivity. The following packaging and grounding precautions are necessary to prevent damage to 
electric components and accessories.

Transport products in static-safe containers, such as tubes, bags, or boxes to avoid hand contact.

Protect all electrostatic parts and assemblies with conductive or approved containers or packaging.

Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

Place items on a grounded surface before removing them from their container.

When handling or touching a sensitive component or assembly, ground yourself by touching the 
chassis.

Avoid contact with pins, leads, or circuitry.

Place reusable electrostatic-sensitive parts from assemblies in protective packaging or conductive 
foam.

Personal Grounding Methods and Equipment

To prevent static electricity damage to equipment, use the following equipment:

Wrist straps are flexible straps with a maximum of one-megohm ± 10% resistance in the ground 
cords. To provide proper ground, wear the strap against bare skin. The ground cord must be 
connected and fit snugly into the banana plug connector on the grounding mat or workstation.

Heel straps, toe straps, and boot straps can be used at standing workstations and are compatible 
with most types of shoes or boots. On conductive floors or dissipative floor mats, use them on both 
feet with a maximum of one-megohm ± 10% resistance between the operator and ground.

The following table shows static shielding protection levels.

Grounding the Work Area

To prevent static damage at the work area:

Cover the work surface with approved static-dissipative material. Provide a wrist strap connected to 
the work surface and properly grounded tools and equipment.

Use static-dissipative mats, foot straps, or air ionizers to give added protection.

Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate. 
Handle them only at static-free work areas.

Turn off power and input signals before inserting and removing connectors or test equipment.

Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.

Table 4-2 Static Shielding Protection Levels

Method Voltage

Antistatic plastic
Carbon-loaded plastic
Metallized laminate

1,500
7,500

15,000
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Keep work area free of nonconductive materials such as ordinary plastic assembly aids and 
Styrofoam.

Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended Materials and Equipment

Materials and equipment that are recommended for use in preventing static electricity include:

Antistatic tape

Antistatic smocks, aprons, or sleeve protectors

Conductive bins and other assembly or soldering aids

Conductive foam

Conductive tabletop workstations with ground cord of one-megohm ± 10% resistance

Static-dissipative table or floor mats with hard tie to ground

Field service kits

Static awareness labels

Wrist straps and footwear straps providing one-megohm ± 10% resistance

Material handling packages

Conductive plastic bags

Conductive plastic tubes

Conductive tote boxes

Opaque shielding bags

Transparent metallized shielding bags

Transparent shielding tubes

Tools and Software Requirements
To service the workstation, you might need the following equipment:

Torx T-15 screwdriver or Flat-bladed screwdriver (can be used in place of the Torx screwdriver)

Phillips screwdriver (to remove the rear fan, if necessary)

Diagnostics software

Tamper-resistant T-15 wrench (FailSafe key) or tamper-resistant bits (required if you get locked out 
by the solenoid hood lock)

Screws
The screws used in the workstation are not interchangeable. The screws might have standard or metric 
threads and might be of different lengths. If an incorrect screw is used during the reassembly process, it 
can damage the unit. HP recommends that all screws removed during disassembly be kept with the part 
that was removed, then returned to their proper locations.
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NOTE Metric screws have a black finish. American National (unified) screws have a silver finish.

NOTE As each subassembly is removed from the workstation, place the subassembly away from the 
work area to prevent damage.

If necessary, additional drive guide screws are provided on the system chassis. There are eight Metric 
screws located on the chassis near the 5.25-inch optical drive bays. These screws can be used to 
mount additional optical drives or an optional diskette drive. There are four American National screws 
located on the chassis near the hard drive. These screws can be used to mount additional hard drives in 
the 3.5” hard drive cage. For more information about this procedure, see “Installing Hard Drives in the 
5.5” slot (Optional)” on page 112.

NOTE The Metric (black) and American National (silver) screws are not interchangeable.

Special Handling of Components
The following components require special handling when servicing the workstation.

WARNING! Do not use the front bezel as a handle or lifting point when lifting or moving the workstation. 
Lifting the workstation from the front bezel or lifting it incorrectly could cause the unit to fall and cause 
harm to the user and damage to the workstation. To properly and safely lift the workstation, lift it from the 
bottom of the unit from either the desktop or minitower configuration.

1 Metric screws (8)

2 American National screws (4)

1

2
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Cables and Connectors

Cables must be handled with care to avoid damage. Apply only the tension required to seat or unseat the 
cables during insertion or removal from the connector. Handle cables by the connector whenever 
possible. In all cases, avoid bending or twisting the cables, and ensure that the cables are routed in such 
a way that they cannot be caught or snagged by parts being removed or replaced.

CAUTION When servicing this workstation, ensure that cables are placed in their proper location during 
the reassembly process. Improper cable placement can damage the workstation.

Hard Drives

Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This 
applies to failed drives as well as replacement spares.

If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective 
packaging and label the package “Fragile: Handle With Care.”

Do not remove hard drives from the shipping package for storage. Keep hard drives in their protective 
packaging until they are actually mounted in the workstation.

Avoid dropping drives from any height onto any surface.

If you are inserting or removing a hard drive, turn off the workstation. Do not remove a hard drive 
while the workstation is on or in standby mode.

Before handling a drive, ensure that you are discharged of static electricity. While handling a drive, 
avoid touching the connector. For more information about preventing electrostatic damage, see 
“Electrostatic Discharge Information” on page 68.

Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields, 
such as monitors or speakers.

Lithium Coin Cell Battery

The battery that comes with the workstation provides power to the real-time clock and has a minimum 
lifetime of about three years.

For instructions on battery removal and replacement procedures, see “Battery” on page 100.

WARNING! This workstation contains a lithium battery. There is a risk of fire and chemical burn if the 
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in 
water or fire, or expose it to temperatures higher than 140º F (60º C).

CAUTION Do not dispose of batteries, battery packs, and accumulators together with the general 
household waste.

Batterij niet
weggooien,

maar inleveren
als KCA.
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Pre-Disassembly Procedures
Before servicing the workstation:

1 Remove/disengage any security devices that prohibit opening the workstation.

2 Close any open software applications.

3 Remove any diskette or compact disc from the workstation.

4 Exit the operating system.

5 Turn off the workstation and any peripheral devices that are connected to it.

6 Remove/disengage any security devices that prohibit opening the workstation.

CAUTION Turn off the workstation before disconnecting any cables.

CAUTION The cooling fan is off only when the workstation is turned off or the power cable has been 
disconnected. The cooling fan is always on when the workstation is in the “On,” “Standby,” or “Suspend” 
modes. You must disconnect the power cord from the power source before opening the workstation to 
prevent system board or component damage.

7 Disconnect the power cord from the electrical outlet and then from the workstation.

8 Disconnect all peripheral device cables from the workstation. For more information, see “Electrostatic 
Discharge Information” on page 68.

Removal and Replacement of Components
This section discusses the procedures necessary to remove and install various hardware components 
on your workstation. Review the safety and precautions and the “Service Considerations” on page 68, as 
well as the Safety and Regulatory Guide, before servicing or upgrading your system.

1 Read all safety information and precautions.

2 Locate and clear a suitable work area.

3 Shut down the system and remove power from the unit.

4 Gather your tools.

5 Service your unit.

6 Restore power to your unit.
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Disassembly Order
Use the following table to determine the order in which to remove the major components.

Pre-Disassembly (page 73)

Locks (page 75)

Access (Hood) Panel (page 77)

Access Panel (Hood) Sensor (page 78)

Front Bezel (page 80)

Front Panel I/O Assembly (page 83)

Power Button (page 84)

System Speaker (page 87)

Optical Drive (page 102)

Diskette Drive (page 106)

Bezel Blanks (page 80)

Power Supply (page 85)

System Fan (page 86)

Memory (page 93)

Battery (page 100)

Hard Drive (page 107)

Processor Heatsink (page 88)

Processor (page 91)

System Speaker (page 87)

PCI or PCI Express Cards (page 98)

System Board (page 114)
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Security Padlock (Optional)
If a security padlock is installed, remove it before servicing the unit. To remove the padlock, unlock it and 
slide it out of the padlock loop as shown in the following illustration.

Cable Lock (Optional)
If a cable lock is installed, remove it before servicing the unit. To remove the cable lock, unlock it and pull 
it out of the cable lock slot as shown in the following illustration.
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Universal Chassis Clamp Lock (Optional)
If a universal chassis clamp lock is installed, remove it before servicing the unit. To remove the noble 
lock:

1 Unlock the screw cover from the universal clamp as shown in the following illustration.

2 Unscrew the universal clamp from the unit as shown in the following illustration.
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Access Panel
Before accessing the internal components of the HP Workstation xw4200, the access panel must be 
removed.

To remove the panel:

WARNING! Ensure that the workstation is turned off and that the power cord is disconnected from the 
electrical outlet before removing the workstation access panel.

1 Disconnect power from the system (page 73) and, if necessary, unlock the security lock and cable 
lock (page 75), and disconnect the universal clamp lock (page 76).

2 Lay the unit in the desktop position as shown in the following illustration.

3 Pull up and out on the cover latch 1 and at the same time slide the cover 2 away from the bezel and 
then lift up.

To replace the access panel, lay it flat on the unit about one inch from the bezel. The hooks should fall 
into the recesses. Then slide the cover towards the bezel until it snaps into place.

1

2
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Access Panel (Hood) Sensor (Optional)
To remove the hood sensor:

1 Disconnect power from the system (page 73) and remove the access panel (page 77).

2 Disconnect the hood sensor 1 from the system board.

3 Slide the hood sensor 2 forward as shown in the following illustration.

CAUTION The hood sensor bracket and the chassis contain sharp edges that present a safety hazard. 
Be careful when sliding the hood sensor forward.

4 Pull the hood sensor 3 down and remove it from the chassis.

To replace the hood sensor, reverse the previous steps.

2

3

1
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Solenoid Hood (Smart Cover) Lock (Optional)
To remove the solenoid lock:

1 Disconnect power from the system (page 73) and remove the access panel (page 77).

2 Disconnect the access panel lock cable 1 from the system board.

3 Using the FailSafe key, unscrew the two screws 2 from the back of the chassis as shown in the 
following diagram.

4 Slide the access panel lock assembly 3 away from the chassis and out of the unit.

To replace the access panel lock assembly, reverse the previous steps.

2

1

3
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Front Bezel
To remove the bezel:

1 Disconnect power from the system (page 73) and remove the access panel (page 77).

2 Lift up on the two tabs 1 located on the front bezel.

3 Rotate the front bezel 2 away from the chassis as shown in the following illustration and remove the 
bezel.

Bezel Blanks
To remove the bezel blanks:

1 Disconnect power from the system (page 73), and remove the access panel (page 80) and front 
bezel. After removing the front bezel, gently pull the subpanel 1, with the bezel blanks secured in it, 
away from the front bezel.

2 Remove the desired bezel blank 2 by pulling the blank away from the subpanel.

NOTE The bezel blanks are keyed to assist you in replacing the blanks. Also, the subpanel can be 
rotated 90 degrees to install the optical drives in desktop orientation, if desired.

1

2

21
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Chassis Feet
The HP Workstation xw4200 ships in a minitower configuration and chassis feet are installed on the base 
of the workstation. The unit ships with additional feet should you convert the unit to a desktop.

To install the chassis feet on a desktop-oriented workstation:

1 Situate the unit into the appropriate position as shown in the following illustration.

2 Place the feet into the embossed areas of the unit.
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IEEE-1394 (Optional)
To install an optional IEEE-1394 adapter:

1 Unlatch the PCI levers 1 and the PCI slot cover 2.

2 Install the IEEE-1394 card 3 into the PCI socket.

3 Close the PCI levers 4.

4 Connect the front I/O cable 5 and power cable 6 into the card.

5 Remove the sticker covering the front IEEE-1394 connector.

1
1

2

4
4

3

5

6
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Front Panel I/O Assembly
To remove the front panel I/O assembly:

1 Disconnect power from the system (page 73), remove the access panel (page 77), and remove the 
front bezel (page 80).

2 Disconnect the front panel I/O assembly cable from the system board.

3 Remove the two screws 1 that hold the assembly bracket to the chassis as shown in the following 
illustration.

4 Remove the two screws 2 that hold the bracket and assembly together and separate the shield away 
from the front panel I/O assembly 3.

5 Slide the front panel I/O assembly 4 (with bracket attached) out about two inches away from the 
chassis.

WARNING! The next step requires the removal of cables through the chassis. Some edges on the 
chassis might be sharp. Care must be taken when removing these cables.

6 Slide the front panel cables through the chassis and out the front of the unit.

To replace the front panel I/O assembly, reverse the previous steps.

1
1 2

2

4

3
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Power Button Assembly
To remove the front power button assembly:

1 Disconnect power from the system (page 73), remove the access panel (page 77), remove the front 
bezel (page 80), and remove the front panel I/O assembly (page 83).

2 Disconnect the power assembly cable from the system board.

3 Press the clips at the top 1 and bottom 2 of the power assembly, then slide the assembly out from the 
front of the chassis as shown in the following illustration.

2

1
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Power Supply
To remove the power supply:

1 Disconnect power from the system (page 73) and remove the access panel (page 77).

2 Disconnect the power supply from the system board.

3 Disconnect all devices (optical drives, diskette drive, hard drives, and on select models, the graphics 
card and IEEE-1394 card) from the power supply.

4 Remove the four screws 1 from the back panel.

5 Slide the power supply 2 toward the front and lift up to remove it from the chassis.

To install the power supply, reverse the previous steps.

1

2
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System Fan
To remove the system fan:

1 Disconnect power from the system (page 73) and remove the access panel (page 77).

2 Disconnect the fan connector 1 from the system board.

3 Remove the four screws 2 from the back of the chassis back panel with a Phillips screwdriver.

4 Slide the fan 3 toward the front of the unit and remove it.

To replace a system fan, reverse the previous steps.

CAUTION When installing the system fan, ensure that the fan is situated so that the airflow direction is 
going out of the chassis.

NOTE This system only supports 4-wire fans.

2

3

1
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System Speaker
To remove the speaker:

1 Disconnect power from the system (page 73) and remove the access panel (page 77).

2 Disconnect the speaker 1 from the system board.

3 Remove the four screws 2 as shown in the following illustration.

4 Pull the speaker out of the chassis.

To replace the speaker, reverse the previous steps.

1

2
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Processor Heatsink

NOTE The following illustrated heatsink is typical of what you might have in your workstation. Be aware 
that different versions of the heatsinks exist, but the overall procedures listed are sufficient to assist you 
in removing the heatsink.

Removing the Heatsink

To remove the heatsink:

1 Turn on the workstation and enter Computer Setup (F10) (page 34). Let the workstation run in this 
mode for five minutes.

This action warms the thermal interface material between the heatsink and processor so that the 
thermal bond loosens, and can more easily be broken.

NOTE Windows in idle state does not provide sufficient heat to warm the compound.

2 After warming the thermal interface, shut down the system, disconnect power from the system 
(page 73), and remove the access panel (page 77).

3 Disconnect the heatsink wire 1 from the system board as shown in the two illustrations below.

4 Remove the captured heatsink screws 2 from the system board. Begin by slightly loosening any two 
screws that diagonally opposite from one another, then slightly loosen the other two. Then finish 
removing the screws. 

5 Gently twist the heatsink unit to break the thermal grease binding.

2

1
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6 Lift the heatsink 3 unit. Use alcohol and a soft cloth to clean all the thermal interface material residue 
from the processor heatsink and processor.

CAUTION Allow the alcohol on the processor heatsink to dry completely.

3

1
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Replacing the Heatsink

To replace the heatsink:

1 Disconnect power from the system (page 73), remove the access panel (page 77), and remove the 
heatsink (page 88).

2 Use alcohol and a soft cloth to clean all the thermal interface material residue from the processor 
heatsink and processor.

CAUTION Allow the alcohol on the processor heatsink to dry completely.

Apply new thermal grease between the heatsink and processor, then reverse the previous steps. Do not 
fully tighten one screw, then move on to the next. Tighten all screws a little at a time, making sure the 
processor remains level.

NOTE This system only supports 4-wire fans.
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Processor
To remove the processor:

1 Disconnect power from the system (page 73), remove the access panel (page 77), and remove the 
heatsink (page 88).

2 Raise the lever 1 on the processor socket handle and open the cover 2.

3 Pull the processor 3 straight out of the socket.

CAUTION If you damage the spring-loaded contacts in the socket, the system board may be damaged 
and your warranty voided.

1

2

3
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NOTE Store the processor in a safe place where it will not be damaged. 

To replace the processor:

1 Raise the processor socket handle fully (the full swing angle of the lever is approximately 135 
degrees).

CAUTION The contacts in the socket are delicate. Use extreme care when placing the processor in the 
socket.

2 Line up the triangle on the corner of the processor with the triangle on the corner of the processor 
socket and install the processor into the socket. Ensure that the underside of the processor is level 
with the top of the top of the processor socket. Lightly press down on the top of the processor while 
closing the socket lever.
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Memory
The HP Workstation xw4200 has four memory sockets. The system supports industry-standard, 240-pin 
DDR2 DIMMs.

The system can support up to 4 GB of memory (1-GB DIMM in each socket). Although a single 128-MB 
DIMM configuration is possible (on XMM1 only), always install DIMMs in pairs for optimal dual-channel 
operation.

Memory Module Requirements

Use only industry standard, unbuffered, PC2-3200 or PC2-4300 DIMMs.

Install unbuffered DDR2 DIMMs in pairs of matched size and type.

Registered memory is not supported.

Removing Memory Module

To remove DIMMs from the unit:

1 Disconnect power from the system (page 73), remove the access panel (page 77), and lay the 
workstation on its side with the system board facing up.

CAUTION To ensure that memory modules are not damaged during removal or installation, power off 
the workstation and unplug the power cord from the AC power outlet. Wait until the LED on the back of 
the power supply turns off before removing memory. If you do not unplug the power cord while installing 
memory, your memory modules might be damaged and the system will not recognize the memory 
changes.

2 Gently push outwards on the socket levers 1 as shown in the following illustration.

3 Lift the DIMM 2 straight up and remove it from the unit.

To replace memory, reverse the previous steps.

1

2

1
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NOTE DIMMs and the DIMM sockets are keyed for proper installation. Make sure the guides line up 
when installing a DIMM.

Installing Memory Module

You must load memory modules in valid configurations.

If using only one DIMM, install it in socket 1

Load the first DIMM pair A into sockets 1 and 3.

Load the second DIMM pair B into sockets 2 and 4.

1 2 3 4

A B
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Peripheral Component Interconnect (PCI) Slots

Table 4-3 PCI Slots

Slot Type Ref IDSEL INTs PME

1 PCI Express x1 J34 N/A A B C D PCI_EXP_WAKE#

2 PCI Express x16 J41 N/A A B C D PCI_EXP_WAKE#

3 PCI J20 AD20 A C F G P_PME#

4 PCI J21 AD25 C F G A P_PME#

5 PCI J22 AD26 F G A C P_PME#

6 PCI J23 AD27 G A C F P_PME#

7 PCI Express x1 J31 N/A A B C D PCI_EXP_WAKE#

Table 4-4 PCI Devices List

Device Bus Dev FN PFA Interrupts

Processor to I/O 
Controller

0 0 0 0000

MCH PCI Express 
Root Port (slot 2)

0 1 0 0008 A

ICH6R PCI Express 
Root Port (Slot 1)

0 28 0 00E0 A

ICH6R PCI Express 
Root Port (Slot 7)

0 28 1 00E1 B

ICH6R PCI Express 
Root Port (LAN)

0 28 3 00E3 D

1

2

3

4

5

6

7
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ICH6R USB 
Universal Host 
Controller

0 29 0 00E8 A

ICH6R USB 
Universal Host 
Controller

0 29 1 00E9 B

ICH6R USB 
Universal Host 
Controller

0 29 2 00EA C

ICH6R USB 
Universal Host 
Controller

0 29 3 00EB D

ICH6R USB2 
Enhanced Host 
Controller

0 29 7 00EF A

ICH6R PCI Bridge 0 30 0 00F0

ICH6R AC '97 0 30 2 00F2 A

ICH6R LPC 
Interface Controller

0 31 0 00F8

ICH6R Ultra ATA 
Storage Controllers

0 31 1 00F9 A

ICH6R SATA 
Controller

0 31 2 00FA B

Slot 2 (PCI Express 
x16)

1 0 0 0100 ABCD

Slot 3 (PCI) 5 4 0 0520 ACFG

Slot 4 (PCI) 5 9 0 0548 CFGA

Slot 5 (PCI) 5 10 0 0550 FGAC

Slot 6 (PCI) 5 11 0 0558 GACF

Slot 1 (PCI express 
x1)

32 0 0 2000 ABCD

Slot 7 (PCI Express 
x1)

64 0 0 4000 ABCD

Gigabit LAN 
Controller

128 0 0 8000 A

Table 4-4 PCI Devices List

Device Bus Dev FN PFA Interrupts
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PCI Express
PCI Express is a new hardware interconnect standard (for example, I/O slots). PCI Express is point-to-
point architecture and uses a serial data transmission protocol. A single PCI Express lane consists of 4 
wires and is capable of transmitting 250 MB/sec in a single direction or 500 MB/sec in both directions 
simultaneously. This bandwidth is not affected by what is happening on other PCI Express buses or 
legacy PCI/PCI-X buses (provided that total bandwidth can be handled by the CPU and the memory 
subsystem). The transmission protocol is somewhat similar to that used for a LAN connection and 
contains error correction and detection, packet addressing and other network features.

PCI Express improves system attributes. PCI Express enables a low-power, scalable, high-bandwidth 
communication path with a small number of connections (wires) compared to traditional parallel 
interfaces (for example, PCI).

The PCI Express I/O slots can support other PCI Express cards with lesser bus bandwidth than what is 
physically defined for the slot. Use the following table to determine compatibility.

For example, a PCI Express x4 card does not work in a PCI Express x16 slot, but a PCI Express x16 
card works in a PCI Express x16 slot.

Table 4-5 PCI Express Compatibility Matrix for xw4200

PCI Express x1 Slot PCI Express x4 Slot PCI Express x8 Slot PCI Express x16 Slot

PCI Express x1 Card Y not available not available Y

PCI Express x4 Card N not available not available N

PCI Express x8 Card N not available not available N

PCI Express x16 Card N not available not available Y
REMOVAL AND REPLACEMENT OF COMPONENTS 97



PCI or PCI Express Removal

To remove a PCI or PCI Express card:

1 Disconnect power from the system (page 73), remove the access panel (page 77), lay the 
workstation on its side with the system board facing up, and remove the PCI retainer (page 97).

2 Lift the PCI levers 1 by first pressing down on them and then out.

3 Lift the PCI card (2, left) out of the chassis. If removing a PCI Express card (2, right), remove the 
power supply cable (not shown), if required, and move the “hockey stick” lever 3 to release the card 
and lift it out of the chassis. Store the card in an anti-static bag.

4 Close the PCI levers.

Figure 4-1 PCI card removal (left) and PCI Express card removal (right)

1 1 1 1

2
2

3
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PCI or PCI Express Installation

To install a PCI or PCI Express card:

1 Disconnect power from the system (page 73), remove the access panel (page 77), lay the 
workstation on its side with the system board facing up, and remove the PCI retainer (page 97).

2 Lift the PCI levers 1 by first pressing down on them and then out.

3 Remove the PCI slot cover 2.

4 Install the PCI card (3, left) or PCI Express card (3, right) into the chassis. Verify that the keyed 
components of the card align with the PCI socket. If installing a PCI Express card, plug in the power 
supply cable, if required.

5 Close the PCI levers 4. If the PCI levers do not close, be sure all cards are properly seated and then 
try again.

6 If installing a PCI Express card, plug in the power supply cable 5, if required.

Figure 4-2 PCI card installation (left) and PCI Express Card Installation (right)

1 1 4 3 4

2

1
1

2

3

4
4

5
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Battery

CAUTION Back up your CMOS (complementary metal oxide semiconductor) settings before removing 
the battery, as all CMOS settings will be lost when the battery is removed. To back up the CMOS 
settings, in (F10 Setup click File>Replicated Setup>Save to Removable Media.

To remove the battery:

1 Disconnect power from the system (page 73), remove the access panel (page 77), and lay the 
workstation on its side with the system board facing up.

2 Press on the release tab 1 of the battery holder as shown in the following illustration.

3 Slide and lift the battery 2 out.

To install the battery, slide the battery back in until it snaps back into place.

2

1
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Power Connections to Drives
For help in identifying power cables, refer to the following illustration. Route or tie cables so that they 
cannot interfere with the heatsink fans.

P1

P3 P11

1394�CARD

GRAPHICS�CARD P4

P5

P15

P13

POWER
SUPPLY

P8

P6

P7

P12�SATA

P14�SATA

P9�SATA

P10�SATA

Processor

Main
Power

Power
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Optical Drive (Minitower Position)
To remove an optional optical drive, you must first release the drivelock. To release the optical drive:

1 Disconnect power from the system (page 73), remove the access panel (page 77), and lay the 
workstation on its side with the system board facing up.

2 Disconnect the power 1, drive 2, and audio 3 cables from the drive.

NOTE The audio cable is included with Linux-based systems only. Windows-based systems do not 
require the audio cable. 

3 After removing the front bezel and bezel blanks, lift the green drivelock release lever 1 and gently 
slide the drive 2 out of the chassis.

1

2

3

1

2
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4 After pulling the drive 1 out, remove the four guide screws 2 from the drive.

5 Verify the jumper settings of the new drive are set correctly.

6 To install a drive, first remove the front bezel (page 80) and bezel blanks (page 80). Insert the four 
guide screws 1 into the drive. Align the screws with the slots on the drive, and slide the drive 2 into 
the unit until it snaps into place.

NOTE All optical drives may not fit in the bottom optical bay due to interference with the system board. 
Check the fit of your drive before installing it into the bay.

7 Connect the drive, power, and audio cables.

NOTE The audio cable is included with Linux-based systems only. Windows-based systems do not 
require the audio cable. 

1

2

2

1

1

2
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Optical Drive (Desktop Position)
To remove an optional optical drive, you must first release the drivelock. To release the optical drive:

1 Disconnect power from the system (page 73), remove the access panel (page 77), and lay the 
workstation on its side with the system board facing up.

2 Disconnect the audio 1, drive 2, and power 3 cables from the drive.

NOTE The audio cable is included with Linux-based systems only. Windows-based systems do not 
require the audio cable. 

3 After removing the front bezel and bezel blanks, press down on the yellow drivelock. As you press on 
the yellow drivelock 1, gently slide the drive 2 out of the chassis.

3
2

1

2

1
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4 After pulling the drive 1 out, remove the four guide screws 2 from the drive.

5 Verify the jumper settings on the new drive are set correctly.

6 To install a drive, insert the four guide screws 1 into the drive. Align the screws with the slots on the 
drive, and slide the drive 2 into the unit until it snaps into place.

7 Connect the drive, power, and audio cables.

NOTE The audio cable is included with Linux-based systems only. Windows-based systems do not 
require the audio cable. 

1

2

2

1

1
2
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Diskette Drive (Optional)
To remove an optional diskette drive:

1 Disconnect power from the system (page 73), remove the access panel (page 77), and remove the 
front bezel (page 80).

2 Disconnect the cables from the back of the diskette drive.

3 After removing the front bezel and bezel blanks, lift the green drivelock release tab 1 and slide the 
drive 2 out at the same time.

To replace an optional diskette drive, reverse the previous steps. Align the screws with the slots on the 
drive, and slide the drive into the unit until it snaps into place.

1

2
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Hard Drive
This section describes how to install SCSI and SATA hard drives.

“SCSI” on page 107

“SATA” on page 109

SCSI

For more information on SCSI hard drives, see “SCSI Devices” on page 153.

Before installing a SCSI hard drive on your workstation, you must give the hard drive a unique SCSI ID.

All SCSI controllers require a unique SCSI ID (0–15) for each SCSI device installed. The controller 
identifies a SCSI device by its SCSI ID number rather than its location. Moving a SCSI device from one 
position to another on the SCSI chain does not affect communication between the controller and the 
device. The reserved and available SCSI ID numbers for SCSI devices are as follows:

0 is reserved for the primary hard drive (not reserved for the primary hard drive on Linux).

7 is reserved for the SCSI controller.

1 through 6 and 8 through 15 are available for all other SCSI devices.

Once you have given the hard drive a unique SCSI ID, you can install the hard drive into your 
workstation.

To remove a SCSI hard drive:

1 Disconnect power from the system (page 73), remove the access panel (page 77), and lay the 
workstation on its side with the system board facing up.

2 Disconnect the cables from the back of the hard drive.

3 Lift up on the green drivelock release tab 1 and slide the hard drive 2 out of the chassis at the same 
time.

1

2
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To install a hard drive, reverse the previous steps, but verify that the jumper settings are set as shown in 
the following illustration.
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SATA

For more information on SATA hard drives and the SATA RAID configuration, see “SATA Devices” on 
page 157.

To remove a SATA hard drive:

1 Disconnect power from the system (page 73), remove the access panel (page 77), and lay the 
workstation on its side with the system board facing up.

2 Remove the cables as shown in the following illustration.

3 Pull the release latch 1 and remove the SATA drive 2 as shown in the following illustration.

1

2
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4 Install the SATA drive as shown in the following illustration.
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5 Connect the cables as shown in the following illustrations.

6 Close up the unit by reversing the procedures listed in step 1.
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Installing Hard Drives in the 5.5” slot (Optional)

1 Place the hard drive in the bracket and secure with American National screws (page 70) as shown in 
the following illustration.

2 Remove the front bezel (page 80), then slide the bracket into the slot, and secure the drive to the 
chassis by tightening the four screws as shown in the following illustration.
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3 Connect the cables as shown in the following illustration (SATA style drive shown).
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System Board
To remove the system board:

1 Disconnect power from the system (page 73), remove the access panel (page 77), lay the 
workstation on its side with the system board facing up, remove all expansion boards and graphics 
cards (page 97), and remove the processor heatsink (page 88).

2 Disconnect all cabling from the system board to disengage the plastic mounting standoffs from the 
chassis.

NOTE Make note of the cable connections before disconnecting them from the system board.

3 Press the release tab 1 as shown in the following illustration.

4 Slide the board 2 toward the front of the chassis and then lift it out of the unit.

To replace the system board:

1 Lay the system board back in the chassis slightly away from the rear of the chassis. The mounting 
hooks should fall into the recesses of the tray so the tray lays flat on the chassis base.

2 Slide the tray towards the rear of the chassis until the heat sink mounting holes line up.

3 Re-install the heatsink, cards, and cables.

1

2
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Chapter 5 System Diagnostics and 
Troubleshooting

This chapter discusses the tools available for diagnosing and troubleshooting system issues. This 
chapter includes the following sections:

“Help & Support Center (HSC) and E-Support” on page 116

“Troubleshooting Checklist” on page 116

“LED Color Definitions” on page 117

“HP Insight Diagnostics Offline Edition” on page 117

“Troubleshooting Using HP Intelligent Manageability Features” on page 122

“Diagnostic Error Codes” on page 123

“Troubleshooting Scenarios and Solutions” on page 125

“POST and Error Messages” on page 148
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Help & Support Center (HSC) and E-Support
HSC provides online access to technical support information, software updates and downloads, 
diagnostic tools, and HP support contact information.

To open HSC from your desktop, click Start>Help and Support.

HSC contains four sections:

HP Product Information (requires Internet access)—Links to the HP Technical Support Web site for 
your product. You can access all related documentation, downloads and updates, tools, and more.

HP Software & Driver Downloads (requires Internet access)—Links to HP-specific software 
downloads and updates.

HP Support Tools (requires Internet access)—Links to self-help tools and diagnostics offered by HP 
Instant Support Professional Edition.

Contact HP for Support (option available that does not require Internet access)—Provides two 
different options:

Chat with an expert online (requires Internet access)—Provides a tool to communicate with a 
support specialist online through Active Chat.

Call a support agent—Provides hardware details about the workstation and HP support contact 
phone number worldwide.

Troubleshooting Checklist
Before running any of the diagnostic utilities, review the following checklist to find possible solutions for 
workstation or software problems:

Are the workstation and monitor connected to a working electrical outlet?

Is the workstation turned on?

Is the green power light illuminated?

Is the monitor turned on?

Is the green monitor light illuminated?

Turn up the monitor brightness and contrast controls if the monitor is dim.

Press and hold any key. If the system beeps, then the keyboard is operating correctly.

Check all cables for loose or incorrect connections.

Reconfigure the workstation after installing a non-Plug ‘n Play expansion board or other option, such 
as a diskette drive.

Are all of the necessary device drivers installed?

Have all printer drivers been installed for each application?

Remove all diskettes and CDs from the drives before you turn on the system.

Are all switches set correctly?

Are you running the latest BIOS version, drivers, and/or software updates?
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LED Color Definitions
An LED light exists on the front panel of your workstation. The following table describes what each color 
signifies.

HP Insight Diagnostics Offline Edition
The diagnostics utility enables you to perform testing and to view critical computer hardware and 
software configuration information from various sources. This utility allows you to:

Run diagnostics.

View the hardware configuration of the system.

Key Features and Benefits
HP Insight Diagnostics simplifies the process of effectively identifying, diagnosing, and isolating the 
hardware issues.

In addition to robust management tools, service tools can be invaluable in quickly resolving system 
problems. To streamline the service process and resolve problems quickly, it is necessary to have the 
right information available at the time that a service call is placed. The primary information requirement, 
which is also the one that provides the greatest insight into potential system issues, is the configuration 
of the system. Insight Diagnostics helps provide higher system availability. Typical uses of the Insight 
Diagnostics are:

Testing and diagnosing apparent hardware failures

Documenting system configurations for upgrade planning, standardization, inventory tracking, 
disaster recovery, and maintenance

Sending configuration information to another location for more in-depth analysis

Theory of Operation
Insight Diagnostics Offline Edition operates in offline mode only. The operating system is not running and 
software information from the system is not available to the diagnostics.

Offline Survey is available to display the current system configuration.

The Insight Diagnostics Test feature provides the capability to test functionality of all the major 
hardware components in the system. The Test feature is designed to be flexible to allow the user to 
customize test selections by providing different modes and types of testing.

A Quick Test provides a predetermined script where a sample of each hardware component is 
exercised and requires no user intervention.

Table 5-1 LED color definitions

LED State LED Color System Status

Solid Green System is on.

Blinking Green System is in Standby.

Solid or Blinking Red System has error. See “Diagnostic Error Codes” on page 123

None No Light System is in Hibernate or it is off.
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A Complete Test provides a predetermined script where each hardware component is fully tested. You 
can select Interactive or Unattended tests. This will change the devices tested during the Complete Test. 
There are more tests available in the interactive mode, but these require user intervention.

A Custom Test provides the most flexibility in controlling the testing of a system. The Custom Test mode 
allows the user to specifically select which devices, tests, and test parameters are run. Users are 
provided the ability to select tests that do not require any user interaction through the Interactive and 
Unattended tests modes.

Diagnostic Utility on CD
HP Insight Diagnostics is available on the Documentation Library CD that was shipped with your 
workstation.

To start the diagnostic utility on the Documentation Library CD:

1 Turn on your workstation and press the F10 key during the initial boot process to enter the Computer 
Setup (F10) Utility (page 36).

2 Select your language from the list and press the Enter key. In the Computer Setup Utilities menu, 
there are five headings displayed: File, Storage, Security, Power, and Advanced.

3 Use the right arrow key to select Storage. Use the down arrow key to select Boot Order, then press 
Enter.

4 Select CD-ROM Drive and enable it as a bootable device by pressing the F5 key (if not already 
enabled, pressing F5 key again disables the device).

5 Set the CD-ROM Drive to the top of the boot order. To do this, select CD-ROM, press Enter, and use 
use the up arrow to move it to top of order.

6 To apply and save changes, press the F10 key, then select File>Save Changes and Exit.

7 Insert the Documentation Library CD into the workstation.

8 Restart your system and HP Insight Diagnostics launches automatically.

Download the ISO Image
The download the latest diagnostic utility.

1 Visit http://www.hp.com.

2 Click the Support & Drivers link.

3 Click the Download driver and software radio button.

4 Enter your product number (for example, xw4200) in the text box and press Enter.

5 Select your OS.

6 Click the Diagnostic link.

7 Locate HP Insight Diagnostics and click Download.
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User Interface

NAVIGATION

The Insight Diagnostics home page contains the following tabs: Survey, Test, Status, Log, and Help. 
These tabs separate the major functions of Insight Diagnostics.

SURVEY TAB

When the Survey tab is selected, the Survey menu displays and allows you to view important system 
configuration information. The Summary view limits the amount of data displayed, while the Advanced 
view shows all the data in the selected category. Regardless of whether you choose Advanced or 
Summary, the following categories of information are available on the Survey menu:

Overview—The Overview view gives you a listing of general information about the computer.

All—The All view gives a listing of all information about the computer.

Architecture—The Architecture view shows the type of bus the computer uses. In addition, if the bus 
is PCI, information about the PCI configuration is displayed.

Asset Control—The Asset Control view shows the serial number of the computer (system 
identification number).

Communication—The Communication view shows information about the computer parallel (LPT) 
and serial (COM) port settings, USB, and network controller information.

Graphics—The Graphics view shows information about the graphics subsystem of the computer. 
This includes information about the graphics card, mode, and ROM.

Input Devices—The Input Devices view shows information about the type of keyboard, mouse, and 
other input devices connected to the computer.

Internal Conditions—The Internal Conditions view shows information about the health of the 
computer. This includes fan, temperature, and power supply information.

Memory—The Memory view shows information about all memory in the computer. This includes 
memory on the board and any memory modules installed.

Miscellaneous—The Miscellaneous view shows information obtained from the computers 
configuration memory (CMOS), BIOS data area, Interrupt Vector table, and diagnostics component 
information.

Multimedia—The Multimedia view shows information about all multimedia devices in the 
workstation. This includes audio devices installed.

Resources—The Resources view shows the system device resource usage information. This 
includes information about I/O, memory, IRQ, slot, and bus usage.

Storage—The Storage view shows information about storage media connected to the computer. This 
list includes all fixed disks, diskette drives, and CD-ROM drives.

System—The System view shows product type, processor type and speed, and coprocessor 
information. Also shown in this display is information about all ROMs in the computer.
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TEST TAB

The Insight Diagnostics utility provides the capability to test all the major pieces of hardware in the 
system. You can select from several types of tests:

Quick Test—Provides a predetermined script where a sample of each hardware component is 
exercised and requires no user intervention.

Complete Test—Provides a predetermined script where each hardware component is fully tested. 
You can select Interactive or Unattended tests. This will change the devices tested during the 
Complete Test. There are more tests available in the interactive mode, but these require user 
intervention.

Custom Test—Provides the most flexibility in controlling the testing of a system. The Custom Test 
mode enables the user to specifically select which devices, tests, and test parameters are run. Users 
are provided the ability to select tests that do not require any user interaction through the Interactive 
and Unattended test modes.

To begin testing:

1 Select the Test tab.

2 Select the Type of Test to perform and then select the Test Mode, either Interactive or Unattended. 

3 Choose how you want the test to be executed, either Number of Loops or Total Test Time.

When choosing to run the test over a specified number of loops, enter the number of loops to 
perform. If you desire to have the diagnostic test for a specified time period, enter the amount of 
time in minutes.

NOTE Testing will automatically stop, if one test loop has been completed, when the elapsed test time 
has reached the specified time limit.

4 Click Begin Testing to start the test.

While tests are being performed, the user can monitor the progress by viewing the Status tab. Any 
errors that are detected are summarized in the Error Log. Click the Print button to print or save the 
report.

If the diagnostics utility detects an error during a test, the user can mouse-over the failed text in the 
Status tab to display additional information for the type of error and the error code.

To view all test failure information, select the Error Log. To view the status of all testing that has 
been performed, select the Log tab.
120 SYSTEM DIAGNOSTICS AND TROUBLESHOOTING



C
h
a
p
t
e
r
 
5

STATUS TAB

The Status tab displays the status of the selected tests. The type of test executed (for example, Quick, 
Complete, Custom) is displayed. The main progress bar displays the percent complete of the current 
set of tests. While testing is in progress a Cancel testing button, which will cancel the test job, is 
displayed.

After testing has completed the Cancel testing button is replaced with two buttons, Select New Tests 
and Retest. The Select New Tests button allows you to go back to the previous test selection page to 
select a new set of tests. The Retest button will retest the last set of tests executed. This enables you to 
re-run the set of tests without having to go back to the test selection page.

The Status page also shows:

The devices being tested.

The tests that are running.

The overall elapsed time.

The individual elapsed test times.

The condition status of each test.

LOG TAB

The Log tab consists of three views.

Test Log—Displays all tests that have been executed, number of times of execution, number of 
times the test failed, and the time it took to complete the test. The Clear Test Log button will clear the 
contents of the Test Log.

Error Log—Displays the tests that have failed during the diagnostic testing. Besides displaying the 
device and test this section might also include error details. The description section describes the 
error that the diagnostic test found. The Recommended Repair will give a recommended action that 
should be performed to resolve the failed hardware. The error count is the number of times the test 
has failed. The Clear Error Log button will clear the contents of the Error Log.

Test Components—Hardware and software tests can be performed on the following components:

Audio—Identifies all audio devices installed in a system, captures any associated configuration 
information, and provides the ability to verify proper operation of these devices.

CPU—Identifies all processors installed in a system, captures any associated configuration 
information, and provides the ability to verify proper operation of these devices.

Inspect—Captures general system configuration information.

Keyboard—Identifies the keyboard installed in a system and provides the ability to verify proper 
operation of this device.

Memory—Identifies all memory modules installed in a system, captures any associated 
configuration information, and provides the ability to verify proper operation of these modules.

Modem—Identifies all modem devices installed in a system, captures any associated 
configuration information, and provides the ability to verify the proper operation of these devices.

Mouse—Identifies the mouse installed in a system and provides the ability to verify proper 
operation of this device.
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Network—Identifies all network devices installed in a system, captures any associated 
configuration information, and provides the ability to verify proper operation of these devices. NIC 
testing is only performed if drivers are installed during discovery.

Parallel Port—Identifies all parallel devices installed in a system and captures any associated 
configuration information. If the parallel port is properly configured and the information is available 
to the operating system, the associated DMA, IRQ, and I/O ports are reported. This test 
component also provides the ability to verify proper operation of these devices.

PCI Bus—Identifies all PCI devices installed in a system and provides the ability to verify proper 
PCI I/O operation to the devices.

Serial Port—Identifies all serial devices installed in a system, captures any associated 
configuration information, and provides the ability to verify proper operation of these devices.

Storage—Identifies storage devices connected to a system through IDE, USB, SCSI or a Fibre 
Channel network. Supported devices include:

IDE hard disk drives

USB diskette drives

SCSI disk drives

SCSI tape drives

SCSI controllers

RAID controllers

Controllers can be connected to the host through PCI, I2C, or serial port. The component also 
captures any associated configuration information, and provides the ability to verify proper 
operation of these devices.

Stress—Provides a solution for stress testing hardware in a system.

USB—Identifies all USB devices installed in a system, captures any associated configuration 
information, and provides the ability to verify proper operation of these devices.

Graphics—Identifies all graphic devices installed in a system, captures any associated 
configuration information, such as the ASIC and monitor types, and provides the ability to verify 
proper operation of these devices.

A list of available tests for each test component and a list of error codes can be accessed through the 
Test Component and Error Codes menu selections on the Help tab menu bar.

Troubleshooting Using HP Intelligent Manageability 
Features

The Local Alert Pop-Up Dialog notifies you of an impending or actual hardware failure. If the workstation 
is connect to a network and the HP Insight Management Agents are installed and configured, a Simple 
Network Management Protocol (SNMP) trap (message) is sent to the specified SNMP-compliant 
management application.
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Diagnostic Error Codes
This section gives an overview of the diagnostic lights and error codes that are related to the HP 
Workstation xw4200.

Diagnostic Light Codes

Table 5-2 Diagnostic Light Codes

Chassis Indicator Lights

Power LED and Sound 
Activity

Diagnosis and Service Action

None System does not power on
Press power button. If HDD LED = GREEN, then:

1 Remove expansion cards one at a time until the 5V_Aux light on the system board 
illuminates.

2 Replace system board.

OR

1 Press power button. If HDD LED does not illuminate, then:

2 Verify workstation plugged into live AC outlet.

3 Verify power button harness connected to system board.

4 Verify that both power supply cables are properly connected to the system board.

5 Verify that the 5V_Aux light on the system board is illuminated. If on, replace the 
power button harness.

6 Disconnect the AC power cord. Disconnect all internal power supply cables. Plug 
in the AC power cord. On the rear panel of the workstation, look through the 
ventilation holes above the power cord connector for a green LED light.

If the green LED light is not visible or the power supply fan is not spinning, 
replace the power supply.

If the green LED light is visible and the power supply fan is spinning, the 
power supply is functional.

7 Replace system board.

Blinks RED 2 times, once per 
second, then 2 second pause, 
2 beeps

Thermal Shutdown:

1 Ensure the workstation air vents are not blocked and cooling fan is running.

2 Open hood, press power button, and see if processor fan spins. If not spinning, 
ensure fan cable is plugged into the system board. Ensure fan is fully/properly 
seated.

3 If fan is plugged in and seated but not spinning, then replace processor fan.

4 Reseat CPU heatsink and verify fan assembly properly attached.

Blinks RED 3 times, once per 
second, then 2-second pause, 
3 beeps

CPU not installed:

1 Install CPU.

2 Reseat CPU.
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Blinks RED 4 times, once per 
second, then 2 second pause, 
4 beeps

Power supply failure:

1 Open the access panel and ensure the 4-wire power supply cable is properly 
connected to the system board.

2 Locate faulty device by removing all devices and then reinstalling one at a time 
until workstation fails. Replace the device causing the failure. Continue adding 
devices to ensure all are functioning properly.

3 Replace the power supply.

4 Replace the system board.

Blinks RED 5 times, once per 
second, then 2 second pause, 
5 beeps

Pre-video memory error.

1 Reseat memory modules.

2 Replace memory modules one at a time to find the faulty module.

3 Replace third-party modules with HP memory.

4 Replace system board.

Blinks RED 6 times, once per 
second, then 2 second pause, 
6 beeps

Pre-video graphics card error.
For systems with integrated graphics, replace system board.
For systems with graphic cards, 

1 Reseat the graphics card. Power on the system.

2 Replace the graphics card.

3 Replace the system board. 

Blinks RED 7 times, once per 
second, then 2 second pause, 
7 beeps.

System board failure (ROM detected failure before video).
Replace system board.

Blinks RED 8 times, once per 
second, then 2 second pause, 
8 beeps

Invalid ROM based on bad checksum.

1 Reflash ROM.

2 Replace system board.

Blinks RED 9 times, once per 
second, then 2 second pause, 
9 beeps

System powers on but is unable to boot.

1 Replace the system board.

2 Replace the processor.

Table 5-2 Diagnostic Light Codes (Continued)

Chassis Indicator Lights (Continued)

Power LED and Sound 
Activity

Diagnosis and Service Action
124 SYSTEM DIAGNOSTICS AND TROUBLESHOOTING



C
h
a
p
t
e
r
 
5

Troubleshooting Scenarios and Solutions
This section presents an extensive overview of various troubleshooting scenarios and includes possible 
solutions for each. Before replacing the power supply, use the Built-In Self-Test (BIST) feature to learn if 
the power supply still works.

To test the power supply:

1 Disconnect all internal power supply cables.

2 On the rear panel of the workstation, look through the ventilation holes above the power cord 
connector for a green LED light. If the light is visible, the power supply is functional.

Solving Minor Problems

Table 5-3 Solving Minor Problems

Problem Cause Possible Solution

Workstation appears locked up 
and will not turn off when the 
power button is pressed.

Software control of the power 
switch is not functional.

1 Press and hold the power button for at least 
four seconds until the workstation turns off.

2 Disconnect electrical plug from outlet.

Workstation will not respond to 
USB keyboard or mouse.

Workstation is in standby mode. Press the power button to resume from standby 
mode.

NOTE: When attempting to resume from standby mode, do not hold down the power button for more than four 
seconds. Otherwise, the workstation will shut down and you will lose your data.

Workstation date and time 
display is incorrect.

Real-time clock (RTC) battery 
may need to be replaced. 

1 Reset the date and time under Control Panel. 

2 Replace the RTC battery.

Workstation appears to pause 
periodically.

Network driver is loaded and no 
network connection is 
established.

Establish a network connection, or use Computer 
Setup or Microsoft Windows Device Manager to 
disable the network controller.

Cursor will not move using the 
arrow keys on the keypad.

The Num Lock key might be on. Press the Num Lock key. The Num Lock key can 
be disabled (or enabled) in Computer Setup.

Cannot remove access panel. Solenoid hood lock, featured on 
some workstations, is locked.

1 Unlock the solenoid hood lock using 
Computer Setup.

2 Use the access panel FailSafe Key in case of 
forgotten password, power loss, or 
workstation malfunction.

Poor performance is 
experienced.

Processor is hot. 1 Ensure airflow to the workstation is not 
blocked.

2 Ensure the fans are connected and working 
properly (some fans only operate when 
needed).

3 Ensure the processor heatsink is installed 
properly.

Hard drive is full. Transfer data from the hard drive to create more 
space on the hard drive.
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Workstation powered off 
automatically and the Power 
LED flashes Red two times, 
once every second, followed 
by a two-second pause.

Processor thermal protection 
activated:
A fan might be blocked or not 
turning.
OR 
The heatsink is not properly 
attached to the processor.

1 Ensure workstation air vents are not blocked 
and the cooling fan is running.

2 Open hood, press power button, and see if the 
processor fan spins. If not spinning, be sure 
the fan’s cable is plugged onto the system 
board header. Ensure the fan is fully/properly 
seated or installed.

3 Replace the processor fan.

4 Reseat processor heatsink and verify that the 
fan assembly is properly attached.

System does not power on and 
the LEDs on the front of the 
workstation are not flashing.

System unable to power on. Press and hold the power button for less than 4 
seconds. If the hard drive LED turns green, then:

1 Remove the expansion cards one at a time 
until the 5V_aux light on the system board 
turns on.

2 Replace the system board.

OR

Press and hold the power button for less than 4 
seconds. If the hard drive LED does not turn on 
green then:

1 Check that the unit is plugged into a working 
AC outlet.

2 Open hood and check that the power button 
harness is properly connected to the system 
board.

3 Check that both power supply cables are 
properly connected to the system board.

4 If the 5V_aux light on the system board is on, 
then replace the power button harness.

5 If the 5V_aux light on the system board is off, 
perform the Built-In Self-Test on the power 
supply. Disconnect the AC power cord from 
the system. Disconnect all internal power 
supply cables. Plug in AC power.

If the green BIST LED on the rear of the 
workstation is lit AND the fan is spinning, 
the power supply is functional.

If the green BIST LED is not lit OR the fan is 
not spinning, replace the power supply.

6 Replace the system board.

Table 5-3 Solving Minor Problems (Continued)

Problem Cause Possible Solution
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Solving Power Supply Problems
Before replacing the power supply, use the Built-In Self-Test (BIST) feature to learn if the power supply 
still works.

To test the power supply:

1 Disconnect the AC power cord from the workstation.

2 Disconnect all internal power supply cables.

3 Plug in the AC power cord.

If the green BIST LED 1 on the rear of the workstation is lit AND the fan is spinning, the power 
supply is functional.

If the green BIST LED is not lit OR the fan is not spinning, replace the power supply.

Table 5-4 Solving Power Supply Problems

Problem Cause Solution

Power supply shuts down 
intermittently.

Power supply fault. Replace the power supply.

Workstation powered off 
automatically and the Power LED 
flashes Red two times, once every 
second, followed by a two-second 
pause.

Processor thermal protection 
activated:

A fan might be blocked or not 
turning.

OR 

The heatsink/fan assembly is 
not properly attached to the 
processor.

1 Ensure that the workstation air vents are not 
blocked and the cooling fan is running.

2 Open hood, press the power button, and see 
if the processor fan spins. If the processor 
fan is not spinning, make sure the fan’s 
cable is plugged onto the system board 
header. Ensure the fan is fully/properly 
seated or installed.

3 Replace the processor fan.

4 Reseat processor heatsink and verify that 
the fan assembly is properly attached.

1

TROUBLESHOOTING SCENARIOS AND SOLUTIONS 127



Power LED flashes Red, once 
every two seconds.

Power failure (power supply is 
overloaded).

1 Open the hood and ensure the 4-wire power 
supply cable is seated into the connector on 
the system board.

2 Check if a device is causing the problem by 
removing ALL attached devices). Power on 
the system. If the system enters the POST, 
then power off and replace one device at a 
time and repeat this procedure until failure 
occurs. Replace the device causing the 
failure. Continue adding devices one at a 
time to ensure all devices are functioning 
properly.

3 Perform BIST on power supply. If power 
supply fan does NOT spin or the green BIST 
LED does NOT light, replace the power 
supply.

4 Replace system board.

Table 5-4 Solving Power Supply Problems (Continued)

Problem Cause Solution
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Solving Diskette Problems

Table 5-5 Solving Diskette Problems

Problem Cause Solution

Diskette drive light stays on. Diskette is damaged. In Microsoft Windows 2000 and Microsoft 
Windows XP, right-click Start, click Explore, 
and select a drive. Select 
File>Properties>Tools. Under Error-checking, 
click Check Now.

Diskette is incorrectly inserted. Remove diskette and reinsert.

Drive button is not pushed in. Push in drive button.

Files on diskette are damaged. Check the program diskettes.

Drive cable is not properly 
connected.

Reconnect power cable. Ensure that all four 
pins are connected.

Drive not found. Cable is loose. Reseat diskette drive data and power cables.

Removable drive is not seated 
properly.

Reseat the drive.

Diskette drive cannot write to a 
diskette.

Diskette is not formatted. Format the diskette.

Diskette is write-protected. Use another diskette or remove the write 
protection.

Writing to the wrong drive. Check the drive letter in the path statement.

Not enough space is left on the 
diskette.

Use another diskette.

Diskette write control is 
enabled.

Use Computer Setup to check the storage 
security feature disabled settings.

Diskette is damaged. Replace the damaged disk.
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Cannot format diskette. Invalid media reported. When formatting a disk in MS-DOS, you might 
need to specify diskette capacity. For example, 
to format a 1.44-MB diskette, enter the 
following command at the MS-DOS prompt:
FORMAT A: /F:1440

A problem has occurred with a disk 
transaction.

The directory structure is bad, 
or there is a problem with a file.

In Windows 2000 and Windows XP, right-click 
Start, click Explore, and select a drive. Select 
File>Properties>Tools. Under Error-checking, 
click Check Now.

Diskette drive cannot read 
a diskette.

Diskette is not formatted. Format the diskette.

You are using the wrong 
diskette type for the drive type.

Check the type of drive that you are using and 
use the correct diskette type.

You are reading the wrong 
drive.

Check the drive letter in the path statement.

Diskette is damaged. Replace the diskette with a new one.

“Invalid system disk” message is 
displayed.

A diskette that does not contain 
the system files needed to start 
the workstation has been 
inserted in the drive.

When drive activity stops, remove the diskette 
and press the Spacebar. The workstation 
should start up.

Diskette error has occurred. Restart the workstation by pressing the power 
button.

Cannot boot to diskette. Diskette is not bootable. Replace with a bootable diskette.

Diskette boot has been 
disabled in Computer Setup.

Run Computer Setup and enable diskette boot 
in Storage>Boot Order.

Removable media boot has 
been disabled in Computer 
Setup.

Run Computer Setup and enable Removable 
Media Boot in Storage>Storage Options.

Diskette MBR validation is 
enabled.

Run Computer Setup and disable Diskette 
MBR Validation in Storage>Storage 
Options.

Table 5-5 Solving Diskette Problems (Continued)

Problem Cause Solution
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Solving Hard Drive Problems

Table 5-6 Solving Hard Drive Problems

Problem Cause Solution

Hard drive error occurs. Hard disk has bad sectors or 
has failed.

Use a utility to locate and block usage of bad 
sectors. If necessary, reformat the hard disk.

Disk transaction problem. Either the directory structure is 
bad or there is a problem with 
a file.

In Windows 2000 and Windows XP, right-click 
Start, click Explore, and select a drive. Select 
File>Properties>Tools. Under Error-checking, 
click Check Now.

Drive not found (identified). Loose cable. Check cable connections.

The system might not have 
automatically recognized a 
newly installed device.

1 Run Computer Setup.

2 If the system still does not recognize the new 
device, check to see if the device is listed 
within Computer Setup. If it is listed, 
the probable cause is a driver problem. If it is 
not listed, the probable cause is a hardware 
problem.

3 If this is a newly installed drive, enter Setup 
and try adding a POST delay under 
Advanced>Power-On.

Drive jumper settings might be 
incorrect.

If the drive is a secondary drive that has just 
been installed on the same cable as the primary 
drive, verify that the jumpers for both drives are 
set correctly.

Drive’s IDE (ATA) controller is 
disabled in Computer Setup.

Run Computer Setup and enable the IDE 
controller in Storage>Storage Options.

Drive responds slowly 
immediately after power-up.

Run Computer Setup and increase the POST 
Delay in Advanced>Power-On Options.

Nonsystem disk/NTLDR missing 
message.

System is trying to start from a 
non-bootable diskette.

Remove the diskette from the diskette drive.

System is trying to start from a 
damaged hard drive.

1 Insert a bootable diskette into the diskette 
drive and restart the workstation.

2 If the hard drive is still inaccessible and MBR 
Security is enabled, try restoring the 
previously saved MBR image by entering 
Setup and selecting Security>Restore 
Master Boot Record.

System files missing or not 
properly installed.

1 Insert a bootable system diskette and 
restart.

2 Verify hard drive is partitioned and 
formatted.

3 Install system files for the appropriate 
operating system if necessary.

Hard drive boot disabled in 
Computer Setup.

Run Computer Setup and enable the hard drive 
entry in the Storage>Boot Order list.

Second UATA hard drive does not 
perform optimally.

Using the wrong cable for the 
drive type.

Reinstall the second UATA hard drive using an 
80-conductor cable (standard on select models).
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Solving Display Problems

Workstation will not start. Hard drive is damaged. Observe the beeps and LED lights on the front of 
the workstation. See the “POST and Error 
Messages” on page 148.

Workstation seems to be locked 
up.

Program in use has stopped 
responding to commands.

1 Attempt the normal Windows “Shut Down” 
procedure.

2 Press the power button for four or more 
seconds to turn off the power.

3 Restart the workstation using the power 
button.

Table 5-7 Solving Display Problems

Problem Cause Solution

Blank screen (no video). The cable connections are not 
correct.

Check the cable connections from the monitor to 
the workstation and to the electrical outlet.

Screen blanking utility installed 
or energy saver features 
enabled.

Press any key or click the mouse button and, if 
set, enter your password.

System ROM is bad; system is 
running in FailSafe Boot Block 
mode (indicated by eight 
beeps).

Reflash the ROM using a ROMPaq diskette.

Fixed-sync monitor will not 
sync at the resolution chosen.

Ensure that the monitor can accept the same 
horizontal scan rate as the resolution chosen.

Computer is in standby mode. Press the power button to resume from standby 
mode.

CAUTION: When attempting to resume from standby mode, do not hold down the power button for more than four 
seconds. Otherwise, the workstation will shut down and you will lose your data.

Monitor cable plugged into the 
wrong connector.

If the workstation system has both an integrated 
graphics connector and an PCI expansion card 
connector, plug the monitor cable into the PCI 
expansion card connector.

Monitor settings in the 
workstation are not compatible 
with the monitor.

1 Restart the workstation and press F8 during 
startup when you see “Press F8” in the 
bottom right corner of the screen.

2 Using the keyboard arrow keys, select 
Enable VGA Mode and press Enter.

3 In Windows Control Panel, double-click the 
Display icon and select the Settings tab.

4 Use the sliding control to reset the 
resolution.

Table 5-6 Solving Hard Drive Problems (Continued)

Problem Cause Solution
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Power LED flashes Red six times, 
once every second, followed by a 
two-second pause, and the 
workstation beeps six times.

Pre-video graphics error. For systems with a graphics card:

1 Reseat the graphics card.

2 Replace the graphics card.

3 Replace the system board.

4 For systems with integrated graphics, 
replace the system board.

Monitor does not function properly 
when used with energy saver 
features.

Monitor without energy saver 
capabilities is being used with 
energy saver features enabled.

Disable monitor energy saver feature.

Dim characters. The brightness and contrast 
controls are not set properly.

Adjust the monitor brightness and contrast 
controls.

Cables are not properly 
connected.

Check that the graphics cable is securely 
connected to the graphics card and the monitor.

Blurry video or requested 
resolution cannot be set.

If the graphics controller was 
upgraded, the correct video 
drivers might not be loaded.

Install the video drivers included in the upgrade 
kit.

Monitor is not capable of 
displaying requested 
resolution.

Change requested resolution.

The picture is broken up, rolls, 
jitters, or flashes.

The monitor connections might 
be incomplete or the monitor 
might be incorrectly adjusted.

1 Be sure the monitor cable is securely 
connected to the workstation.

2 In a two-monitor system or if another monitor 
is in close proximity, be sure the monitors 
are not interfering with each other’s 
electromagnetic field by moving them apart.

3 Fluorescent lights or fans might be too close 
to the monitor.

Monitor must be degaussed. Degauss the monitor. 

Vibrating or rattling noise coming 
from inside a CRT monitor when 
powered on.

Monitor degaussing coil has 
been activated.

None. It is normal for the degaussing coil to be 
activated when the monitor is powered on.

Clicking noise coming from inside a 
CRT monitor.

Electronic relays have been 
activated inside the monitor.

None. It is normal for some monitors to make a 
clicking noise when turned on and off, when 
going in and out of standby mode, and when 
changing resolutions.

High pitched noise coming from 
inside a flat panel monitor.

Brightness and/or contrast 
settings are too high.

Lower brightness and/or contrast settings.

Fuzzy focus; streaking, ghosting, 
or shadowing effects; horizontal 
scrolling lines; faint vertical bars; or 
unable to center the picture on the 
screen. (Flat panel monitors using 
an analog VGA input connection 
only.)

Flat panel monitor’s internal 
digital conversion circuits 
might be unable to correctly 
interpret the output 
synchronization of the graphics 
card.

1 Select the monitor’s Auto-Adjustment option 
in the monitor’s on-screen display menu.

2 Manually synchronize the Clock and Clock 
Phase on-screen display functions. 
Download SoftPaq SP20930 or SP22333, 
depending on the monitor, to assist with the 
synchronization.

Table 5-7 Solving Display Problems (Continued)

Problem Cause Solution
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Certain typed symbols do not 
appear correct.

The font you are using does 
not support that particular 
symbol.

Use the Character Map to locate the and select 
the appropriate symbol. Click Start>All 
Programs>Accessories>System 
Tools>Character Map. You can copy the 
symbol from the Character Map into a document.

Table 5-7 Solving Display Problems (Continued)

Problem Cause Solution
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Solving Audio Problems

Table 5-8 Solving Audio Problems

Problem Cause Solution

Sound does not come out of the 
speaker or headphones.

Software volume control is 
turned down.

Double-click the Speaker icon on the taskbar and 
use the volume slider to adjust the volume.

The external speakers are not 
turned on.

Turn on the external speakers.

External speakers plugged into 
the wrong audio jack.

Refer to the sound card documentation for 
proper speaker connection.

Audio cable not connected. Connect audio cable between CD or DVD-ROM 
drive and the system board.

Digital CD audio is 
not enabled.

Enable digital CD audio:

1 From the Control Panel, select System.

2 On the Hardware tab, click the Device 
Manager button.

3 Right-click on the CD/DVD device and select 
Properties.

4 On the Properties tab, be sure “Enable 
digital CD audio for this CD-ROM device” is 
checked.

Headphones or devices 
connected to the line-out 
connector mute the internal 
speaker.

Turn on and use headphones or external 
speakers, if connected, or disconnect 
headphones or external speakers.

Volume is muted. 1 From the Control Panel program, click 
Sound, Speech and Audio Devices, then 
click Sounds and Audio Devices.

2 Click the Mute checkbox to remove the 
check mark from the box.

Computer is in standby mode. Press the power button to resume from standby 
mode.

CAUTION: When attempting to resume from standby mode, do not hold down the power button for more than four 
seconds. Otherwise, the workstation will shut down and you will lose your data.

Noise or no sound comes out of 
the speakers or headphones.

1 If using digital speakers that have a stereo 
jack and want the system to auto-switch to 
digital, use a stereo-to-mono adapter 
to properly engage the auto-sense feature 
or use the multimedia device properties 
to manually switch the audio signal from 
analog to digital.

2 If the headphones have a mono jack, use 
the multimedia device properties to switch 
the system to analog out.

NOTE: If you set digital as the Output Mode, the internal speaker and external analog speakers will no longer output 
audio until you switch back to an auto-sense or analog mode.

If you set analog as the Output Mode, external digital speakers will not function until you change the output mode back 
to an auto-sense or digital mode.
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Solving Printer Problems

Sound cuts in and out. Processor resources are being 
used by other open 
applications.

Shut down all open processor-intensive 
applications.

Workstation appears to be locked 
up while recording audio.

The hard disk may be full. 1 Before recording, be sure there is enough 
free space on the hard disk.

2 Try recording the audio file in a compressed 
format.

Table 5-9 Solving Printer Problems

Problem Cause Solution

Printer will not print. Printer is not turned on and 
online.

Turn the printer on and be sure it is online.

The correct printer driver for 
the application are not 
installed.

1 Install the correct printer driver for the 
application.

2 Try printing using the MS-DOS command:
DIR C:\>[printer port]
where [printer port] is the address of the 
printer being used. If the printer works, 
reload the printer driver.

If you are on a network, you 
might not have made the 
connection to the printer.

Make the proper network connections to the 
printer.

Printer might have failed. Run printer self-test.

Printer will not turn on. The cables might not be 
connected properly.

Reconnect all cables.

Printer prints garbled information. The correct printer driver is not 
installed.

Install the correct printer driver for the 
application.

The cables might not be 
connected properly.

Reconnect all cables.

Printer memory might be 
overloaded.

Reset the printer by turning it off for one minute, 
then turn it back on.

Printer is offline. The printer might be out of 
paper.

1 Check the paper tray and refill it if it is empty. 

2 Select online.

Table 5-8 Solving Audio Problems (Continued)

Problem Cause Solution
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Solving Keyboard and Mouse Problems

Table 5-10 Solving Keyboard Problems

Problem Cause Solution

Keyboard commands and typing 
are not recognized by the 
workstation.

Keyboard connector is not 
properly connected.

1 Turn off the workstation.

2 Reconnect the keyboard to the back of the 
workstation and restart the workstation.

Program in use has stopped 
responding to commands.

Shut down the workstation using the mouse and 
then restart the workstation.

Keyboard needs repairs. Replace the keyboard.

Workstation is in standby 
mode.

Press the power button to resume from standby 
mode.

NOTE: Some mouse software applications might 
interfere with the functionality of the keyboard 
and mouse if the keyboard and mouse are 
connected to your workstation through a 
keyboard, video, mouse (KVM) switch. If you are 
experiencing “no-response” from your keyboard 
and mouse, you might need to uninstall the 
mouse software or connect the keyboard and 
mouse directly to the keyboard and mouse 
connectors on the workstation.

CAUTION: When attempting to resume from standby mode, do not hold down the power button for more than four 
seconds. Otherwise, the workstation will shut down and you will lose your data.

Cursor will not move using the 
arrow keys on the keypad.

The Num Lock key might be 
on.

Press the Num Lock key. The Num Lock light 
should not be on if you want to use the arrow 
keys. The Num Lock key can be disabled 
(or enabled) in Computer Setup.

Mouse does not respond to 
movement or is too slow.

Mouse connector is 
not properly plugged into the 
back of the workstation.

1 Shut down the workstation using the 
keyboard.

2 Plug the mouse connector into the back of 
the workstation (or the keyboard) and restart 
the workstation.

Program in use has stopped 
responding to commands.

Shut down the workstation using the keyboard 
and then restart the workstation.

Mouse needs repairs. Replace the mouse.

Workstation is in standby 
mode.

Press the power button to resume from standby 
mode.

CAUTION: When attempting to resume from standby mode, do not hold down the power button for more than four 
seconds. Otherwise, the workstation will shut down and you will lose your data.

Mouse will only move vertically or 
horizontally, or movement is jerky.

Mouse roller ball is dirty. Remove roller ball cover from the bottom of the 
mouse and clean it.
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Solving Front Panel Component Problems
If you are experiencing problems with one of the front panel ports, you might be able to try your device in 
the corresponding port on the back side of the computer. If this does not fix the problem, or you must use 
the front panel ports, continue troubleshooting.

Some problems in this section are also discussed in other troubleshooting suggestions in this chapter.

Table 5-11 Solving Front Panel Component Problems

Problem Cause Solution

If a USB device, headphone, or 
microphone is not recognized by 
the workstation.

It is not properly connected. 1 Turn off the workstation.

2 Reconnect the device to the front of the 
workstation and restart the workstation.

The device does not have 
power.

If the USB device requires AC power, be sure 
one end is connected to the device and one end 
is connected to a live outlet.

The correct device driver is not 
installed.

1 Install the correct driver for the device.

2 You might need to reboot the workstation.

The cable from the device to 
the computer does not work.

1 If possible, replace the cable.

2 Restart the workstation.

The device is not working. 1 Replace the device.

2 Restart the workstation.

A device in the IEEE-1394 port is 
not responsive.

Cable(s) of new external 
device are loose or power 
cables are unplugged.

Ensure that all cables are properly and securely 
connected.

The power switch on the 
device is not turned on. 

Turn off the workstation, turn on the external 
device, then turn on the workstation to integrate 
the device with the workstation system.

The IEEE-1394 port is not active. The port is not there because it 
was not purchased with the 
system. 

You can buy an IEEE1394 connection. Contact 
an HP seller. 

The IEEE-1394 cable might 
not be connected to the IEEE-
1394 card.

1 Turn off the workstation.

2 Remove the access panel. See “Access 
Panel” on page 77 for more information.

3 Be sure to connect the front IEEE-1394 pre-
installed cable to the IEEE-1394 card. See 
“IEEE-1394 (Optional)” on page 82.
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Solving Hardware Installation Problems
You might need to reconfigure the workstation when you add or remove hardware, such as an additional 
diskette drive. If you install a Plug ‘n Play device, Windows 2000 and Windows XP automatically 
recognize the device and configure the workstation. If you install a non-Plug ‘n Play device, you must 
reconfigure the workstation after completing installation of the new hardware. In Windows 2000, select 
the Add New Hardware icon in the Control Panel (for Windows XP, use the Add Hardware Wizard) and 
follow the instructions that appear on the screen.

Table 5-12 Solving Hardware Installation Problems

Problem Cause Solution

A new device is not recognized as 
part of the system.

Device is not seated or 
connected properly.

Ensure that the device is properly and securely 
connected and that pins in the connector are not 
bent down.

Cables of new external device 
are loose or power cables are 
unplugged.

Ensure that all cables are properly and securely 
connected and that pins in the cable or 
connector are not bent down.

Power switch of new external 
device is not turned on.

Turn off the workstation, turn on the external 
device, then turn on the workstation to integrate 
the device with the workstation system.

When the system advised you 
of changes to the 
configuration, you did not 
accept them.

Reboot the workstation and follow the 
instructions for accepting the changes.

A Plug ‘n Play board might not 
automatically configure when 
added if the default 
configuration conflicts with 
other devices.

Use Windows 2000 or Windows XP Device 
Manager to deselect the automatic settings for 
the board and choose a basic configuration that 
does not cause a resource conflict. You can also 
use Computer Setup to reconfigure or disable 
devices to resolve the resource conflict.

Workstation will not start. Wrong memory modules were 
used in the upgrade or 
memory modules were 
installed in the wrong location.

1 Review the documentation that came with 
the system to determine if you are using the 
correct memory modules and to verify the 
proper installation.

2 Observe the beeps and LED lights on the 
front of the workstation. See the “POST and 
Error Messages” on page 148 to determine 
possible causes.

Power LED flashes Red five times, 
once every second, followed by a 
two-second pause, and the 
workstation beeps five times.

Memory is installed incorrectly 
or is bad.

1 Reseat DIMMs.

2 Replace DIMMs one at a time to isolate the 
faulty module.

3 Replace third-party memory with HP 
memory.

4 Replace the system board.
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Power LED flashes Red six times, 
once every second, followed by a 
two-second pause, and the 
workstation beeps six times.

Video card is not seated 
properly or is bad, or system 
board is bad.

For systems with a graphics card:

1 Reseat the graphics card. Power on the 
system.

2 Replace the graphics card.

3 Replace the system board.

4 For systems with integrated graphics, 
replace the system board.

Table 5-12 Solving Hardware Installation Problems (Continued)

Problem Cause Solution
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Solving Network Problems
These guidelines do not discuss the process of debugging the network cabling.

Table 5-13 Solving Network Problems

Problem Cause Solution

Wake-on-LAN feature is not 
functioning.

Wake-on-LAN is not enabled. Use the Network control application to enable 
Wake-on-LAN.

Network driver does not detect 
network controller.

Network controller is disabled. Run Computer Setup and enable network 
controller.

Incorrect network driver. Check the network controller documentation for 
the correct driver or obtain the latest driver from 
the manufacturer’s Web site.

Network status link light does not 
turn on or it never flashes.
NOTE: The network status light 
should flash when there is 
network activity.

No active network is detected. Check cabling and network equipment for 
proper connection.

Network controller is not set up 
properly.

Use the Network control application to verify 
that the device is working properly.

Network driver is not properly 
loaded.

Reinstall network drivers.

System cannot autosense the 
network.

Disable auto-sensing capabilities and force the 
system into the correct operating mode.

Diagnostics reports a failure. The cable is not securely 
connected.

Ensure that both ends of the data cable are 
securely connected. 

The cable is attached to the 
incorrect connector.

Ensure that the cable is attached to the correct 
connector.

There is a problem with the cable 
or a device at the other end of the 
cable.

Ensure that the cable and device at the other 
end are operating correctly.

Network controller interrupt is 
shared with an expansion board.

Under the Computer Setup Advanced menu, 
change the resource settings for the board.

The network controller 
is defective.

Replace the NIC.

Diagnostics passes, but the 
workstation does not 
communicate with the network.

Network drivers are not loaded, or 
driver parameters do not match 
current configuration.

1 Be sure the network drivers are loaded and 
that the driver parameters match the 
configuration of the network controller.

2 Be sure the correct network client and 
protocol is installed.

The network controller is not 
configured for this workstation.

Select the Network icon in the Control Panel 
and configure the network controller.
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Network controller stopped 
working when an expansion 
board was added to the 
workstation.

Network controller interrupt is 
shared with an expansion board.

Under the Computer Setup Advanced menu, 
change the resource settings for the board.

The network controller requires 
drivers.

Verify that the drivers were not accidentally 
deleted when the drivers for a new expansion 
board were installed.

The expansion board installed is a 
network card (NIC) and conflicts 
with the embedded NIC.

Under the Computer Setup Advanced menu, 
change the resource settings for the board.

Network controller stops working 
without apparent cause.

The files containing the network 
drivers are corrupted.

Reinstall the network drivers, using the Restore 
Plus! CD.

The cable is not securely 
connected.

Ensure that both ends of the cable are securely 
attached to the correct devices.

The network controller is 
defective.

Replace the NIC.

New network card will not boot. New network card might be 
defective or might not meet 
industry-standard specifications.

Install a working, industry-standard NIC, or 
change the boot sequence to boot from another 
source.

Cannot connect to network 
server when attempting Remote 
System Installation.

The network controller is not 
configured properly.

Verify Network Connectivity, that a DHCP 
Server is present, and that the Remote System 
Installation Server contains the NIC drivers for 
your NIC.

System setup utility reports 
unprogrammed EEPROM.

Unprogrammed EEPROM. Flash the ROM.

Table 5-13 Solving Network Problems (Continued)

Problem Cause Solution
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Solving Memory Problems

CAUTION For those systems that support ECC memory, HP does not support mixing ECC and non-
ECC memory. Otherwise, the system will not boot the operating system.

Table 5-14 Solving Memory Problems

Problem Cause Solution

System will not boot or does not 
function properly after installing 
additional memory modules.

Memory module is not the 
correct type or speed or the 
new memory module is not 
seated properly.

Replace module with the correct industry-
standard device for the workstation.

On some models, ECC and non-ECC memory 
modules cannot be mixed.

Out of memory error. Memory configuration might 
not be set up correctly.

Use the Device Manager to check memory 
configuration.

You have run out of memory to 
run the application.

Check the application documentation to 
determine the memory requirements.

Memory count during POST is 
wrong.

The memory modules might 
not be installed correctly.

Check that the memory modules have been 
installed correctly and that proper modules are 
used.

Insufficient memory error during 
operation.

Too many Terminate and Stay 
Resident programs (TSRs) are 
installed.

Delete any TSRs that you do not need.

You have run out of memory 
for the application.

Check the memory requirements for the 
application or add more memory to the 
workstation.

Power LED flashes Red five times, 
once every second, followed by a 
two-second pause, and the 
workstation beeps five times.

Memory is installed incorrectly 
or is bad.

1 Reseat DIMMs.

2 Replace DIMMs one at a time to isolate the 
faulty module.

3 Replace third-party memory with HP 
memory.

4 Replace the system board.
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Solving Processor Problems
.

Solving CD-ROM and DVD Problems

Table 5-15 Solving Processor Problems

Problem Cause Solution

Poor performance is experienced. Processor is hot. 1 Be sure the airflow to the workstation is not 
blocked.

2 Be sure the fans are connected and working 
properly (some fans only operate when 
needed).

3 Be sure the processor heatsink is installed 
properly.

Power LED is Red and stays on. Processor is not seated 
properly or not installed.

1 Check to see that the processor is present.

2 Reseat the processor.

Table 5-16 Solving CD-ROM and DVD Problems

Problem Cause Solution

System will not boot from CD-ROM 
or DVD drive.

The CD-ROM or DVD boot is 
not enabled through the 
Computer Setup utility.

Run the Computer Setup utility and enable 
booting to removable media and verify boot 
order settings.

Non-bootable CD in drive. Try a bootable CD in the drive.

CD-ROM or DVD devices are not 
detected or driver is not loaded.

Drive is not connected properly 
or not properly configured.

1 Reconnect power and data cables to the 
drive.

2 Install correct device driver.

Movie will not play in the DVD 
drive.

Movie might be regionalized 
for a different country.

Refer to the documentation that came with the 
DVD drive.

Decoder software is not 
installed.

Install decoder software.

Cannot eject compact disc (tray-
load unit).

Disc not properly seated in the 
drive.

1 Turn off the workstation and insert a thin 
metal rod into the emergency eject hole and 
push firmly.

2 Slowly pull the tray out from the drive until 
the tray is fully extended, then remove 
the disc.
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CD-ROM, CD-RW, DVD-ROM, or 
DVD-R/RW drive cannot read a 
disc or takes too long to start.

CD has been inserted upside 
down.

Re-insert the CD with the label facing up.

The DVD-ROM drive takes 
longer to start because it has 
to determine the type of media 
played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM 
drive determine the type of media being played. 
If the disc still does not start, read the other 
solutions listed for this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD cleaning kit.

Windows does not detect the 
CD-ROM or DVD-ROM drive.

1 Use Device Manager to remove or uninstall 
the device in question.

2 Restart the workstation and let Windows 
detect the device.

Recording audio CDs is difficult or 
impossible.

Wrong or poor quality media 
type.

1 Try using a slower recording speed.

2 Verify that you are using the correct media 
for the drive.

3 Try a different brand of media. Quality varies 
widely between manufacturers.

Table 5-16 Solving CD-ROM and DVD Problems (Continued)

Problem Cause Solution
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Solving Internet Access Problems

Table 5-17 Solving Internet Access Problems

Problem Cause Solution

Unable to connect to the Internet. Internet Service Provider (ISP) 
account is not set up properly.

Verify Internet settings or contact the ISP for 
assistance.

Modem is not set up properly. Reconnect the modem. Verify the connections 
are correct using the quick setup documentation.

Web browser is not set up 
properly.

Verify that the Web browser is installed and set 
up to work with your ISP.

Cable/DSL modem is not 
plugged in.

Plug in cable/DSL modem. You should see a 
“power” LED light on the front of the cable/DSL 
modem.

Cable/DSL service is not 
available or has been 
interrupted due to bad 
weather.

Try connecting to the Internet at a later time or 
contact your ISP. (If the cable/DSL service is 
connected, the “cable” LED light on the front of 
the cable/DSL modem will be on.)

The LAN cable is not 
connected.

Connect the CAT5 10/100/1000 cable between 
the cable modem and the workstations’s RJ-45 
connector. (If the connection is good, the “PC” 
LED light on the front of the cable/DSL modem 
will be on.)

IP address is not configured 
properly.

Contact the ISP for the correct IP address.

Cookies are corrupted. Windows 2000:

1 Select Start>Settings>Control Panel.

2 Double-click Internet Options.

3 On the General tab, click the Delete Cookies 
button.

Windows XP: 

1 Select Start>Control Panel.

2 Double-click Internet Options.

3 On the General tab, click the Delete Cookies 
button.

Cannot automatically launch 
Internet programs.

You must log on to the ISP 
before some programs will 
start.

Log on to the ISP and launch the desired 
program.
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Internet takes too long to download 
Web sites.

Modem is not set up properly. Verify that the correct modem speed and COM 
port are selected.
For Windows 2000:

1 Select Start>Settings>Control Panel. 
Continue with step #2.

For Windows XP:

1 Select Start>Control Panel. Continue with 
step #2.

2 Double-click System.

3 Click the Hardware tab.

4 In the Device Manager area, click the Device 
Manager button.

5 Double-click Ports (COM and LPT).

6 Right-click the COM port your modem uses, 
then click Properties.

7 Under Device status, verify that the modem 
is working properly.

8 Under Device usage, verify the modem is 
enabled.

9 If there are further problems, click the 
Troubleshoot button and follow the on-
screen instructions.

Table 5-17 Solving Internet Access Problems (Continued)

Problem Cause Solution
TROUBLESHOOTING SCENARIOS AND SOLUTIONS 147



POST and Error Messages
POST is a series of diagnostic tests that runs automatically when the system is turned on. An audible 
and visual message occurs if the POST encounters a problem. POST checks the following items to 
ensure that the workstation system is functioning properly:

Keyboard

Memory modules

Diskette drives

All SATA, IDE and SCSI mass storage devices 

Processors

Controllers

NOTE If the Power-On Password is set, a key icon appears on the screen while POST is running. You 
must enter the password before continuing.

Table 5-18 POST Error Messages

Screen Message Probable Cause Recommended Action

101–Option ROM Error System ROM checksum. Verify the correct ROM.

1 Flash the ROM, if needed.

2 If an expansion card was recently added, remove it 
and see if the problem remains. 

3 Clear CMOS.

4 If the message disappears, there might be a problem 
with the expansion card.

5 Replace the system board.

102–System Board Failure DMA, timers, and so on. 1 Remove expansion boards.

2 Replace the system board.

110–Out of Memory for Option 
ROMs

Option ROM for a device was unable 
to run due to memory constraints.

Run Computer Setup and enable the ACPO/USB Buffers 
at Top of Memory under the Advanced>Power-On 
option.

162–System Options Not Set Configuration incorrect. RTC (real-time 
clock) battery might need to be 
replaced.

1 Run Computer Setup (F10 Setup).

2 Set the date and time under Control Panel or in F10 
Setup depending on the operating system.

3 If the problem persists, replace the RTC battery.

163–Time and Date Not Set Invalid time or date in configuration 
memory.
RTC (real-time clock) battery might 
need to be replaced.

1 Set the date and time under Control Panel or in F10 
Setup depending on the operating system.

2 If the problem persists, replace the RTC battery.
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164–Memory Size Error Memory configuration is incorrect. 1 Run Computer Setup (F10 Setup) or Windows 
utilities.

2 Be sure memory modules (if any) are installed 
properly.

3 If third-party memory has been added, test using HP 
only memory.

4 Verify proper memory module type.

201–Memory Error RAM failure. 1 Run Computer Setup (F10 Setup) or Windows 
utilities.

2 Ensure memory and continuity modules are installed 
correctly.

3 Verify proper memory module type.

4 Remove and replace memory modules one at a time 
to isolate faulty module.

5 Replace the faulty memory modules.

6 If error persists after replacing memory modules, 
replace the system board.

207–ECC Corrected Single Bit 
Errors in Memory Sockets y,y

Single Bit ECC error. 1 Verify proper memory module type.

2 Try another memory socket.

3 Replace memory module if problem persists.

213–Incompatible memory 
Module in memory Sockets 
X,X, X

A memory module in memory socket 
identified in the error message is 
missing critical SPD information, or is 
incompatible with the chipset.

1 Verify proper memory module type.

2 Try another memory socket.

3 Replace memory with a module conforming to the 
SPD standard.

214–DIMM Configuration 
Warning

DIMMs not installed correctly (not 
paired correctly).

See “Memory” on page 93 for the correct memory 
configurations and reseat the DIMMs accordingly.

301–Keyboard Error Keyboard failure. 1 Reconnect keyboard with workstation turned off.

2 Check connector for bent or missing pins.

3 Ensure that none of the keys are depressed.

4 Replace keyboard.

303–Keyboard Controller Error I/O board keyboard controller. 1 Reconnect keyboard with workstation turned off.

2 Replace the system board.

304–Keyboard or System Unit 
Error

Keyboard failure. 1 Reconnect the keyboard with workstation turned off.

2 Ensure that none of the keys are depressed.

3 Replace keyboard.

4 Replace system board. 

402–Parallel Port 2 Address 
Assignment Conflict

IRQ address conflicts with another 
device.

Reset the IRQ.

Table 5-18 POST Error Messages (Continued)

Screen Message Probable Cause Recommended Action
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501–Display Adapter Failure Graphics display controller. 1 Reseat the graphics card (if applicable).

2 Clear CMOS.

3 Verify that the monitor is attached and turned on.

4 Replace the graphics controller.

510–Splash Screen image 
corrupted

Splash Screen image has errors. Install latest version of ROMPaq to restore image.

511–CPU, CPUA, or CPUB 
Fan not detected

Fan is not connected or might have 
malfunctioned.

1 Reseat fan cable.

2 Reseat the fan.

3 Replace the fan.

512–Chassis, rear chassis, or 
front chassis fan not detected

Fan is not connected, might have 
malfunctioned.

1 Reseat chassis, rear chassis, or front chassis fan 
cable.

2 Reseat chassis, rear chassis, or front chassis fan.

3 Replace chassis, rear chassis, or front chassis fan.

515–Power Supply fan not 
detected

Power Supply fan not seated properly. Reseat the power supply connector.

601–Diskette Controller Error Diskette controller circuitry or diskette 
drive circuitry incorrect.

1 Run Computer Setup (F10 Setup).

2 Check and/or replace cables.

3 Clear CMOS.

4 Replace diskette drive.

5 Replace the system board.

605–Diskette Drive Type Error Mismatch in drive type. 1 Run Computer Setup (F10 Setup).

2 Disconnect any other diskette controller devices (tape 
drives).

3 Clear CMOS.

918–Front USB Not 
Connected

Front USB is not connected. Connect front USB cable.

920–Fan Command 4 Pin 
Connector from Power Supply 
Not Connected

The 4-pin fan connector from the 
power supply is not connected.

Connect 4-pin fan connector.

921–Device in PCI Express 
Slot failed to initialize

PCI Express cards not seated 
properly.

Reseat all PCI Express cards in their PCI Express slots. If 
the problem persists, contact the PCI Express card 
vendor.

1720–SMART Hard Drive 
Detect Imminent Failure

Hard drive is about to fail. (Some hard 
drives have a firmware patch that will 
fix an erroneous error message.)

1 Determine if hard drive is giving correct error 
message. Run the Drive Protection System test if 
applicable.

2 Apply firmware patch if applicable (visit http://
www.hp.com/support).

3 Back up contents and replace hard drive.

Table 5-18 POST Error Messages (Continued)

Screen Message Probable Cause Recommended Action
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1721–SMART SCSI Hard 
Drive detects imminent failure

Hard drive is about to fail. (Some hard 
drives have a firmware patch that will 
fix an erroneous error message.)

1 Determine if hard drive is giving correct error 
message. Run the Drive Protection System test if 
applicable.

2 Apply firmware patch if applicable (visit http://
www.hp.com/support).

1785–MultiBay incorrectly 
installed

No other IDE device may be attached 
to the same IDE controller.

Attach the MultiBay as device 0 on the primary IDE 
controller.

1794–Inaccessible devices 
attached to SATA 1 and/or 
SATA 3

Devices attached to the primary IDE 
controller are inaccessible while the 
SATA controller is set to “Replace 
Primary IDE Controller in Setup.

1 Run Computer Setup (F10 Setup).

2 Select Storage>Storage Options and set SATA 
controller to Add as Separate Controller.

1796–SATA Cabling Error SATA cables are plugged into the 
incorrect connectors.

Follow the on-screen directions that are displayed in 
conjunction with this message. It will direct you to use the 
four SATA connectors in a particular sequence. The SATA 
connectors are color-coded dark blue, white, orange, and 
light blue.

1801–Microcode Patch Error Processor not supported by ROM 
BIOS.

Upgrade BIOS to proper version.

1998–Master Boot Record has 
been lost

The previously saved copy of the MBR 
has been corrupted.

Run Computer Setup and save the MBR of the current 
bootable disk.

1998–Master Boot Record has 
been changed

The current MBR does not match the 
previously saved copy of the MBR.

Use extreme caution, the MBR might have been updated 
due to normal disk maintenance activities (disk manager, 
fdisk, or format). Replacing the previously saved MBR in 
such situations can cause data loss. If certain that the 
MBR change is unintentional and undesired (for example, 
due to a virus), run Computer Setup and restore the 
previously saved MBR copy. Otherwise, run Computer 
Setup and either disable MBR security or save the MBR 
of the current bootable disk.

Table 5-18 POST Error Messages (Continued)

Screen Message Probable Cause Recommended Action
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Appendix A SCSI Devices

This appendix discusses SCSI devices and related issues. This appendix includes the following 
sections:

“SCSI Guidelines” on page 154

“Using SCSISelect with SCSI Devices” on page 154

“SMART” on page 155

“Jumpers” on page 155
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SCSI Guidelines
When installing and operating SCSI devices, you must follow these guidelines:

A narrow (50-pin) SCSI controller allows you to daisy-chain up to seven additional SCSI devices. 
Counting the controller, that amounts to eight total SCSI devices.

A wide (68-pin) SCSI controller allows you to daisy-chain up to 15 additional SCSI devices. Counting 
the controller, that amounts to 16 total SCSI devices.

If two narrow (50-pin) SCSI controllers are each connected to separate system board SCSI 
connectors, each controller may have seven SCSI devices attached. Counting the controller, this 
gives a total of 16 SCSI devices on the system.

HP does not recommend mixing different width SCSI devices on the same SCSI chain or on the 
same SCSI channel. Mixing devices of different widths on the same chain or channel will always 
result in a data transfer rate of the slowest machine in that chain. The only exception to this is that 
Ultra Wide SCSI devices will cause a speed degradation when mixed with other 68-pin devices.

If multiple SCSI devices are used, split the devices between channels from multiple controllers for 
optimum performance. Cable length for the second channel should not be longer than 12 meters.

If two controllers are used, each can use SCSI devices having widths and speeds different from the 
other. If a 68-pin data cable is used on a controller having 50-pin SCSI devices, use an internal cable 
adapter or an external cable adapter.

CAUTION Do not route data cables near the air intake to the power supply. Cables routed in this 
manner may block the airflow and cause the workstation to overheat.

All SCSI controllers require a unique SCSI ID (0–15) for each SCSI device installed. For more 
information, see “Jumpers” on page 155.

68-pin SCSI controllers require a 12-meter, maximum-length twisted pair, LVD cable with built-in 
terminator, maximum of 15 drives.

Every SCSI chain or circuit must be terminated (closed) at both ends. Some system boards have 
both ends of the SCSI cable connected to, and terminated by, the system board. Termination can be 
accomplished in one of several ways:

Use a cable with a built-in terminator.

Use a cable with a terminating resistor plug in the last connector.

Connect a SCSI device with its termination enabled into the last connector.

Connect an external SCSI device with its termination enabled to the external SCSI connector on 
the rear panel of the workstation.

Turn on all external SCSI devices before turning on the power to the workstation. This enables the 
SCSI controller to recognize the external devices.

Using SCSISelect with SCSI Devices
The Ultra160 and faster SCSI host adapters include the SCSISelect utility to configure the host adapter 
and to run the SCSI disk utilities. To run the SCSI Select utility:
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In POST Messages Enabled mode: Press Ctrl+A when the “Press<Ctrl><A> for SCSISelect Utility” 
message appears during POST.

In POST Messages Disabled mode: When the HP logo screen appears, press any key to exit the 
logo screen. Immediately after exiting the logo screen, press Ctrl+A to access the SCSISelect utility.

A menu appears with the following options:

Configure/View Host Adapter Settings

SCSI Bus Interface Definitions

Host Adapter SCSI ID

SCSI Parity Checking

Host Adapter SCSI Termination

Additional Options

Boot Device Options

SCSI Device Configuration

Advanced Configuration Options

SCSI Disk Utilities

Lists all SCSI devices and SCSI ID numbers

NOTE For additional information about configuring POST message display status, refer to “Computer 
Setup Menu” on page 37.

SMART
The SMART SCSI hard drives for HP workstations have built-in drive failure prediction that warns the 
user or the network administrator of an impending failure or crash of the hard drive. SMART drives track 
fault prediction and failure indication parameters, such as re-allocated sector count, spin retry count, and 
calibration retry count. If the drive determines that a failure is imminent, it generates a fault alert.

Jumpers
All SCSI controllers require a unique SCSI ID (0–15) for each SCSI device installed.

The controller identifies a SCSI device by its SCSI ID number rather than its location. Moving a SCSI 
device from one position to another on the SCSI chain does not affect communication between the 
controller and the device.

The reserved and available SCSI ID numbers are displayed in the following list:

0 is reserved for the primary hard drive (not reserved for the primary hard drive on Linux).

7 is reserved for the SCSI controller.

1 through 6 and 8 through 15 are available for all other SCSI devices.

When 0 is used for the primary hard drive, set the second hard drive to 1, the third to 2, and so on.
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To set the SCSI ID on a drive, refer to the instructions on top/back of the hard drive for the correct jumper 
settings. The drive probably displays a diagram of the jumper block. This diagram shows you which 
blocks to cover with your jumper to get the desired ID.

For example, if the drive needs to be set to 3, the drive might show that the 3 ID bits are at the far left of 
the connector (ID0, ID1, ID2, and ID3), then using the jumpers provided, cover each block to set the 
SCSI ID.

NOTE After changing the jumper settings, reboot the workstation to recognize the new address.
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Appendix B SATA Devices

This appendix discusses SATA devices and related issues. This appendix contains the following 
sections:

“SATA Guidelines” on page 157

“Boot Order” on page 158

“Hard Drive Configurations” on page 158

SATA Guidelines

NOTE These systems support a mixed configuration of UATA/IDE, SCSI, and SATA hard drives. While 
HP supports the presence of IDE drives, it does not ship any configurations using those drives.

NOTE The HP Workstation xw4200 has four SATA ports on the system board to cover all the internal 
hard drive mounting points. The first SATA drive (boot drive if booting from SATA) should be connected 
to the port labeled SATA0, and a second drive to SATA1 if needed.

When installing and operating SATA devices, you must:

Use the SATA data cables with the 90-degree connector (326965-001) for the hard drive bays. The 
90-degree connector goes to the hard drive.

Use the longest data cable with the straight connectors (326965-002) if installing a hard drive in an 
optical bay.

When hooking up an IDE drive on an IDE bus that also has an optical drive on it, put the hard drive in 
the master position and the optical drive in the slave position.

CAUTION Do not route data cables near the air intake to the power supply. Cables routed in this 
manner might block the airflow and cause the workstation to overheat.

For complete and current information on supported accessories and components, visit http://
www.partsurfer.hp.com.
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Boot Order
You can modify the boot order in the Computer Setup Utility by arranging the Controller Order on the 
Storage tab. You can also arrange the boot order on the Storage tab.

Hard Drive Configurations
Whenever one or two drives are to be connected to a plug-in controller, HP recommends that those 
drives be mounted in the hard drive bays to simplify cabling. When a third drive is needed in the optical 
bay, it can also be connected to the plug-in controller, or to a system board if it is a SATA drive. A bracket 
is required to mount a hard drive in the optical bays.

NOTE The first hard drive bay is the recommended position for the drive containing the bootable OS.

SATA Raid Configurations
This workstation supports an embedded SATA RAID. RAID (Redundant Array of Inexpensive Disks) 
combines multiple physical drives together to provide either increased performance or increased 
redundancy.

For an embedded SATA RAID, there are two primary configurations.

RAID 0 is a striping configuration. For example, this combines two 80 GB drives into one 160 GB 
drive. Both physical drives can be accessed simultaneously for better performance. This is faster 
than using two 80 GB drives separately.

RAID 1 is a mirroring configuration. For example, this uses two 80 GB drives, but one drive is a 
complete mirror of the other drive. The system remains functional and no data is lost if one of the 
drives should fail.

There are other RAID configurations, but they are not supported on an embedded SATA RAID.

NOTE For information on the integrated SATA RAID, visit http://www.hp.com/go/workstationsupport and 
review the supplier’s documentation. For information on supported SATA RAID configurations, visit
 http://www.hp.com/go/productbulletin.
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Appendix C Ultra ATA Devices

This appendix discusses the guidelines and features for Ultra ATA drives.

NOTE This system supports a mixed configuration of UATA/IDE, SCSI, and SATA hard drives. While HP 
supports the presence of IDE drives, it does not ship any configurations using those drives.

This appendix includes the following sections:

“Ultra ATA Jumpers” on page 160

“Ultra ATA Cables” on page 160

“Drive Installation Guidelines” on page 160

“SMART” on page 162

“Jumpers” on page 162
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Ultra ATA Jumpers
Ultra ATA drives are configured with jumper settings. With cable-select, the drive is configured as either 
Master (Drive/Device 0) or Slave (Drive/Device 1) by its physical attachment to the cable.

If you purchase a third-party hard drive, refer to the documentation included with the drive kit to ensure 
proper cable installation and configuration.

NOTE All drives on a controller channel need to have their jumpers either in the cable-select mode or 
have the individual drive jumper installed on the appropriate Master (Drive/Device 0) or Slave (Drive/
Device 1) position.

Ultra ATA Cables
When installing a second device on the primary controller, you must use an industry-standard, 
80-conductor Ultra ATA cable for optimal performance. These cables have a maximum length of 18 
inches and a maximum distance of six inches between the two devices for a two-drive cable.

Drives operating at speeds faster than those of the Ultra ATA-33 devices require industry-standard, 40-
pin, 80-conductor cables to maintain the higher data transfer rates possible with the improved 
technology.

When using Ultra ATA-133, -100, -66, and slower -33 drives in the same system, each drive will operate 
at its appropriate data transfer rate.

NOTE On a two-drive cable, the Drive/Device 0 connector is always the farthest one from the system 
board connector and the Drive/Device 1 connector is always the closest to the system board connector.

NOTE Some cables might be labeled “Drive 0” instead of “Device 0” and “Drive 1” instead of “Device 1.”

Drive Installation Guidelines
The HP Workstation xw4200 system board has one Ultra ATA (IDE) controller channel designated as the 
primary controller.

The controller can have up to two devices attached to it, and all drives are connected to this controller 
using an industry-standard, 80-conductor cable.

NOTE The industry-standard, 1.44-MB diskette drive has its own separate channel and is not included 
as a part of the maximum four drives.

Any drive attached to a controller must have a drive designation. If only a single drive is connected to a 
controller and its jumper is in the cable-select position, it is designated as the Master Drive (Drive/Device 
0) by its attachment to the Drive/Device 0 cable position. If two cable-selected drives are connected to a 
single controller, one will be designated by its attachment to the cable as the master (Drive/Device 0) and 
the other as slave (Drive/Device 1).
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Device Classes
To determine the best drive attach sequence, Ultra ATA/ATAPI drives are segregated into four different 
classes based on the bandwidth demands they place on an Ultra ATA controller. The most demanding 
devices are in Class 1. The least demanding devices are in Class 4. The following table illustrates those 
classes.

General Attach Guidelines

The lower the device class number, the faster the device and the more bandwidth required.

Drives installed in the Device 0 position receive the greatest possible bandwidth.

Attach Sequence Rules by Class Priority
The following table summarizes the attach sequence rule.

Additional Drive Application Notes
When replacing a hard drive, the replacement should be of the same type (Ultra ATA 33, -66, or
-100) as that being removed to retain the same level of performance.

When Ultra ATA and SATA hard drives are mixed in the same system, the SATA drive will become the 
boot drive unless the boot order is changed in Computer Setup (F10). The default boot order on this 
system prefers SATA, then Ultra ATA, then SCSI.

Table C-1 Device Classes

Class 1
Hard Drives

Class 2
High Speed Optical Drives

Class 3
Optical Storage Drives

Class 4
Magnetic Storage Drives

Ultra ATA-100
Ultra ATA-66
Ultra ATA-33

DVD
DVD-CD R/W

R/W CD-ROM
CD-ROM 

LS-120
Tape
Zip 

Table C-2 General Attach Sequence Rule*

Sequence Description

1 The lowest class drive—bootable hard drive recommended.

2 If only two drives, the last drive goes here; otherwise the lowest class of the remaining drives.

*If there are three or more devices, two or more of which are hard drives, two hard drives should be attached to the 
primary controller first before following the General Attach Sequence Rule.
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SMART
The Self Monitoring Analysis and Recording Technology (SMART) Ultra ATA drives for HP workstations 
have built-in drive failure prediction that warns the user or network administrator of an impending failure 
or crash of the hard drive. The SMART drive tracks fault prediction and failure indication parameters, 
such as reallocated sector count, spin retry count, and calibration retry count. If the drive determines that 
a failure is imminent, it generates a fault alert.

Jumpers
The specifications included below are the standard drive configurations.

CD-ROM or DVD-ROM Drive

Figure C-1 CD-ROM or DVD-ROM Drive Jumper Connections

C S M
S L A

C S M
S L A

C S M
S L A

Use CSEL Slave Master
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Appendix D Connector Pins

This appendix contains the pin assignments for many workstation connectors. Some of these connectors 
might not be used on the product being serviced. This appendix contains the following sections:

“Enhanced Keyboard” on page 164

“Mouse” on page 164

“Ethernet RJ-45” on page 164

“Parallel Interface” on page 165

“Serial Interface” on page 165

“USB” on page 165

“Microphone” on page 166

“Headphone” on page 166

“Line-In Audio” on page 166

“Line-Out Audio” on page 166

“Ultra SCSI” on page 167

“SATA” on page 167

“Monitor” on page 168

“ATA/ATAPI (IDE) Standard Drive Cable” on page 168

“24-Pin Power” on page 169

“4-Pin Power (for CPU)” on page 169

“6-Pin PCI Express” on page 169

“DVI-I Signals” on page 170
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Enhanced Keyboard

Mouse

Ethernet RJ-45

Connector and Icon Pin Signal

1
2
3

Data
Unused
Ground

4
5
6

+5 VDC
Clock
Unused

Connector and Icon Pin Signal

1
2
3

Data
Unused
Ground

4
5
6

+5 VDC
Clock
Unused

Connector and Icon Pin Signal

1
2
3
4

(+) Transmit Data
(-) Transmit Data
(+) Receive Data
Unused

5
6
7
8

Unused
(-) Receive Data
Unused
Unused
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Parallel Interface

Serial Interface

USB

Connector and Icon

Pin Signal Pin Signal Pin Signal

1
2
3

Strobe
Data Bit 0
Data Bit 1

7
8
9

Data Bit 5
Data Bit 6
Data Bit 7

13
14
15

Select
Auto Linefeed
Error

4
5
6

Data Bit 2
Data Bit 3
Data Bit 4

10
11
12

Acknowledge
Busy
Paper End

16
17
18–25

Initialize Printer
Select IN
Signal Ground

Connector and Icon Pin Signal

1
2
3

Carrier Detect
Receive Data
Transmit Data

4
5
6

Data Terminal Ready
Signal Ground
Data Set Ready

7
8
9

Request to Send
Clear to Send
Ring Indicator

Cable connector and Icon Pin Signal

1
2
3
4

+5 VDC
- Data
+ Data
Ground
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Microphone

Headphone

Line-In Audio

Line-Out Audio

Connector and Icon (1/8") Pin Signal

1 (Tip)
2 (Ring)
3 (Shield)

Audio
Power
Ground

Connector and Icon (1/8") Pin Signal

1 (Tip)
2 (Ring)
3 (Shield)

Audio_Left
Audio_Right
Ground

Connector and Icon (1/8") Pin Signal

1 (Tip)
2 (Ring)
3 (Shield)

Audio_In_Left
Audio_In_Right
Ground

Connector and Icon (1/8") Pin Signal

1 (Tip)
2 (Ring)
3 (Shield)

Audio_Out_Left
Audio_Out_Right
Ground
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Ultra SCSI

SATA

Connector and Icon

Pin Signal Pin Signal Pin Signal Pin Signal

1–11
12
13
14

Ground
Reserved
Open
Reserved

29
30
31
32

DB3
DB4
DB5
DB6

37
38
39
40

Reserved
TERMPWR
Reserved
Ground

45
46
47
48

RST #
MSG #
SEL #
C/D

15–25
26
27
28

Ground
DB0
DB1
DB2

33
34
35
36

DB7
DBP
Ground
Ground

41
42
43
44

ATN #
Ground
BSY #
ACK #

49
50

REQ #
Input/Output

Connector

Pin Usage Pin Usage Pin Signal

Data Cable Power Cable Power Cable

S-1 Ground P-1 3.3 V power P-8 5V power

S-2* A+ P-2 3.3 V power P-9 5V power

S-3* A- P-3 3.3 V power P-10 Ground

S-4 Ground P-4 Ground P-11 Reserved

S-5** B- P-5 Ground P-12 Ground

S-6** B+ P-6 Ground P-13 12V power

S-7 Ground P-7 5V power P-14 12V power

*S-2 and S-3 differential signal pair
**S-5 and S-6 differential signal pair

P-15 12V power
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Monitor

NOTE Monitor connectors might vary depending on your configuration.

ATA/ATAPI (IDE) Standard Drive Cable

Connector and Icon

Pin Signal Pin Signal Pin Signal

1
2
3

Red Analog
Green Analog
Blue Analog

6
7
8

Ground
Ground
Ground

11
12
13

Monitor ID
DDC Serial Data
Horizontal Sync

4
5

Monitor ID
Ground

9
10

+5 V DC
Ground

14
15

Vertical Sync
DDC Serial Clock

Connector

Pin Signal Pin Signal Pin Signal

1
2
3
4
5

Reset
Ground
DD7
DD8
DD6

15
16
17
18
19

DD1
DD14
DD0
DD15
Ground

29
30
31
32
33

DMAK
Ground
INTRQ
IOCS16
DA1

6
7
8
9
10

DD9
DD5
DD10
DD4
DD11

20
21
22
23
24

(Key)
DMARQ
Ground
DIOW
Ground

34
35
36
37
38

PDIAG (cable detect)
DA0
DA2
CS1FX
CS3FX

11
12
13
14

DD3
DD12
DD2
DD13

25
26
27
28

DIOR
Ground
IORDY
CSEL

39
40

DASP
Ground
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24-Pin Power

4-Pin Power (for CPU)

6-Pin PCI Express

Connector

Pin Signal Pin Signal Pin Signal Pin Signal

1
2
3
4
5
6

+3.3 V
+3.3 V
GND
+5 V
GND
+5 V

7
8
9
10
11
12

GND
POK
+5 Vaux
+12 V
+12 V
+3.3 V

13
14
15
16
17
18

+3.3 V
-12 V
GND
PSON
GND
GND

19
20
21
22
23
24

GND
NC
+5 V
+5 V
+5 V
GND

24
23
22
21
20
19
18
17
16
15
14
13a
13b

12
11
10
9

8
7
6
5
4
3
2
1

Connector and Icon Pin Signal

1
2
3
4

GND
GND
+12 V
-12 V

Connector and Icon Pin Signal

1
2
3
4
5
6

+12 V
+12 V
+12 v
GND
GND
GND

3
2
1

6
5
4
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DVI-I Signals

Connector and Icon Pin Signal

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
C1
C2
C3
C4
C5

TMDS Data2 -
TMDS Data2 +
TMDS Data2/4 shield
TMDS Data4 -
TMDS Data4 +
DCC Clock (SCL)
DCC Bi-directional Data (SDA)
Analog Vertical Sync
TMDS Data1 -
TMDS Data1 +
TMDS Data1/3 shield
TMDS Data3 -
TMDS Data3 +
+5V DC Power
Ground Return: +5V, Hsync, Vsync
Hot Plug Detect
TMDS Data0 -
TMDS Data0 +
TMDS Data0/5 shield
TMDS Data5 -
TMDS Data5 +
TMDS Clock shield
TMDS Clock +
TMDS Clock -
Analog Red
Analog Green
Analog Blue
Analog Horizontal Sync
Analog Ground Return: analog Red, Green, Blue
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Appendix E System Board Designators

This appendix lists the system board reference designators for this system. 

Table E-1 System Board Designators

Designator Silkscreen Component

MH01-MH10 N/A Mounting holes

CR1 5V_AUX LED: 5V_AUX power indicator

N/A N/A Power LED

P14 N/A Boot block header/jumper

E49 N/A Clear password header/jumper

J20 SLOT3 PCI PCI slot

J21 SLOT4 PCI PCI slot

J22 SLOT5 PCI PCI slot

J23 SLOT6 PCI PCI slot

J31 SLOT7 PCI-E X1 PCI Express slot

J34 SLOT1 PCI-E X1 PCI Express slot

J41 SLOT2 PCI-E X16 GRAPHICS PCI Express x16 slot for graphics

J50 PARALLEL Parallel port

J68 KBD_MSE Stacked keyboard/mouse connector

J9 RJ/USB Stacked RJ45/Dual USB

J10 QUAD USB Quad stacked USB

J83 AUDIO Triple stacked audio jack

P1 P/S Power supply connector (24 pin)

P3 N/A Processor 12V header

P10 FDD Diskette drive connector

P101 SECURITY Security board connector

P7 CD-IN CD analog audio connector
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P11 AUX-IN Auxiliary audio connector

P124 HOOD LOCK Hood lock header

P125 HD SENSE Hood sensor header

P20 IDE Primary IDE connector

P23 FRONT AUDIO Front panel audio header

P24 FRONT USB Front panel USB header

P27 MULTIBAY Multi-Bay header

P29 HDD LED HDD LED connector

P30 SATA0 Primary serial ATA (SATA) connector

P31 SATA1 Second serial ATA (SATA) connector

P32 SATA2 Third serial ATA (SATA) connector

P33 SATA3 Fourth serial ATA (SATA) connector

P5 CONTROL PANEL Main power/HDD LED connector

P52 SERIAL B Flying serial port header

P53 SERIAL A Serial port

P6 SPK Speaker connector

P70 CPU FAN CPU fan header 

P8 SYS FAN Primary chassis fan header

P9 PCI FAN Secondary chassis fan header

SW50 CMOS Clear CMOS switch/push button

XBT2 BATTERY Battery retainer

XMM1 DIMM1 Memory slot

XMM2 DIMM2 Memory slot

XMM3 DIMM3 Memory slot

XMM4 DIMM4 Memory slot

XU1 CPU Processor socket

XU15 FWH ROM socket

Table E-1 System Board Designators

Designator Silkscreen Component
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Appendix F Power Cord Set Requirements

This appendix discusses the power cord set requirements for the HP Workstation xw4200.

The power cord set (flexible cord or wall plug) received with this product meets the requirements for use 
in the country where you purchased the equipment.

If you must obtain a power cord for a different country, you should purchase a power cord that is 
approved for use in that country.

The power cord must be rated for the product and for the voltage and current marked on the product’s 
electrical ratings label. The voltage and current rating of the cord should be greater than the voltage and 
current rating marked on the product. In addition, the diameter of the wire must be a minimum of 
0.75 mm2 or 18AWG, and the length of the cord must be between 6 feet (1.8 m) and 12 feet (3.6 m). If 
you have questions about the type of power cord to use, contact the HP authorized service provider.

A power cord should be routed so that it is not likely to be walked on or pinched by items placed upon it 
or against it. Particular attention should be paid to the plug, electrical outlet, and the point where the cord 
exits from the product.
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Appendix G Routine Care

This appendix discusses routine care procedures for the HP Workstation xw4200. This appendix 
includes the following sections:

“General Cleaning Safety Precautions” on page 176

“Maximizing the Airflow” on page 176

“Cleaning the Workstation Case” on page 176

“Cleaning the Monitor” on page 177

“Cleaning the Mouse” on page 177
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General Cleaning Safety Precautions
When cleaning the workstation, follow these general precautions:

1 Never use solvents or flammable solutions to clean the workstation.

2 Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and then 
use the cloth on the component.

3 Always unplug the workstation when cleaning with liquids or damp cloths.

4 Always unplug the workstation before cleaning the keyboard, mouse, or air vents.

5 Disconnect the keyboard before cleaning it.

6 Wear safety glasses equipped with side shields when cleaning the keyboard.

Maximizing the Airflow
Keep your workstation in an area where the airflow to the front and rear of the system is not obstructed.

If possible, keep the unit off of surfaces where dust can gather.

Keep the back of the unit at least six inches away from a wall or other obstruction.

Keep the front of the unit clear of any obstruction that keeps air from entering the front of the system.

Remove any dust on the front panel (vent area) and the rear fans with a small vacuum, compressed 
air, and dust rag.

Cleaning the Workstation Case
Follow all safety precautions stated earlier before cleaning the workstation.

To clean the workstation case:

To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

For stronger stains, use a mild dish-washing liquid diluted with water. Rinse well by wiping it with a 
cloth or swab dampened with clear water.

For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will 
evaporate quickly and not leave a residue.

After cleaning, always wipe the unit with a clean, lint-free cloth.

Occasionally clean the air vents on the workstation. Lint and other foreign matter can block the vents 
and limit the airflow.
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Cleaning the Keyboard
Follow all safety precautions stated earlier before cleaning the keyboard.

When cleaning debris from under the keys, review all rules in the previous section, then:

CAUTION Use safety glasses equipped with side shields before attempting to clean debris from under 
the keys. 

Visible debris underneath or between the keys can be removed by vacuuming or shaking.

Canned, pressurized air can be used to clean debris from under the keys. Caution should be used as 
too much air pressure can dislodge lubricants applied under the wide keys.

If you remove a key, use a specially designed key puller to prevent damage to the keys. This tool is 
available through many electronic supply outlets.

CAUTION Never remove a wide-leveled key (like the space bar) from the keyboard. If these keys are 
improperly removed or installed, the keyboard might not function properly.

Cleaning under a key can be done with a swab moistened with isopropyl alcohol and squeezed out. 
Be careful not to wipe away lubricants necessary for proper key functions. Use tweezers to remove 
any fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

Cleaning the Monitor
Follow all safety precautions stated earlier before cleaning the monitor.

To clean the monitor, wipe the monitor screen with a clean cloth moistened with water or with a towelette 
designed for cleaning monitors. Do not use sprays or aerosols directly on the screen; the liquid might 
seep into the housing and damage a component. Never use solvents or flammable liquids on the 
monitor.

Cleaning the Mouse
Follow all safety precautions stated earlier before cleaning the mouse.

To clean the mouse:

Clean the mouse ball by first removing the retaining plate and the ball from the housing.

Pull out any debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.
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Appendix H Additional Password Security 
and Resetting CMOS

This appendix discusses additional password security and CMOS (complementary metal oxide 
semiconductor)-related issues for the HP Workstation xw4200. This appendix includes the following 
sections:

“Resetting the Password Jumper” on page 180

“Clearing and Resetting the CMOS” on page 181

This workstation supports security password features, which can be established through the Computer 
Setup Utilities menu. These features are:

setup password

power-on password

When you establish only a setup password, the power-on password is required to access Computer 
Setup and any other information on the workstation. When you establish both passwords, only the setup 
password will give you access to Computer Setup.

When both passwords are set, the setup password can also be used in place of the power-on password 
as an override to log in to the workstation. This is a useful feature for a network administrator.

If you forget the password for the computer, there are two method for clearing that password so you can 
gain access to the information on the workstation:

resetting the password jumper

using the Clear CMOS button

CAUTION Pushing the CMOS button resets CMOS values to factory defaults and erases any 
customized information including passwords, asset numbers, and special settings. It is important to back 
up the workstation CMOS settings before resetting them in case they are needed later. To back up the 
CMOS settings, use Computer Setup and run the Save to Diskette option from the File menu.
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Resetting the Password Jumper
To disable the power-on or setup password features, and clear the power-on and setup passwords:

1 Shut down the operating system and then turn off the workstation and any external devices. 
Disconnect the power cord of the workstation and any external devices from the power outlets.

2 Disconnect the keyboard, monitor, and any other external devices that are connected to the 
workstation.

WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces, be sure to 
disconnect the power cord from the wall outlet and allow the internal system components to cool before 
touching.

CAUTION When the workstation is plugged in, the power supply always has voltage applied to the 
system board even when the unit is turned off. Failure to disconnect the power cord can result in damage 
to the system.

CAUTION Static electricity can damage the electronic components of the workstation or optional 
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by 
briefly touching a grounded metal object.

3 Remove the access panel.

4 Locate the header and jumper. The password jumper is E49.

NOTE The password jumper is green so that it can be easily identified. For assistance locating the 
password jumper and other system board components, see “System Board Components” on page 17.

5 Remove the jumper from pins 1 and 2. Place the jumper on either pin 1 or 2, but not both, so it does 
not get lost.

6 Replace the access panel.

7 Reconnect the external equipment.

8 Plug in the workstation and turn on the power. Allow the operating system to start. This clears the 
current passwords and disables the password features.

9 To establish new passwords, repeat steps 1 through 4, replace the password jumper on pins 1 and 2, 
then repeat steps 6 through 8. Establish the new passwords in Computer Setup.
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Clearing and Resetting the CMOS
The CMOS of the workstation stores password information and information about the workstation 
configuration. This section describes the steps to successfully clear and reset the CMOS.

Using the CMOS Button
To use the CMOS button:

1 Shut down the operating system and then turn off the workstation and any external devices. 
Disconnect the power cord of the workstation and any external devices from the power outlets.

2 Disconnect the keyboard, monitor, and any other external devices that are connected to the 
workstation.

WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces, be sure to 
disconnect the power cord from the wall outlet and allow the internal system components to cool before 
touching.

CAUTION When the workstation is plugged in, the power supply always has voltage applied to the 
system board even when the unit is turned off. Failure to disconnect the power cord can result in damage 
to the system.

CAUTION Static electricity can damage the electronic components of the workstation or optional 
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by 
briefly touching a grounded metal object.

3 Remove the access panel.

CAUTION Pushing the CMOS button resets CMOS values to factory defaults and erases any 
customized information including passwords, asset numbers, and special settings. It is important to back 
up the workstation CMOS settings before resetting them in case they are needed later. To back up the 
CMOS settings, use Computer Setup and run the Save to Diskette option from the File menu.

4 Locate, press, and hold the CMOS button in for five seconds.

NOTE Be sure that the AC power cord is disconnected from the power outlet. The CMOS button does 
not clear CMOS if the power cord is connected.

NOTE For assistance locating the CMOS button and other system board components, see “System 
Board Components” on page 17.
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5 Replace the access panel.

6 Reconnect any external devices.

7 Plug in the workstation power and turn the power back on.

NOTE The workstation passwords and any special configurations along with the system date and time 
will have to be reset.

Using Computer Setup to Reset CMOS
To reset CMOS using Computer Setup, access the Computer Setup Utilities menu. When the Computer 
Setup message appears in the lower-right hand corner of the screen, press the F10 key. Press Enter to 
bypass the title screen, if necessary.

NOTE If you do not press the F10 key while the message is displayed, the workstation must be turned 
off, then on again, to access the utility.

From the Computer Setup menu, select File>Set Defaults and Exit. This restores the soft settings that 
include boot sequence order and other factory settings. It does not, however, force hardware 
rediscovery.

NOTE The workstation passwords and any special configurations along with the system date and time 
will have to be reset.
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Appendix I Quick Troubleshooting Flows

This appendix presents some quick troubleshooting flowcharts for some common issues. This appendix 
contains the following sections:

“Initial Troubleshooting” on page 184

“No Power” on page 185

“No Video” on page 188

“Error Messages” on page 191

“No OS Loading” on page 194

“No OS Loading from Hard Drive” on page 195

“No OS Loading from Diskette Drive” on page 198

“No OS Loading from CD-ROM Drive” on page 199

“No OS Loading from Network” on page 200

“Non-Functioning Device” on page 201

Additional information about troubleshooting can be found in “System Diagnostics and Troubleshooting” 
on page 115.

NOTE The flowcharts presented here are for general troubleshooting purposes only and they might not 
apply to your specific workstation.
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Initial Troubleshooting
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No Power
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No Video
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Error Messages
ERROR MESSAGES 191
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No OS Loading
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No OS Loading from Hard Drive
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No OS Loading from Diskette Drive
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No OS Loading from CD-ROM Drive
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No OS Loading from Network
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Non-Functioning Device
NON-FUNCTIONING DEVICE 201
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Index

Numerics
20-pin power connector pin assignments 

169
4-pin power connector pin assignments 169

A
access panel

installation and removal 77
asset tracking and security 52

B
battery

disposal 72
handling 72
installing and removing 100
real-time clock 125

bezel blanks, installing and removing 80
blank screen 132
boot order 39
bootable disk, important information 64
bus options 42

C
cable

proper handling 72
SCSI adapter 154

cable lock
Kensington 64
provision 64

cable lock slot 64
cable select drive 160
cables and connectors 72
cautions

adding devices 27
batteries 72
cable routing 154, 157
cables 72, 73
cooling fan 73
cover lock security 60
FailSafe Key 61
installation 27
keyboard cleaning 177
keyboard keys 177

CD-ROM and DVD-ROM
jumpers 162

CD-ROM drive
See optical drive

chain termination, SCSI 154
changing password 56
chassis feet, installing and removing 81
cleaning

keyboard 177
clearing password 58
cloning tools, software 44

CMOS
button 181
clearing and resetting 181

COA label location 19
components

front panel 15
rear panel 16

computer pauses 125
Computer Setup (F10)

Advanced functions 42
File functions 37
overview 34
Security functions 40
Storage functions 38
using 36
utilities 36

connectors
front panel 15
pin assignments 163
rear panel 16
system board 17

cover lock security, caution 60
cover lock, SMART 60
customizing software 44

D
data integrity 65
date and time display 125
deleting password 57
delimiter characters, table 58
deployment tools, software 44
desktop management 44
device

onboard 42
options 43
PCI 42
security 40

device configuration 38
diagnostic tool for hard drives 65
DIMMs, installing and removing 93
disk, cloning 44
diskette drive

installing and removing 106
location 15
troubleshooting 129

drive
cable select 160
device designation 160
Drive Protection System (DPS) 65
protecting 65
replacement type 161

Drive Protection System 65
DriveLock

applications and recommendations 59
overview 58

password setup 40
security purpose 52
using 59

DVD-ROM drive
See optical drive

E
ECC Fault Prediction and Prefailure Warranty 

65
Energy Star 24
entering

power-on password 55
setup password 55

ESD (electrostatic discharge)
materials and equipment 70
preventing damage 69

Ethernet RJ-45 connector pin assignments 
164

F
FailSafe

Key, caution 61
Key, ordering 62

FailSafe key
obtaining 62
using 61

fault notification and recovery 65
formatting disk, important information 64
front bezel, installing and removing 80
front panel components 15
front panel I/O assembly, installing and 

removing 83
front panel, troubleshooting 138

G
graphics adapter location 16
graphics card

power specifications 21
grounding methods 69

H
handling the workstation 71
hard drive

diagnostic tool 65
installing and removing in bracket 112
jumper settings 131
proper handling 72
SATA drives 157
SCSI drives 154
troubleshooting 131
Ultra ATA 160

hardware
removal and replacement 67, 73
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troubleshooting 139
headphone

jack location 15
heatsink, installing and removing 88
hood sensor

enabling 40
installing and removing 78
overview 60
setting protection level 60

hood solenoid lock
installing and removing 79
locking 61
unlocking 61

HP Intelligent Manageability 44
Hyper-Threading Technology 25

I
ID numbers, SCSI 107
IDE

controller Computer Setup (F10) 39
IDE connector pin assignments 168
IEEE-1394

connector location 15
installing and removing 82

information
system 37

initial configuration 44
Installing 112
installing

access panel 77
battery 100
bezel blanks 80
chassis feet 81
DIMMs 93
diskette drive 106
front bezel 80
front panel I/O assembly 83
hard drive in bracket 112
heatsink 88
hood sensor 78
hood solenoid lock 79
IEEE-1394 82
Kensington cable lock 75
memory 93
optical drive (desktop) 104
optical drive (minitower) 102
power button assembly 84
power supply 85
processor 91
security lock 75
speaker 87
system board 114
system fan 86

internal computer temperature 65

J
jumpers

CD-ROM and DVD-ROM 162
hard drive 131
resetting passwords 180

K
Kensington cable lock 64

installation and removal 75
purpose 53

keyboard
cleaning 177
connector pin assignments 164

delimiter characters 58
delimiter characters, national 58
PS/2 connector location 16
troubleshooting 137

L
legacy diskette write 39
lifting the workstation 71
line-in audio

connector location 16
line-out audio

connector location 16

M
Master Boot Record

restoring 41
saving 40
security 40
security overview 62
security purpose 53

memory
guidelines 93
installing and removing 93
troubleshooting 143

memory errors 65
message URL partsurfer.hp.com 13
microphone

connector location 15, 16
Microsoft Windows XP Professional

operating system 28
monitor

blank screen 132
blurry video 133
connector pin assignments 168
dim characters 133

mouse
cleaning 177
connector pin assignments 164
PS/2 connector location 16

N
national keyboard delimiter characters 58
network connector location 16
non-correctable memory errors 65

O
operating system

installing 27
Microsoft Windows XP Professional 28
restoring 27

optical drive
activity light 15
installing and removing (desktop) 104
installing and removing (minitower) 102
location 15

ordering FailSafe Key 62

P
padlock loop, purpose 53
parallel

connector location 16
connector pin assignments 165

partitioning disk, important information 64
password

additional information 179
changing 56
clearing 58

deleting 57
DriveLock 40
power-on 40, 54, 55, 148
resetting jumpers 180
security 54
setup 40, 54, 55

PCI
devices 42

POST error messages 148
power

button 15
dual-state button 51
light 15

power button, installing and removing 84
power cord

location 16
power supply

installing and removing 85
surge tolerance 65
surge-tolerant 65

power-on options 42
power-on password 148

entering 55
establishing 54
purpose 52
setting 54

pre-disassembly procedures 73
prefailure memory warranty 65
preinstalled software image 44
primary IDE

connector 17
problems

audio 135
CD-ROM and DVD 144
display 132
front panel 138
hard drive 131
installing hardware 139
keyboard 137
memory 143
network 141
optical drives 144
power supply 127
printer 136

processor, installing and removing 91
product

overview 13
routine care 175
specifications 20

protecting
hard drive 65

R
rear panel components 16
recovery, software 44
remote setup 44
Remote System Installation 44
removable media boot 39
removal and replacement 73
removing

access panel 77
battery 100
bezel blanks 80
chassis feet 81
DIMMs 93
diskette drive 106
front bezel 80
front panel I/O assembly 83
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hard drive in bracket 112
heatsink 88
hood sensor 78
hood solenoid lock 79
IEEE-1394 82
Kensington cable lock 75
memory 93
optical drive (desktop) 104
optical drive (minitower) 102
power button assembly 84
power supply 85
processor 91
security lock 75
speaker 87
system board 114
system fan 86

routine care 175

S
safety precautions, cleaning 176
SATA

boot order 158
data cables 157
installing 109
ports 157
RAID 158
removing 109

SATA drives 157
screws 70
SCSI drives 154

cable adapter 154
chain termination 154
connector pin assignments 167
controllers, ID numbers 107
guidelines 154
SMART 155

security
master boot record 62

security lock installation and removal 75
serial ATA

connectors 17
serial connector location 16
serial connector pin assignments 165
serial number location 19
setting

power-on password 54
setup password 54, 55

setup
initial 44

setup password
entering 55
establishing 54
purpose 52
setting 54

Slot 21
SMART 155, 162
software

configuration and deployment 44
customizing 44
Drive Protection System 65
Fault Notification and Recovery 65
management and updating 45
managing 45
Master Boot Record Security 62
recovery 44
Remote Management Setup 45
Remote System Installation 44
service requirements 70

updating 45
spare part number

external cable adapter 154
internal cable adapter 154

speaker, installing and removing 87
static electricity 68

grounding methods 69
preventing damage 69

surge-tolerant power supply 65
system

diagnostics and troubleshooting 115
management 33
overview 13
routine care 175
setting time and date 37
specifications 20

system board
installing and removing 114

system fan, installing and removing 86

T
temperature, internal computer 65
thermal sensor 65
tool requirements 70
troubleshooting

audio problems 135
CD-ROM and DVD problems 144
diskette problems 129
front panel problems 138
hard drive problems 131
hardware installation problems 139
Internet access problems 146
keyboard problems 137
memory problems 143
minor problems 125
network problems 141
preliminary checklist 115
printer problems 136
processor problems 144
scenarios and solutions 125
video problems 132

U
Ultra ATA

cables 160
jumpers 160
SMART 162

Ultra ATA Integrity Monitoring 65
USB

connector pin assignments 165
USB ports

front panel location 15
rear panel location 16

W
Wake-on-LAN feature 141
warnings

battery 72
lifting and moving 68, 71
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